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F—HR—FLa—rhvhk

ENRl: ENRIE—RICUIV B RS LLECHREDR—D BEDLAT IR FEFT X
TOLATINENRIT 5128 DF—R—FIa—rhvhEEY LB TONSHIFaYY
FABEmEhELE=, [IBERE (Preferences) IO F+—HR—KFLa—kAvk (Key
Commands)IR—I OTHIR (Print) IATI)—I2, LTOFRIATUEAHYE
ER

s IRTOLAF7Ir% PDF LLTEEHL (Export All Layouts as PDF)

s BEDL A7 h% PDF ELTEEHL (Export Current Layout as PDF)

s BEDAR—T% PDF ELTEZHIL (Export Current Page as PDF)

s BEDL A7 %R (Print Current Layout)

o BEDAR—LZHER| (Print Current Page)
CNEDVTNADITUFEFERALTHRIEFEESHLETEIEEF, BETD
LA 7ML CREMRBE—F TEESN TOSHRIA T ar MEREINET,
ENRIZTLEa—: [Home] 233 LENRITLE 2 —DRMDR—T(ZFHEIL. [End]
T EHRITLE 2 —DREA—VITBETEHLIITHYELT,

BEHDAN

MELARORE:TIRBRT (Preferences) IF A 7O DI BHRDANERE
(Note Input and Editing)IR— DIEAEE (Auditioning)l 2223V, Fid T3
VIBIRSATLWSHMEDITRTOTHEELE (Play all notes in chord when
any is selected)lPBMEINFEL Iz, COATL 3o I UITH->TNSE, FIBD
BREVITNANVDEDEER (BREVIVITH. RANT—ZFEALTEFICEE
I54E) LEEBE. ITOBHAEIRNTHBLESNET,

HIBR R ICRIUKRBZ#HFF I 5 Dorico [F.1 DUEDTATLZERIRLTHIBRLT-
EEIT HIBRENISERADTATLE LW XL EDEUEICHAIMDT AT LZE
BIRLESETBHLIITHYFELIz, ChITKY . BEDREERT T H5-HIZTVR
FIRELTEDORBZEEY VYIS HL0, FETAMZERIRT HBENL
BTYFET

BEHEHIBRLI=5E . Dorico [FETRILEMDIALLEDRLHEIZH DD T
FEERLESIEL, TNIZKRBLE-BE . RLEHOV XL LEDRIOME (&KX
T 4 FF 4 27001 [CHABEHERRLISELFTY EFTREVERER
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DT AT LEHIBRLIZHSE . Dorico [FA[EETHNIE. ZDFMOIXLEDELE
IRV EICHEERERBRLET . FREATREEVWTATL (RS— R
R8BI ELE) ZHIBRL-BE. Dorico (FZFDAVRARYILAVKIET 5—F
LtOEROZRNOFHMS VUALEORLELIGEWNMIBEDOEFEERLET,
HERIZHKTAT L (TURRES. 3—FERE.YE—MEIALE) ZHIBRLIZIGE.
Dorico [FHBEND—F LOEROFVDEHICETSHH15. VXL EDRLET:
[HEWMIBDOEFERRLET . CNLOERBEIVThE HLGERSNET
AT LEEA—ICIRO S -DICRTBEHEBBSELHZENHYET  ChIFHEEIC
LT AT LZEHIBRLI-GRITHICEGEIVET,

TRV DFH A
[T RSV DEHEHAAH (Import Tempo Track)IFA7AS I2EA T aVT#
BTXRALOT—h—ORBEITHEREERTF (Show border around system text
markers) A BMEINELIz, COA T av (&, ERICHTFRNLTY—H—%
HARALA T AV NBEIRSNTWSEEDABMIGYVES , COA T avEa4D
[CF 5L I—D—(FZEABEICERBIENTFRNLTHEARAENET,

Issues resolved

ID # Component Issue
STEAM-9198 Barlines Barllnes_ and bar numbers can now be copied and pasted as part of the same operation
as copying and pasting a time signature.
Under certain circumstances, replacing a dynamic with an SVG graphic in the Music
STEAM-9305 Dynamics Symbols dialog could cause parts of the music not to draw; this has now been
resolved.
STEAM-9189 Flows Clicking ona car_d in the_ Flows pant_el in Setup mode now correctly navigates to that
flow even if the first bar in that flow is not numbered 1.
STEAM-7952 Grace notes Grace notes on percussion kits now play back correctly once more.
Graphics . . . L .
STEAM-7831 export The size and position of text in exported SVG graphics is now correct (Windows only).
Key Custom key signatures with octave position overrides for particular clefs now appear
STEAM-9229 . . . . .
signatures with accidentals in the correct octaves in the preamble at the start of the system.
Under some circumstances, some of the notes from a trill late in a flow could
STEAM-9212 MIDI export erroneously appear at the start of the exported MIDI file. This problem has now been
resolved.
Multi-bar An immediate dynamic that coincides with the start of a multi-bar rest will no longer
STEAM-9195 .
rests cause the multi-bar rest to be broken.
Multi-bar Dorico no longer crashes when attempting to exclude single bar multi-bar rests from
STEAM-9213 o : . .
rests spacing in the presence of multiple local time signatures.
STEAM-9197 Note input When pasting a selection that extends the flow, Dorico now.cor.rectly adds an extra bar
if necessary to ensure that any item at the end of the selection is shown.
Noteheads The stem attachment positions for the wide diamond notehead have been improved.
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ID # Component Issue
STEAM-9239 Page layout System .and frame breaks at tacet flows are now considered correctly when
determining whether to wait for the next system or frame break.
STEAM-9288 Playback Under certain .C|rcumstances, stgrtmg playback from .mlc.zlway through a flow could
cause notes prior to the start position to be played back; this has now been resolved.
Playing Changing the global space size at a system break now correctly causes playing
STEAM-9290 . ; : L
techniques techniques following the break to redraw at the correct size right away.
: ' Dorico will no longer crash on start-up if it encounters files other than Dorico projects in
Project files
the AutoSave folder.
STEAM-9122 Project files Dorico no longer cra_shes Wher_l saving a bac_kup project if the project flename contains
an unmatched opening or closing parenthesis.
STEAM-9270 Rhythm Dorico will no longer sometimes crash when extending a rhythm slash region into a bar
slashes with an open meter.
Time Selecting a barline belonging to an open time signature and hitting Return to open the
STEAM-9193 . . .
signatures Shift+B popover no longer sometimes causes a crash.
STEAM-9140 Tremolos Resetting the beamlng. of notes with single-stem tremolos no longer incorrectly
prevents them from playing back as tremolos.
STEAM-9178 Tremolos Resetting thg beaming of notes with multi-note tremolos now correctly immediately
removes their tremolo effect in playback.
STEAM-9245 Tremolos Actlvafung the Single-stem tre_molc_) prope_rty_for a n_ote ina tie chain no longer
sometimes causes the rhythmic splits earlier in the tie chain to change.
User interface The keys [and] are no Ion_ger bound to the buttons to show the information for the next
or previous flow in the Project Info dialog.
User interface It is now poss_lble to specify Pitch of A4 to three decimal places on the Tuning page of
Playback Options.
The step size when incrementing or decrementing the value via the paddle arrows in
User interface  the multi-unit spin box used for measurements is now more appropriate for each unit
type.
The space size and page dimension read-outs in the expanded cards in the Layouts
User interface panel in Setup mode now use an appropriate level of precision for each measurement
unit.
STEAM-9105 User interface The Delete Lay(_)ut button in _the Layout_s p{inel in Se_tup mode_ now yvorks correctly and
no longer sometimes results in the application crashing when it is clicked.
STEAM-9113 User interface The dlsplay of the current layout transposition (i.e. concert or transposed pitch) in the
status bar is now always updated correctly when switching layouts.
i . The rhythm dot buttons for the left- and right-hand side durations in the Tempo
STEAM-9194 User interface Equation section of the Tempo panel now update correctly.
STEAM-9207 User interface Home and End always move left and right by a screenful in galley view, rather than

sometimes incorrectly using the width of the first flow to determine the increment.

Video

It is now possible to set a very large video attachment position (9999 beats) in the
Video Properties dialog.
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TATLZERETSD

[R&E (Edit)] » TR¥ER (Flip)Ja~wrRAFzICEBmMEnELIz, TI4HILEDF—
R—FLa—rhyMETFITY , 2OATURIEERD L TFICERESNDSZTRTOTA
TL (THXRRRNZAT L TG, 7—T4F¥2L—2avil) OMBF RESEET,
Flz. HRB.RS— BB EDTATLOAEE RESEET,

—EDTATL (FA. 7—T4F¥2L—23 73 E ) (FFEE—FTLAMERIIZER
TERUH . REEZTHEADDLEEE—FOALLEYET,

HMEE—FTEREAADE, F—FR—FLa—thyrDTFIET TIZHFRERIFIOA
AICENYEHTEN TS, BIRLIEZ7ATLDOREIITHEAFEA. BFRDOAS
RIZERLIETATLERETESLIICTT HICIE. TREFEETE (Preferences) D
[F—HR—FSa—bkhyk (Key Commands)IR—C TliEs (Edit)] » TR
(FliplIS2B5F—DHAEHEEEIY LB THEELET,

TATLEREESESE., T BB (Placement)1&E /=X AR (Direction)]
DTANTADEEINES , TATLERGSE THLMBRZIMYETICIE, 7R
INTANRIITHIETDTANTAZXTIZT 50, THRE (Edit)] » [FRPIavzE
J£vk (Reset Position)l1Z#RLET .

BRDET AUNEFDODRT— (FEAFEREFC S FRORT—) H EXRE
FCERIHCEROATENTIVINEARZRKED (., FHLEHE THRHONE
T EBDAT—OEFEZERLTVDEER . ENOI R TOARDBEAEHEN
—HBLAWVREY, B EToOLWThhICAN I TREELET .

BERE

TPz TEE D, Dorico (X MDorico 7AY xSk (Dorico Projects) |7+ )L
F—RNIZHATBHRE (AutoSave) | 7AILEF—IZTADILOaE—FFEHMIC
R7ELZEY (TDorico FAY Yk (Dorico Projects)1Z74 LA —I&, TIAILLT
FA—H—TFTHIUrDIEFa AV (Documents) | 74— SN TULVE
) TADTILEFKRELTWVEMN-T-ELTH. Dorico [EBEMRFELI=TR
CIONEBODTEICEHLET . TDHAREIZ Dorico B3 valTh, R[E
EECETOCIFORZICBBRESINFN—DaVFRETES2H. Y
BELEEER/NRICINZONETS,

5R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

BEMRFELI-TOP VML EITR: Dorico N Zviall-ZIcEREIE-LE,. E
BETEZRHREINLTODIMBIB R RTFVV 2RI -V DRTE
[CUTDFAT7RTNRRENET,

Recover Auto-saved Projects

Dorico did not close comrectly last time, and the following auto-saved projects can be recovered. Any
listed auto-saves that you do not recover naw will be deleted.

B beethoven-ops3.dorico

B Ritevin |Ldorico

| Discard All Recover Selected Projects

TIAILETIE, BBRESALTOD IS RTORENMBESAET AL URE
NO—FOTAD /DA EEREL-WVEEF. BELZVWTAS IO F vy
RyOREFTICLThE, TBRLEFADVFEEE (Recover Selected
Projects)1& 7" ) v ILET, £=(F YAMAOWThOTOD /M EETIHNE
NEWNSEIE. T RTHZE (Discard AlNIZEYIVILET . RIVEIIVITBE.
BERFESNI-TODIIMNEITRTAEICHIBRESN . Ch LB O RE L TERA
5D TEBLTLESLY,

ooz rDEIERIE. TIPMLIL (File)] » T{RTE (Save)lZEERLT. FO>zy
FERABICRELET . TOE. RETITODI VMDD I7A VB ERET HIGFH
EANTEESIROONET,

BEREOMBELEETS: TIAILLTIE, Dorico F7IT47HTAPcIME
5 ACLICREFELET . COMRBEERTHICIL. TRIERE (Preferences)I1®
[24& (General)IR—CDII74LIL (Files)1toavIchbIBEMEEDMRE n
9 (Auto-save every n minutes)|ZEE D BBIRFORMBICHRELES . BEIR
BRZTDLOEENTI5EE. TEBRGFOME n 2 (Auto-save every n
minutes) 1 F Ty IRV IREFTIZLET,

BEREFEDSHEEET S TIHINEIERGIEFRICBEBRERIAILS —%
IEEITHEEIE. TBIRERTE (Preferences) DI £ (Genera) IR—C D I774
JU (Files)1t2oiavIch b BEIREFEIAILA— (Auto-save folder) JD A IHFED
HOIMRIR (Choose)IRFLEV )V ILET CCTHRELEIAUS —DNFEELL
LM &, Dorico (FEBIFFICZEDTHILT —DIERERAFET . IBELIZT4HILT —
[CEZFAATELGIMGS . BEIRFIEEEE T . ESLThbIER A, TIHILE
DREBMEEETIESIE. —F—Th I ZOEFRICEEICT7AILE
RETELILEW T HERELTZEL,
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BHEOTOCIIMERWRETOBEBHRE: BEDEOIZTIT14TITLTST
270 UMEIEBFIC 1 DEFTY, T0H. EHOTOC IR TS
BIE. 7OT47GT00 Y0 DFEYBBRFORHREICELLFRTHEEFOTO
CIUMDANEBRFEINET . EROTODIMNEEREICYIVEATLSEE
[T, BBREFOMBRENSCRETHELEEETIHLET,

EBREARFTINDEE, TOSIIFOFAR(TEoTIE, TOSIIRDEES,
TAYSLORSHEELHBENBYET,

HERELE-TOCIIMDHEIRR: 7Oz EFLSE. BEIREFESNED7MLIE
ENEEIZHIBREINFE T, F4kIZ, Dorico # TEEDE, 7TIr—a>nETEED
[CEBRBEIN=IT7AILIETRTHIBREINET,

IO URIDN—DavICRIRENHSHHEEICEA . Dorico [XTI4I/LE
T. 7Oz OMERETH-VIC. A—F—DTFFa ATk (Documents)1 7+ LA
—®MIlDorico 7AY x4k (Dorico Projects) |74 —ZHAITAP IR E/RY
9797 (Backup Projects)] ZAILE—DHIZ MG BBRDTHILT —%4
L. ZQRIZTASI VDAY TavhERELET,

INE#R

RN 1 DOHMEXICH T LB /NEHR: [EREEA T3> (Notation Options)]
DOTNGEIER (Barlines) IR—VICIRAIDMEBRICHEAERORBAED /MR
(Barline at start of systems following first system) 147> ar N #FHf=IZBMNE
N EBRD 1 DOMEBORUDHEELYEICE. HEO/NEIRERITITESLIIC
BYELIz, CORFTRAMEIFEZDU—FR—FT. EBEIE 2 DOLUBEDHEED.

HERDFIR M EN LS EBLTOSERICERAINET,

G3521499DEEHL

ETHLRAI7MIL 4 TEEHLAI7M/I)L4A (Export Filenames)l1&4 A4 70T H
FLGEMSN, EEHINBTFT4VIDITTANEREERT D I7AILEERHA
XEFEINERETEET A A7AJ (2L TREEE (Preferences) DI T7AIL
(Files)IR—U BT IERTEh ., FIEHRBE—FOERIONRIILTIHA%
(Destination) IMI4'524v% (Graphics)lIZERESNTWSIGEIC, TEEHLA
T7AIL& (Export Filenames)1&9)vIL T A7 AT EMAEFET,
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Export Filenames

[
Filenames for Portable Network Graphics [PNG) v

Filename recipe:

$n-5l-5t-5gl

Copy o All

Preview: 01 - Full score - Untitied Project 1 - 000.png

Filename ingredients

Project filename {51) ! Project title {(St)

Layout name (S1) [ Layout number (Sn)

Date YYYY-MM-DD {$d} | Time HHMM (Sh)

Page number [$p) |

Default separator: | -

Cancel m

FATOT T BR—FENTWVST T4V IR LIRS T7M LB ERA
XFHNEHZETEEFT  FAT7RT LBDII27AIWNEBZFERTHEKX (Filenames
for)IFAYTH o A=a—ho RETIXFIOHAEERLES ., [T7MILE
Y AXFS (Filename recipe) IIRYI R T, XFIIZT7MILEBDEREREE
EEMELRERTEES . FEFA7OT THOII7AILVEDEHRESR
(Filename ingredients) J/R22 %0 vV 9 5L MEDXFIDREREITHERE
FEEBMTEFT BREROAMZIC.TTIHILFORYIYXFE (Default
separator) IRy AR DT HF A E L TEMEINET,

BATRTERWNEE(TOC I T IOTAITEBE X BED XTI EFEAL
TERSNET7AINBDRTRBIN, TFUE1— (Preview)JIZRRENET,

XFHNE R EIC) g B TTI4ILMIYUtYh (Reset to Default)l
UL LET . BEDXFIEMD IR TOESFHLEKITOE—TBIZE. [T
RTIZaE— (Copy to Al)IESZYvILET ., PDF [ERILFR—SHATHS1=0.
PDF X DIGEE. R—CBEDF—U I SpINERLIzEBYIZEBRINGNIE
[TEEL TS,

rEEHLAI7CIL4A (Export Filenames) ¥ 47045 T:EIRLI-EEIE Dorico
DBERFEICERESN. TRTOTOSIH/MNERENET.

BEHLIANE — 57499774 ILDEZTHLEERDTAILE—(F. TOPT
SRS EIZEEEINE T, TOC /MDA E1—5— (BB T 5. Tt
—H—moTACIVMNERITRAEGEES (BICTO1I—HY 184S OS £T
Dorico Z{EALTL\SIHEE). TADIIMIBBEINTVIESHLEIL. Shh b
ZTOTACIHMERCAVE A —3—TET7 VR EIEBERATELRWMGELH
YEY, Dorico [FINERHLIZHE . EEHLATHILF —ETOD IR EDIOD
BRI NEIALE—ICHBMICEHLET, ChickY., BRIV E 1 —4—
TRESN:TOD IS T TT190FEEHTEEIC, 5LV IS—H KRR
SNBENESITHEYET,

gR—T Steinberg Media Technologies GmbH



@ steinberg

LAL7 Ik
LAT7IRESDOMIFTEL: TERE (Setup)l » TLLPILBEBEDOHFITEL
(Renumber Layouts)IAFHLGEMEN ., LATIRARILDY) AMIRRENDIE
BITWHOTLAT IFEBERETEDRIIRYFEL ., CHIZKY LAT IR
IWHADLAT IRV I LTREEDIEFBICHUVEZ THL, IBRE (Setup)l »
[LA7IRBEDFITEL (Renumber Layouts)1&EiIRT &, HEIZLATIH
BEEDMFTELATEZET .

N—MREIE—T S TEE (Setup)] » [—kXZEaIF—F B (Propagate
Part Formatting)1&#ER T HMEIZTLL7IMA T3 E&EHS (Include layout
options) IF Ty IRy IREFICTSHE, JO—RELELVEFvbDTA—(C
B 3R EZIE—TELKIITHYELT=,

MIDI $%EF

HifRZiEDH 5 94284 XAF 3> (Quantization Options)1# 475 E LUV
[$R%k (Edit)] » TEIA>E/4X (Requantize)1Z 47042, THREENHS
(Fill gaps) 77 avhEHLGEMEN ., MIDI §kFE=1E MIDI 774 ILHHAH
[CRBEHEADICEVT, B/~ EICELIHREIEDIRNENEINERET
EHSINTBYFEL -, FHRALERT—INT TICERITIA A XINTNS
BRI BREKRFTOTAL—2av oAV A/ X ERLERIC—BLTRESH
58I, THEZEHS (Fill gaps)I&ATICTHIEEHETITOHLET,

E7/ORE)25: TRIBHRTE (Preferences)|DIB&E (Play)IR—CDIFE
(Recording) 1t9avI(ZICC64 H#RAIJVBRELTHEAAL (Import CC64 as
pedal lines)lA 7> avh#FHLGEMEN, MIDI S5 H KLU MIDI 771 IILDFHH
AHEFIZ HRTAoRF)LAVO—F—ERT LR ELTRRT 2 EINEER
TEAHLIITHBYELTz, SLICTNICET BF Toar ., [IRFILBRERMOREICRFY
793 (Snap pedal lines to previous beat)1Z4 (23 %&, ERESN=RF )L
ROMIBMNEZ. BEDRLELAZR (RILEBORAUEDNERELIENT DR
BEUERTHH>TH) HOWDIZRFYTLET,

EvFDOAN: TR (Write)l » TEYFD AR (Input Pitch)IOHYTA=2—T
BEIRLTLSETEN MIDI FFEFRICLRBEN, FEZRAT TLEETHLIIEGR
BEIITHEYFELI, SHICEYOA, F3—  AVRINRGEDAVI—THIRAZERIE.
MIDI AADELWAIE—T TEREINSLIITHYELT=,

RUHH
ERICATF AL THRANTZATLANNEDFRIRMEICHDHIEE . TD/NMEHIHE
I ORAKRFENOTEERICHREL TLEICENGLRYELT =, Efit T D RAFFETF
ARTATLIZEDTHEISNFEIT N, THXFANTATLANE DB EIZH D5
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&IZIRY, ZO/MHIERORAFIHEShET,

AFTyb: TL—NY—m70—(CEY S TONGEHNSEEEIFHNMEE. [2F Ty
MORAKRFNRTREINFET (ChiTKY, BERNFoIARRSNGVNEFIVEDT
A—&ERBIENFET ), ZE—DEUNELHIEL SR F2ER EZ2—DHILEITE
ESh3LDTHA5E . 7O0—IZH(Ttacet |ERTT DD TIEAL, Fa—m5EW
CEETL—V—D— B TEMBTELLIIC /MHERTLEZVEEShELIEE
ho CNERBT B0, FEA T3> DIMKRF (Rests) IR—P(2IoA—(C
[Tacet |JZT/FTTH/NHHMDTZE/ME (Minimum number of bars in flow to
show ‘Tacet’)1A 7T avhFHLGBMENELIz, TIHILATIE, 16 MEIUT
O70—(Z[ZNEHBARTEN, ChEYRWNTO—[Z[FMtacetINRRENFET

1 INERDINEIARFTF DR RAFNRRENHLATIMIBNT, HEFTavm
(AR (Rests)IR—T DIl INFAOKRTIBED/PMHHDETR (Bar count for
single bar rests) 1A /MEEEZL (No bar count) JIZERESNTULRIGE. 1 /IMES
QIMEARFICIERAFT TG BEQ/NHOIRENMERSNSKSITHYFEL C
DATL TN DEERT (Show bar count) JIZRESNTNDIBEDH .
TIZHBIRAR—L Y (Spacing)lFFLavTHRELEBEAMERINET, ZOH
RIZKY.BEENTOT Y% Dorico 2.2.10 TRLV=EE SN DT HICELL
I HGENHYET .

BE

BEERREE FHRCIGKETLLTERINEREEN BARICELRDNDS
FITBYFELS -, BEEDERRIELIE, TNARESN-ERFEIEMBEOHIE
AShd30ThHY (L. BEFFELIEMBOLICESELTRESNDIRFY
T-EFH—IRE) BROESRREELE BEMOERTRYEINIETHRTS
HLDTY (fz&AIE. TFRAMpizz. JTRESN. TDHETFRXMarcolIZ&H>TH
VHSNBEFHh—MEL),
BEEEGESM W ERFLIENBOT2L— a3 FELRBEL. BFELIETE
DELYEEDIZ, TORIDBERREZZREBEIE S LIITHYEL, ChIZEY, F4
—DN—FEZHR BZBBORFTVT - EFH—MEEDBEEEN (Fndh VST
IHRTLYIavIvTICEBINTLSEEICZRY) ELKBEINET,
Sa—MNA—TU: EEEBTRNEIL—FDOEEN, BEBICELLEHONSEL
SI2BYELIz, SNFETIE. A—T U022 — IR EDIB RN H>THI2—FD
PMENELRYEEINSZLIFHL HBZa— Mo RIDIa—k (F2EAIFRN—
Sa—kSHYTIa—b) AOEFHRTRBELBEELERATLz, AN—DaY
Tl S DBERBCEIFT TR TELL BN S LIITHEYELE: (=L, VST T4
AT avIVvTICERINTVARENHYET),

10 R=Y Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg
BEMRBES: RENABESOKRIC. Z0RBOHALE KA DRHIRTS
BENHURE (FEAE mp HOBEDZTISRIVRORIC ff HEIBES
). BEMBRBRENERT 2AROBRBA . BEICRBENDLIIHYELT,
CNETH. BRNABREEORBOAANZOROBIHMABLSIc LESS
izt dim. DRI fFf PHEBEE. SLy U RELTEESATLEST
WEL,

Rl

BRDOES: HMRFEIXT T4 DEETHLO=HITERSN 2/ S\—FL AT IF
D535 1 DULEAEFTRRICHRESNTLSIGE . FIRIE—RTIEIR (Print) 1
IEMEEHL (Export)1z9)v o 5L BEEL4(TOTHARTSIN, —HOLA
PO BRARSRRICHRESNTODIEBESN ., TNOEBHBMICHASIC
BRETOINEINERIRTEET,

Layout Transposition Warning

[f88A%ZE (Change Transposition)1Z2Uvo$5E. DANMIRTSINTZT AN
TOLATOABRTICEBmSN ., IRIFE-FZEESHLLIETINET . [FDFE
#E1T (Proceed Anyway)l&xoUvo9d 5L EBEDEFFELATOROHRIFERITE
SHLAERTINET . [FrIL (Cancel)lFEVvoT 5L TRTOEMELAF
YORILENET, —HOLATIOMNDAERRAETICERTHEHEIF. ZELGLL
A7 9 DFzv IRy IREFTIZCLTHL. [BAZEE (Change
Transposition)1#2)voLET,

HAZLRAMY AR 912" RERRBER—SH A XEFERTHLATIMIDNT,
BRLETI =D T IHILNTIORBY A XITRHIEE T LHALIOTEUE
DRAKICIERET 25E . BIRLER—DH A IHFREORBT A XZEBT SR
Y. BRIE—F DY A X—EIZRRENFT  ERRICELKHIRISN SN EIMNE, T
B —DHREREEBYET

JE—bT—h—

JE—rEIE: TYE—FEI# (Repeat Count)lD/N55S5TRAAAIILHAEFLGEMS
N ERILVE— MO a3V KEICRTRENSTFXMPlay 4 times D4V &%,
ERSNILONBEEREICERTEDLSITHYEL,
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BEMEMER: FEA T DMK Barlines)IR—UDIR1E (Repeats) it
g avcla—Sh o/ g# (Barline coinciding with repeat jump before
coda)lA T avhEtzICEBmMEnELz, CNIFO—FERIO/NF DR THEIC
BEMICERIRERT I ADNEINEIETEET .

)X L DR

Ay aBEE SV E—MEE: XYL YrDRENSRTYY 18 FE (&
INE) E—MEEZER TEDLSITRYEL -, CNETRHERMMIZTERT D2
ENHYFELT=,

TXAk

J0—&5: [{@flowNumberRomanLower@}1H &V
[{@flowNumberRomanUpper@} 1D r—o U h#FHLGEMSN, 70—FFZF0—
IEFDOINXF (i, iv, x 5E) FIFKRXF (I, IV, X 7E) TRRTESLIIIL
Uibf:o

B¥iEs

TR0 MNE: TONRT4ARILOTAFESE (Time Signatures) | /L—7IZ
r1 INHHZETF 2 7298ELTH IL—F{E (Group first bar as pick-up)17E/3F
4D FHLGEBIMENFEL -z, CNICKY  AFEBTEROZA/NDY X LD IL—
TELEESTEET 7OI2VMME L DMEIDIZLHMBIBIZHD AT EHDT
(T N DR DY DNSHICAD T B TYUXLMIZT IL—TeshEzT,
Dorico (&, Ea—)RTA4UREFERALT. IEDERNHET Y IR2I NN EATR
ITHEIDERELET,

Ea—URTAIANBOLMERZL-LELVMEEF. 1 IMIHETII2I0E
LTY I —F1E (Group first bar as pick-up)17O/\T4ZAVIZLTEYIZERE
FBHEITKY, ToIAY NN EHAI LT /NETE SR FI A CAZZE R A ZERI/NET &L
T N—FLzY BEMLER/NETEEHERI L/ NSRRI T D 720 M
EiELTY L—TILIYTEET,

I

FILDERE: BEA TV OIEME (Ornaments) IXR—UDIRJJL (Trills) ]
5 avIZHATMIILOEERLR (Extension line for trills)JA 7L a(THFHLLE
REEAEBIMSNFELIz, RS TOENNI-FHFIZERT (Show on tied notes) 1%:&E
RIBE ML RLTOELINIZEHOFEICH->THGGEIEBBMNICER
BOKRTEN, MILHFEE 1 DITRHKUGEE #r BB DANKRREINET,

HENER: PSR RSNDHBERICHEEYIEEATEDLSICRYEL,
CNISKY EABMLEDEREN—EZIVREST DI THITLRAFT,
HOEFICERIAMEEEETDICE MLFEHBEFZERLTESR
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@ steinberg

(Edit)] » TH#EE (Noteheads)IA=Za—MoEEDHFELYFERIRLET,

BRENIZVUICEESNMN L CIEIEERNBEMICERRICEYET . 12
=L, BRI LEESSN-GEE. M ERIRRINET,
A—H—AA—Tx—R
DRATLISYY: SRTLRNIYIDIIL—Z—D BEYN. BRBFORLVMNGIZE
WTHELLRRENSLSITHYFELT,
BETUIL—F VRNDTATLEZTILY)vI T 5121+ T. TBE (Play)l »
[BEToFL—b (Playback Template) D RIREHETE TS ELITHYELT=,
N—hyiarwyd: RERIZBIRLIZ/A—DyarwyT T$RTERF (Show
al)J/IMERASFD MIDI /—h%EFRTK (Show MIDI notess in use) JIDEIRIRE, &
KUBFA7AT DY AXANRESN, B—viardThHnlL, THE (Play)l »
[I\—HhvwiarvF (Percussion Maps)I CTHERRLEZE. RELRENET
b &I iEYFELT,

FRF—R—Fa—rhyb: TRIEEE (Preferences) 1D F—R—Fa—rAy
k (Key Commands) | R—IIZULDOMDFHIATURAEMEN, TA/T1/3R
ILABTLARITTEGVDLKDONDIREIC, F—R—FLa— v ERETESL
SITFYELT=,

» TERRFEES ORTF/IFERTEYVIVEZ (Toggle Accidental Visibility)l: #EiRL
RERELITEMEFICHL. BHOICERBFRESDIERT. ®R. FBIlAER
REIRFICOYVEZET,

n [EEEFEE B4 IERT (Hide Accidental)]: BIRLF-BERFE-(XEMHBTHFIHL.
sEhilH RS EIERRICLET

n [EREFEEHBZ#RT (Show Accidental)]: BIRLI-FFE(EEMTHFITHL.
SEHlI RS E R RLET,

» [ERERESZIENMAIZRTRT S (Show Accidental in Parentheses)): #iRL
FERELIFEMBTRICHL., IR S EEIIAETRRLET,

n TLEJsTLAAEYIYEZ (Toggle Laissez Vibrer Tie)l: BRLI=-B R/ ET=
(FEMETRFICKL. LETATLRADRFIFERTEVVERET,
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Issues resolved

@ steinberg

ID # Component Issue
STEAM-4241 Accidentals Changing the pitch .of a grace note befo.re the barline no longer incorrectly considers
the state of the accidentals in the following bar.
STEAM-8900 Accidentals A numbgr of problems rglated to the appearance and dlsappear.ance of accidentals
when using the Modernist accidental duration rule have been fixed.
STEAM-9075 Accidentals Under some circumstances, ac_:c.lde_ntals on altered unisons cc_>u|d appear or disappear
when editing surrounding music; this problem has now been fixed.
STEAM-8916 Audio export 'rAeL:S;cr)] export no longer fails with an error if the project or flow title contains a carriage
STEAM-8944 Bar repeats When using fixed casting off, bar repeat regions now correctly respect the desired
number of bars per system.
STEAM-8974 Sy Ties Under some circumstances, adding a special barline could cause a crash; this problem
has now been resolved.
Brackets and  Nudging the handle on the top or bottom end of a barline in Engrave mode no longer
STEAM-8889 : -
braces sometimes ends up reselecting the wrong handle.
Brackets and ' Creating a bracketing change at the same position as an existing bracketing change
STEAM-8917 ; S
braces now correctly overwrites the existing change.
STEAM-8991 ST _Under some circumstances, nudging a long octave line in Engrave mode on an
instrument with divisi staves could cause a crash; this problem has now been resolved.
Engrave . . . . .
STEAM-9003 mode It is now possible to set the constraint properties for frames to zero in Engrave mode.
STEAM-8913 Fingering Fingerings for_ guitar in projects 'created in Dorico 2.1.10_ or earlier no longer
unexpectedly disappear when opening them in the current version.
When adding a player to multiple flows, the player is now correctly added to any flows
- Fl . - ;
STEAM-8931 ows that it was not previously attached to, rather than not being added to any of them.
STEAM-8955 P PG Cha_ngmg the instrument held py a player to an |nstrum_ent w!th fewer staves than the
original instrument no longer fails if the top staff of the original instrument had no music.
STEAM-8996 Key Under some circumstances, editing the current tonality system could cause some or all
signatures of the music in the flow to appear to be deleted; this has now been resolved.
STEAM-9020 Licensing On some M_acs running macOS 10.14 Mojave, Dorico could intermittently hang during
start-up. This problem has now been resolved.
STEAM-8928 MIDI import Import_lng a MIDI file whose trgck names or other metadata use unexpected text
encodings no longer causes Dorico to crash.
STEAM-8894 MIDI The first note input via MIDI recording is no longer spelled as if the key signature at the
recording start of the flow were active rather than the prevailing one at the recording position.
STEAM-8920 MIDI . .
STEAM-8952 recording MIDI recording now correctly takes repeats into account.
STEAM-8921 MIDI _ E_dlt »Requantize now works correctly in irregular bars and all kinds of compound time
recording signatures.

Dorico 2 /N\—2av R
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@ steinberg

ID # Component Issue
MIDI MIDI recording now correctly takes into account the current setting for Write » Input
STEAM-8924 - ) . o . . .
recording Pitch, allowing you to record in either written or sounding pitch.
STEAM-8929 MIDI _ Edit >Requ_a_nt|ze now always correctly applies the specified minimum note durations
recording when quantizing.
STEAM-8948 lr\flalctt)nlrding The transcription of tuplets in irregular meters has been improved.
MIDI Recording onto one of the instruments belonging to a player holding multiple
STEAM-8972 . . X . ; )
recording instruments in galley view now always records into the correct instrument.
MIDI . The metronome click now plays back correctly in irregular bars that are longer than the
STEAM-8998 recordingMIDI S .
. prevailing time signature.
recording
MIDI When recording into a flow other than the first in a project, the correct key and time
STEAM-9062 . . . ;
recording signatures are now used for notating the recorded music.
MIDI When recording into a flow other than the first in a project, the first note recorded is no
STEAM-9068 s .
recording longer sometimes dropped.
MIDI When recording into an instrument that has extra staves added, pedal lines created by
STEAM-9076 . . 4
recording recording sustain pedal changes now correctly appear below the bottom staff.
STEAM-8914 Mixer Changing mode with Fhe Ml_xer open no longer causes EQ, sends and inserts sections
for each fader to be hidden if they were shown.
. The mute/solo state of the video fader is now correctly reset when a new playback
STE A Mixer template is applied via Play » Playback Template.
Multi-bar Single-bar multi-bar rests now use the double whole (breve) rest instead of the whole
STEAM-9051 ) : . . ; .
rests (semibreve) rest if the option to show bar rests in long bars is set appropriately.
Multi-bar .
STEAM-9056 rests Multi-bar rests now appear correctly where a grace note appears at the start of the flow.
Music When using an imported graphic in place of a music symbol, when printed there is no
STEAM-8075 - ; .
symbols longer a slightly blurry image for that item.
STEAM-8912 MusicXML Under some circumstances, gradual dynamics with large offsets could be imported
import from MusicXML files with incorrect durations; this has now been fixed.
MusicXML Under some circumstances, gradual dynamics can be exported from Cubase with
STEAM-8988 . . ) -
import excessively large offsets; these are now truncated to prevent absurdly long hairpins.
STEAM-5290 Note input When using step-time or MIDI recording for octave transposing instruments, the pitch
you hear is how always in the correct octave.
STEAM-8905 Note input Under some circumstances, doubling qr h_alvmg note duration with the caret visible
could cause the caret to advance too far; this problem has now been resolved.
) . Pasting material copied from an unpitched percussion kit onto a pitched instrument
STEAM-8982 Note input now correctly overwrites the existing material on the pitched instrument.
A redundant clef no longer appears at the position of an instrument change between
STEAM-8956 Ossias two instruments using the same clef if an ossia staff is present on one of the

instruments.
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@ steinberg

ID # Component Issue
STEAM-8995 Ossias Whep using Split Flow, music on ossia staves following the point at which the flow is
split is no longer lost.
STEAM-9001 Ossias Em'pty ossia staves no longer appear or disappear incorrectly based on the layout
option to show extra staves across the whole width of the system.
STEAM-9027 Ossias Shoyvmg a mid-system preamble on an ossia staff belonging to an instrument held by a
section player now works correctly.
) . Under some circumstances, an ossia staff could be made to appear when the main
STEAM-9031 Ossias staff associated with it is hidden; this problem has now been fixed.
STEAM-8902 Page layout cDI:)e::EO no longer crashes if a flow overflows the end of a layout-specific music frame
STEAM-8910 Page layout Using _Any flow startlng at to_p of page option to use the Flrs_t master page no longer
sometimes causes music to disappear when at least one flow is tacet.
) Time signatures could sometimes appear incorrectly at the end of a system involving
STEAM-8911 Page layout transitions between instruments with differing number of staves; this is now fixed.
) Break signposts on tacet flows now correctly respect the View options checkbox in the
STEAM-8922 Page layout Annotations section of the right-hand panel in Print mode.
STEAM-9039 Page layout Adding extra staves bgfore the flrs_t existing position at v_vhlch an extra staff is added no
longer creates an additional staff, instead correctly reusing the existing extra staff.
STEAM-9057 Page layout When Iea_vmg the master page editor and choosing to discard the changes, the warning
about losing those changes now appears only once.
Under some circumstances, flow headings might not be updated correctly when they
STEAM-9060 Page layout end up being moved to another page by casting off changes; this has now been
resolved.
STEAM-9013 Pedal lines Under rare circumstances, a pedal Ilne_of -a very particular length could cause Dorico to
crash when printing or exporting graphics; this problem has now been fixed.
STEAM-9058 Pefussion Note input c_Jnto a percussion kit will no longer incorrectly duplicate existing articulations
on other voices in the kit to the newly-input notes.
STEAM-8741 Performance Some_ of the panc.els in Write mode were unnecessarily recalculated every time the
selection changes; this has now been resolved.
STEAM-8976 Performance The system ;rack has been optimized and now ha_s _con5|derably less impact on the
speed of editing in both page and galley view when it is shown.
STEAM-8981 Performance Dorico now breaks a_Ilgnment in Iargc_e dynamic groups with gaps of 12 quarter notes
(crotchets) or longer in galley view to improve redraw performance.
STEAM-8984 Performance The speed of opening large projects with many playing te_ch_mques, and of preparing for
playback after making changes to the music, has been significantly improved.
STEAM-8990 Performance Double-clicking to edit an item or show the caret now works rellably in larger projects, in
both page and galley view, whether or not the system track is shown.
STEAM-9032 Play mode Switching layout in Play mode now correctly ensures that the tracks for all players in

the newly-chosen layout appear populated.
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@ steinberg

ID # Component Issue
STEAM-8754 Playback The playback of microtonal dyads has bgen improved; both notes are now played
correctly under a much greater number of circumstances.
STEAM-8896 Playback The score is now always moveq to keep the playhegd in view; prewously it could go
wrong if the number of systems in the flow changed since the project was opened.
STEAM-8906 Playback Ple_lylng technl_ques on the first note of the flow now play back correctly when multiple
voices are active.
STEAM-8954 Print mode Unc:[er some circumstances, print options set in p.ropcts. last saved in Dorico 2.1.10 or
earlier were lost when opening in the current version; this problem has now been fixed.
Repeat Changes made to the Repeat Marker Sections and Repeat Marker Jumps paragraph
STEAM-8933 . . X
markers styles are now correctly shown in the layout immediately.
STEAM-8915 Selection Shlft+c_llck|ng in an empty part of the staff no longer extends the selection to the wrong
staves if the bar contains a fermata.
STEAM-8965 Text In Dorico Elements, it now possible to edit the text in a frame more than once.
STEAM-9014 Ties Tie endpoints now correctly avoid rhythm dots on unison notes in opposing voices.
Time The Ends interchangeable property is no longer sometimes incorrectly deactivated or
STEAM-8966 . - - . - . . .
signatures reactivated when undoing the deletion of a time signature in the interchangeable set.
Time Flows that begin with an interchangeable time signature where the first bar uses a time
STEAM-8967 . . . ;
signatures signature other than the first in the set no longer change appearance after reloading.
Under some circumstances, a trill interval of a diminished fifth played back incorrectly in
STEAM-8930 Trills the lower octave rather than the octave above the written note; this problem is now
resolved.
STEAM-8620 User interface  The positioning of the score when switching between modes is now more stable.
STEAM-8840 User interface The correct tempo value is now shown immediately when activating fixed tempo mode.
STEAM-8880 User interface Creating or deleting a tempo no longer causes the tempos filtered by the slider in the
Absolute Tempo section of the Tempo panel to be reset unexpectedly.
STEAM-8918 User interface Changing the selected Iayout in the rllght-hand panel in L.ayout thlons now correctly
causes all of the other options in the dialog to be updated immediately.
STEAM-8980 User interface MIDI triggers for key comma_mds that require multiple notes to be played are now
correctly loaded when Dorico is restarted.
STEAM-9078 User interface Opening a project whose filename includes word_s like setupz config, options, or
preferences no longer prevents the Preferences dialog from being opened.
STEAM-8415 Video Incrementing or decrementing the values in the timecode spin box now always works
STEAM-9037 correctly for drop frame rates.
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Dorico 2.2

@ steinberg

HTHLRE

Dorico 2 /N\—2av R

2018 % 11 A 23 H
SDN=Ua0 DHFHEE WERBLVBRREADHEEZUTICRELES,

MIDI $&E

Dorico 2.2 I£. Y7 ILBA L MIDI $xEHReziEFHELEL-,

¥HAERTE: Dorico Z#2EIT BRIIZ. MIDI F—R—KAarE1—4—IZiEkSh.,
BIEMASDTWNBIEFFERLET, Dorico ITIRBFSTIL, 2T7HIZ MIDI T34
ADEHFREDLELEFBRETEEEA,

Flz, KEHEANETEIRNC, Vv IICEHOE TEMGV X LEAALTHS
ET.VRATLDLATUY—EFIvITHEERBTIOLET FIELTIE, iR
TR Y ERIBLT, TL—VY—%EML. 4/4 QINEIZELOMEMLET, (FL
ODRFEEIRLTEHEEZMIALI=D. VUV IICEHIZAMLZEHET 4 7 EF
ZRELTHET,

4 PERNMEIVHDTMICHICERESINSZLIELENTLLID, CODIGE ., RER
EDBEIOR—CDNERF 107 avICFHLGEMSNIZIMIDI AALATIY
—#H1E (MIDI input latency compensation)1Z 73> D {E%E 50ms HEIZK
ELT, PYLHLTHTIZELY,

HLLEEEFHIC 4 DEFIBLYRASICERESNDIEE. TRE (Edi)) » TF
ARE&TE (Device Setup) | T/N\YI7—H A XEFHOLLTH TS, FAYT TS
EOIRELGVWREL-BELTITHADSR/NEDEZLERLET, Windows T2~
TELNUA—TAFTNAREFERTEEE. EREOSWVTILIALANE
TEABDEITOENLATUO—NRONGWNMEENLHYET, COIHFE. ASIO I
595 USB ERONBA—TAH A A—Tz—ADBAEETTOHLET,
MIDI ¥—/R—K([& USB #A—TAF A 2—TJ1—RIZEEERTIDLEIEHYE
BAAVEL—F3—DF—TA4F YT RTLOLATOO—D+REITIL,
MIDI F—HR—KIF USB TavEa1—4—(l##xd n(E+5 T, Dorico &fEM
95 L TIE, Steinberg UR L1J—XD USB A —FTA4F A 3—Tx—ANRETT
OTITDN. BREL ASIO FSAN—ZHF DA —TAA AU F—T—XTHNIFE
NTLHEEHYFEE A

B{ED MIDI AATNAREEMELT S MEARETIE. /A—Fv)L MIDI 7—7
IWREFTROT TV —a B/AREE S, Dorico [FaVE1—42—I[ZH#EfidnT-
ED MIDI THRAZNHTH MIDI ANEZELET . HED MIDI T/AAZXHD
MDA AN% Dorico NZELHNWKSESETDIZIX. RBEREDODIEE (Play)IX
—JIZHBIMIDI AAT/8A4 R (MIDI Input Devices)I/hFEH)vIL T, KR
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@ steinberg

SNBFATAT TCRERTNARDFIIRIIREATIZLET,

DUIDRTE: BREERBT IR [BEA T avicHLGEBMESN I 2YvH
(Click)IN—=U T ANA/—LO) VI DEEEHERTEHLEEITITOLET . YV
VO IURIE. BBEEBE—TEBL BARETOANANA/ — LRI LD EEIEDY
VIED 2 BEHILEIRTEEY, Dorico DHHARETIXE—THAERIN, /I
gD 1 HBICIEEVELNELEN. 2 HEURIZIHESTNEHDENIBLENE
T, NSRBI ZIB S, HDOEICFSSITENENMERSLES . COTHE
9% 3 DOBRFENETNEYFERAL T —EHRETEET,

Dorico M#NHALE Tl B#MAF TIHAXS BN T . EE5HAFTEELALBIS
nEJ, OB, TESEFTHESE (Subdivide beats in simple time
signatures) | A& HAFTHZE S E (Subdivide beats in compound time
signatures)ID#A 7L 3> THIEHITEE T,

Dorico [& MIDI $kBEHRIEEIZV)VIZERLLET A, Y—IL/N—D3
ZRIVRR—PTRHET DRIV EY VDT HIET. BERIZEI)Y A
VERLEET,

)9 EBERDr—2PzL—4F—IDoricoBeep /IZ&>TREINET , Vv
[ZERTETNAREERTHEEIE. BEE—FTIALINYIDR Y IANYT —
DIAVEA—LEFERALT. VUVIEEED VST AV RRYIILAVMNIFETIL—T
AV TCEET . FENKBVIVIDIN—T1 T 1Tl 1=156. TDHETODT
HMEBEMT BT R TOFERA VARG AVMIRLFERICEDIL—T AT EITH
SHLEMRBHBEITEELTLESLY, Dorico [2KBAVRARYILAV D BENIIL—T 4«
VISR IEEIE. TBE (Play)l » TB&ETYFL—b (Playback Template) 1
BT 7HILEDBETUIL—LOVT O ZERIRL TS,

NI/ Dorico MAMAARE TIE. FERWBATICE 1 DEDHVURA DT
BHONETH. CNIETBEAF T a> 1 0I9)99 (Click) IR—=DTIADURL2D
INEREL (Number of bars count-in) 1ZZEE 35 ETHRE TEXT, 70—DEHA
MEIYVRADUETHREZHRIRT 5SS, REFRBMEIYAICFET HEED
NBEDNAI VMU E—RICBESH . FHRNOBRAEDMEZIBELLIGYE
ED

DAVBAXDEERTE: BRI HEEOABIHRVD. BULEIA A XDEREEITE
WEF 1EX X BETIRNENDHIZ 8 A EFLVEVNEHOEZTFNFEAEH
TIRBWELAOTWBBF R, VAU F3(XDEfY 8 R EFITHETHRET
T IF VA XEERTHICIE. RREEEDIBE (Play) IX—I Tl oA 484X
#7232 (Quantization Options) &%)y L%,

BEVZLOBEFEEFNDEFICIE, BRIZOALEAXFToavhMRAESNT
WET . EFZERLLGVIEN D> TWEIGEE L. EFEEE (Detect
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@ steinberg

tuplets)1Z#42I1ZLT. Dorico WWEERNRZEMELMBRMTHILEMHLELET,

% E% MR T S Dorico TIEEFFITEMO /NI LHEEERTEERA. BREH
RRTIC. TR R/IMNEDEEHDAR—ZAIMERFH THILERRBL TS &
EICIFRENRESNTLSIHEAIL, [Shift]+[B] L T/NEIE/MEIROR YT
F—NN—Z%FRRE. BT H/NEEHEAHALT [Return] 23T, EHRD/INE%E
FRGBMTEET,

BREEMETARIE. BT T HEROEFELIIRFERIRLET, Dorico [EZD
ERICHEETOIRVOEBICHEELTEFT  ET/BEDKERDAVALIILAVE
[CBRETHLEEE. EFREEFAMADERODENFIIRTLERT ILET
HYFEH A, Dorico [EAADERICHEE T HEFIL. EVFICRHVERZEBH
[CETDRERIIRYATET,

Dorico [CHEDFEADEE ., FERKEROFADEROA~NDHZRTEIETR
$55A. REERBTAMUEICFrLybERRL. ELLWEHINERSATNSS
LEXVLYNEDAU O —2—THERLET [V] 20T L. FHNERICHERAT
Sh5EYEDLY . [Shift]+[V] B TE EEOFEDAMEH SI-HFLLEE
DIEREERTEET

Dorico DR ETIE, BRBEETEOIFRMOBEDEFIIIRTLEESLFT,
FECHFEREI A EFICHRERNREY—CIH58E., REFWRAICHEE—NES
VITLET ([Q] Z# ),

ELGEIRTES. TBE (Play)]l » T&F (Record)IZ:&IRT 50, [Ctrl]+[R]
(Windows) F1=I% [Command]+[R] (Mac) Z#L T, 25 £6BLET.
BERBAIDAV O DINFBEERET AT . TBEA T3 1019 Yys
(Click) IDR—2 T AU DM (Number of bars count-in)JZEXEL
E3 8

BEPINFLEFROBEANYELBELET S, BEE—FTHEEFERTSN
FEA LOL. BEE—FTHREZITEIGSE. BEERRDAUARYILAVED
E7 /O—LICERNRRINES . BREZFLT DL BT FOEEICHLEE
RBENRRINET,

JEEREEED MIDI A AT 2R BAP(E, MIDI F—FR—FZEERLTT
A—N\YISNBBEREITETN, ChIFRATICRESILEFLA BEPRITESRL
EEEZRERLTEE Mo ILhimnoRfF N I5E. FHREFD MDI AH
T—ARGMAEFFEALT. ChEXaT7IZRETEET,
BERITXF—R—FTERLHE. BEZELLTHL BRELEBEREANTS
ERT.ANTINEOEFEIRFERIRLCT. [BE (Play)l » NERER
D MDI AAT—4H%58H (Retrospective Record) 1Z&IRT % hH .
[CtrI]+[Alt]+[R] (Windows) F7=I& [Opt]+[Command]+[R] (Mac) =L %7,
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@ steinberg

FEERETRD MIDI ANT—2EHREED/N\VI7—(TBLERBOEITEESND
=&, BRI BERIBIYATISERSNEFIIETTETE A

BERITEREIRE 5 BETETERTINDAURMYILAVMIEE T HE.
Dorico [FIRIBBFEDIFFDANEHEHE (Note Input and Editing) IOR—T(Z
HAMXINERIZT)IEADA A (Input onto kit or grid) IDFA T avIZHELNE
T o cNITKY ANESNEERD (FERBFLEANTESICHNT D) BREUEIC
BT EH . FUERT S/ A—hyiar Ty T THRESNDE Y FICRHET HH
DVWTNIERIRTEET, F1= Dorico &, FEAVRRYILAVMNIERT HFEEIC
DNTIIMTERB X YIEEE (Edit Percussion Kit) 1A 47O ([ZHEESNDFEER
DIRYDFIZRWNET,

BT RE—K: Dorico D#HAETE TIL. MIDI HFEFOTURIETO—HNDT
UREBICRVET . CNEIFELSTURTREETESEEE. TBE (Play)l
» TEETHRE—F (Fixed Tempo Mode)|ZAVIZLET, ZhiZ&kY Dorico
DHRELSIVBLERICRESIN-TUREESZERT AIIILYVET . FEET
VIRE—RDAUIFTE V=N —DIZ, SV RAR—D HOBEEERDHTE

fix2Uvo3 5 LTHUVERLNET,

> RIZHES BT

BETURE—RAALDEEIL. BEBSLUHEEDTURIIRRINIEHIEEZY)
YYILTLETFICFSYT T HETHRETTEET,

BAERE BETURTHEATITURDERL, BETURE—RETURIZHES
E—ROYVEZ BLITLHAFEA,

BOAAA4X: 5L (FX MIDI #ETHRARAENE) SHEBIAVSA
AT BICIE. BIA A4 X THEREERLT. TEE (Edit)] » TEIA 424X
(Requantize) 1ZRIRLFET . A4/ 7OUMFHE. BEREMNSEHITEILDERLC.,
MIDI $§BDIF A R REFIEET DA TLavERRLET . FHILLREEER
LTTOKIZEVIYILET . BRDOBIF 24 XHEBFICETINET,

JE—b<w—h—

Dorico 2.0 IZ8B+5VE—MMNIREIVIE—MEMOBAEOHELERLL T,
Dorico 2.2 [& D.C./D.S/aA—RGEDIY U TICET A EMGERERSERIEN
[THR—IPLET VE—FI—H—.BEE—FOIRELSF (Repeat
Structures) /S )L, Ff=1E [Shift]+[R] DRYTA—/N—MSBMTEET . LA
TIONA T EEEF T OMAIC, SESEFLREEDMAES SV ERICET
BT avhAESNTOET,

Dorico Tl& . VE—hI—h—I% 2 DIZHRFESINFET . Dv TR BIE. BEDNE
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BTERENDSYUTITEHRDMEFIEEL (D.C. al Coda %E), —AUE—r
AvF. O TITREDLE (a segno ¥ a coda HE) OEEDKRTHE
(Fine 12&) #HEELET,

OYUTRBEERT S Dy TREFERIATHL O YU TREL/NED
RKEIEMT BB, SvoTRROBHN RSN S/NEHIREERT 0. XD
INDRRNEDEFTERFEERL, LEE—FDIREES (Repeat
Structures) J/SRILWSIFERB DY TEEE0)v I S0 . [Shift]+[R] #HLT
VE—RESDRYTF—N\—%2HEET,
RyTH—N—DEXITTELRYFRRICITHEADLIICL TSSO, v T
REITEETHLERE TEANTEET . RYTF—N\—IZANTEL LD DHIZELL
TITRLET,

= D.C. al Fine: dcalf, DC al Fine, D.C. al Fine

= D.C. al Coda: dcalc, DC al Coda, D.C. al Coda

= D.C.:.dc, D.C., dacapo

m D.S.:ds,D.S., dal segno

= D.S. al Fine: dsalf, DS al Fine, D.S. al Fine

= D.S. al Coda: dsalc, DS al Coda, D.S. al Coda

= To Coda: toc. tc. to coda, To Coda

E—=bEI2avE KT 5 VE— I3V FERATHA-O. JE—r I
IVEINEDETEITEMT B, U arY—h—DEmdA iAo b/ ET#RE
BIRT 5D N OB NEDEFEIIRFEERL. BEE—FOIRERS
(Repeat Structures) I/ARILDLEEDIVE—bEHavE D)9 TBh.
[Shift]+[R] L TIE—rRBEDRYTA—/N\—%HEET,

RV TA—N—DEXIERRIC, 2 a3 KRBT HLETEUGANTENTER
(FANDIIIERESNTVET . ANTEDLDDHZLUTISRLEYS,

= Segno: s, seg. segno

= Fine: f, fin, fine

m Coda: c, co, coda

HEE P DGR O—F V2 avEERT HE. Dorico [Ea—4 EENLIRTD /METE
B[EMIZH T2, BBIMNICHEBRICHREBEALET RO TI+/LEOXRE
SlE.FEA T a0 DIYE—RT—h— (Repeat Markers) | R— T, B H®
=S5 DEIDTI4ILEDORERE (Default gap before mid-system coda
section)IDEZEE T HLTRETTEET . MHE P ORIREE < IZFHE T HIZIE.
FEE—FICUYBAT. TEFODAR—Y (Note Spacing)l'V—ILEAIZL
FI. a3V A ORBUBICRKELEAVNUFILNARTSN, ChiE
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[At+EED KX —CHBEZEGICHMARTEET, (2T [Ctrl] Fz(E
[Command] Z#J & KREBITEET )

HE P ORRBICX T 5a—FY—h—DT I+ILMIBLIAM CEE T, EAMICIE.
BELF T30 E—FIT—H— (Repeat Markers) IR—C DIKERE

(Horizontal Position)1t2>a> CIHBORBUEBDI—4FT—h—DuE

(Position of coda marker at start of system) DA T3 %EETSILET, M

[ROHLEDERBOFIBMEICHIZ SN, FREABRREIN-EHRELHATOH

EDAR—ZADRIRMEIZRIZ M ERIRTEET,

A=A a3V ORBREEBIC/NIBESERRIEDIGEEIE. LATIMATT a0
NMNEIES (Bar Numbers) IR—o TCla—4S OB EBIC/NGESERT
(Show bar numbers at start of codas)]Z#4IZLET,

FIRIDIEE ST RGEHRNTERIND/NEICET S Dorico DIREDLIESE
[SHBEFHLELT. v TTHMBTETTDOT AT LICHRGREILITED
NFEEBA, cO-0. RS . fE. HFESLENI—F DERO/NEIET—S
D 1 MEBETELESHEIEEELTZEL, Dorico (&, I—4 ERID/METIZIE
HURSELTORASE TP FREEZ—URTLEE A, Dorico DFFED/N—
JAVITBWT. DY TR DHNE TETRD T AT LERS O DFEEEZIBM
$H5FECTT,
JE—RIX—h—DHNER: HEA T a>DI)E—rI—h— (Repeat Markers) 1D
R=DICF VE—rT—D—DNEREHET 2 2DFTavtHUES, Tty
FAY 2 DRAESN. NMER—DREBOTIE—FIT—I—SBOT) YL
(Repeat marker appearance preset) | A =21 —TRIRTEET,
= [{8#% (Standard))TlE. RAELMRINDOVI/RYT RO EETRL— I
FASNDZRERAE GV RIZHEYETS,
= [45'—JLFK (Gould)ITIZ. Elaine Gould M&EZIBehind Bars]DHEEEIZHE
DIV — B EOEEITELNEBRICEYES,
2 DOT)eybDELENL, MEE (Standard) INKYEBIhEZESn=-X
BWEAWSILIZHL. [T—ILF (Gould) &Y TR THATHARREMANSIL
[CHYET, Flz. F—ILFTIRVE—bI—D—FERDO TICERE T HI MRS
nNd—H. BAEHRSNZO00 7Ry TRADEETIEIINODIERELERD LICE
BT 50N &Y —EIHTT,
2 2O56VWITNHADT)EvrEBRLEHEE. TVE—FT—h— (Repeat
Markers)IR—SDWT MDA T3V BHICHAMTEE T ChEiTh5&, TV
YA —(IZIFREDT) 2y L TIARR L (Custom)IBRRESNET,
=3B LUV FREBOTFRAMNIATEIRESELEETBICIE. [THFIY
(Design) 1t ar DIFEEEBSDMEE (Scale factor for music symbols) 1M
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FTLavERELET . DroTRBEVE—bEVavEFENTL.[HE
(Engrave)] » /855 52XBRA )L (Paragraph Styles)1DIN)JE—rI—h—D
> 7 (Repeat marker jumps)1BEUTYE—rI—h—+E9 3> (Repeat
marker sections)ID/ATT TR AN EHRETHIET ARMIZTAU M REL)L .,
DIAEBLUVH A XZHIETEES,

TIHILEDEE: Dr o TREBEVE—bYiavid. PR ETEIERD LICK
RENFT T —IRTIR, DY TRBET—RRBBFIEROTICRRTHLE
HRLTWET, TDE=OICIEX. LAT I ToarnlEREMEER (Staves and
Systems) IR—U TCIO v TREBLUTFine IO TIAILLELE (Default
placement for repeat jumps and ‘Fine’) JZ#&ZDT (Below staff)JICEEL
F9,

HIEDEE, EAFRIYDHAREETRE IR O R AT IBETE,. OvT
B EVE— o avomAMN. RO LICMA T, EBEO—FBTDERDTIC
LERTNFET ., CORERAUNEFERATBHICTIE. [P TREELUIFine 1D T2
#ILGIE (Default placement for repeat jumps and ‘Fine’) JZTE#&k D E&—
ETOEERDT (Above and below bottom staff) JICERELET .

J—Rov7: Or TREDO—EIE. T IR HRET S H AT RETREC
HSHE . RENFEITRGDGEENHYFET . COLILIEE . FEEITRLVIE—
FMETE 2 TICIHYBRLTRRIEDILICKY . RRICO YO TE#TESHEDOD
MYDESIEEFTEET . RLDYUTREE 2 TICHYRTICIE. LATFIE
TiarplggR 48 (Staves and Systems)R—U TlMJE—bw—H—DI—
K3y (Word wrapping for repeat markers)1%l2 {TG&~R (Show on two
lines) IISERELET

REE—FTIE— I—h—%8BET 5 RBEE—FTE. DYoo TRBEBIUVE
—r 023V DBBEBEEDAE. DFYTIRATEAICN VT T5H. [Al] &
LA EADRNF—ZHI ETITEAFET .
HEEIFTIE—II—DH—DUEZRETSH: BFEETFTR. OvUTREB L
WE—rEI2avDRREEDREIL. TVRATRIYI 3 5H . [Alt] ZRLGHN
SRNF—%#|TELTTHAET  VE—MI—HD—2TIAHIMIBIZUVNT S
[ZIF. TH#R&E (Edit)] » RIS arEYtvh (Reset Position)1ZR#IRLET
E—FI—D—DTFXFRA+ELEZT S BEF T avDlYE—FT—H—
(Repeat Markers)IX—L DA TavzEERTNIE. —BMICERAINSJE—
I—N—DORTRAUNETRTHETESET TN, ZELIEERLIFHRLEREIC
KB TROBDELRIBE. TO/NTAN\RILDOTN)E—FT—h— (Repeat Markers)]
GIW—TTIHRRALTF AR (Custom Text)IDTONT1EF (2T BHIET,UE
— I —H—DTFRAELEETTEET,
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BHOI—Ft—=a3: EHTIE-MEELHODEHTEH. EHOI—FTF (&
t—CaDEENIBERIGENHYET (LIEFVA. EBEISFEEICHBLIE—NME
BEEEREIRFEALYIE RG> THIE—MEEZFEALGUVV I TRELIER
THIEEELBTTOHLEY),

NEEHRTH=6HIZ. Dorico TIEVE—rEI2avIZIR—A—AOTYIR
(Marker index)17ANTAFIBEL, F=Ov  TREIZIEX O TEDA TV
A (Jump to’ index)|TANTAFI/ELT. —RHDVE—MERICHFIZLE1Y
TYIREEY B THIENTEET .
BHEOE——3BLVa—4Z2EDKSICRETEINOVNTIE, FEF T aoD
M)E—k<—5h— (Repeat Markers)IDR—C DA T a3V FIRATEET,
RELRT QMR SvoTRELIVE— I aVOBEITMAT. RELTD
INERREARY IR LIS E TEDLSICHYFEL =, VE—IERZERYIR T @ %%E
EOTISE. RERT O/NEREERLT, TO/8T41\RIILOTHEFERE (Time
Signatures) ] )L—7TlIn EI;EZE (Play n times)IDFO/\T4ZAUIZLET,

In [EEZ= (Play n times) % 3 B LIZFRET SE. Dorico (£ E—NNEHRD
EITEEDORYIBELA 2 BIUETLEONEILEBEREIERADSTHFAMNEKT
LET . RTIDHTHFANOEDORRME (VE—MEEDRIBME. BTMHE. £
fFIEZEDO@|A) 22V TDFTavix. #EF T avnlyE—rvw—h—
(Repeat Markers) | OR—IDOM)E—REIE (Repeat Count) DI avIZHY
FY,

JE—FDFELE: Dorico [E#LGVE—MEETELEBMICBALET . RYARED
O¥>TF (D.C. £zl D.S) OHL VE—MMFRBEIVIE—MMEIINE D KS
[SH/RbONEHEIEETDHICIE. TEBEXFTF 3> (Playback Options) DI R{E
(Repeats) IO R— T, ID.S/D.C. hoPr o FLIzRICKEZHE (Play
repeats after D.S./D.C. jump)INFA T avERELET,

COFTaviE, TanFanzxIILOMN)E—,I—h— (Repeat Markers) 104
IW—TTIEYRLEICYUE—MEBE (Replay repeats)]Z4IZ$5ZET. Y
E—h—h—CE¢ICEEEZTEET,

S XT7—T4F¥2L—3y

Dorico 2.0 MoiEMENTfz, /NETHREYIRLEFT ORIV A FELEED D v X THER
T DL E~DYR—FEHEIREL. Dorico 2.2 TlE. S¥ ANEE LB TEIME
AEnd (FELEEERICEBESNDIHITTEEL) ERMGEHMBOREEZS
FBHIZHR—FLET, INLEDYXT7—ToFaLl—2ar ERULGLHENTIE
WETH.BEICIET—T4F2L—2ar TIRECERBIHEVWEETH D6,
Dorico TIXMEEHEF (Ornaments) 1/ RJLIZR TSN, [Shift]+[0] DRy TA—
N—ZFRALTAAIINET,
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O AT —T4X2L—LaVEBEROEAICTRTN 1 DT oUhftiFohEE
Ao BERNZIETRY T RO—=TFEIXI TR BRICIERAEERIETH—ILAF 5
NET, CNODEEREOEMIIERXICEOONEELEDTIEIBNIEMND, BREE
BT H-OICENENICOVTEFRLET . TAVTIEENS RY—TEYTRET
NoBEFIZZIO—FLET . FAMMIBF/FMSLEFL, TA—ILIETBERFHSTRELE
ED

NEDT—T14Fal—avF AF—ICHA-HIETREMIMMBIGEE L. IR, K
BRRRICKDERTHEMINDIGEAHYET , Dorico TIIATEZEIANUK], &BE
ZIRL—X | EBUFET,

RE. DY A7 —T4FaL—2avOBEFYR—FENTOEE A MIDI EVF
NURBEDBMET Iy TRRTDICIIERTE. Yo T TStz —23
UINEETHN—TFXILADARM LAV D EHHEFNR ThERVHT I
IEHER S A LTEBOEFDEMEHIBRETEOERTNENBLELELS-DHTT,
DN AT —T4¥aL—2a 0 OBER, FRDY)—ATEMESNLAREREHYE
ER

DY RT—TAF¥a1L—avEBET S DYy AX7—T4FaL—avEEBMT I
. BRELFIELERLT, BEREFOHEAIZHLHTEMHE (Ornaments)]
NN DITPH X (Jazz) 129 avh o EEDERREZIIVITEHH.
[Shif]+[0] DRy TA—IN—IZUTFEAHLES,

s JAy7T: TplopITTAYTIRUE, Iplopsmooth] TTAYTRL—X

m R9—T: [scoop ] TRI—TRUK

m Tk ift]

m FAb: TdoitI TRARRUK Tdoitsmooth ] TRAFRL—X

m J+—)L: MfalllTI4A—ILRUK, Tfallsmooth | T4 — LA L—X

O RT—T4F2L—23VFHIBRT 5 O XT7—T1FaL—aviEEnsift
BIHEMD—ETHA-H. [Delete] ZHLTHHIRTEE A (ChETLESE
ERFERNEIBRINET), hbYIC, EFEFEIRLTMESHT (Ornaments) ]/
WD X (Jazz) 1o avIZHbTHIER (Remove)lREVEI )y TBHET
HIBRTEEY,

DY A7 —TA4FaL—LavERET S DY X7 —T14Fab—avid, Thsft
BYAEFICHLEBBMNICERESNET . TR BRES. FRAETOEFLEND
BGEE. TNODRELBEINE S, Dv X7 —T4F2L—2 3V MBDEKY
DEFIAFIHE. Dorico [FO¥RXT7—T4FaL—2avEFNENDOFREEICEN
FEIHAEDITTERE TESAMNE, SESFRKFEMNEICERESN Vv AT —T1Fal
—2aVNENEITRAMICRRINIMNELEL T, TNODKFEMEZERIZSHH
FRET SR ELEEELITHVET, F/=. Dorico TlE 1 DOAR—XI[IKRIRT
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ZFHUONART7—T4F%aLb—avid 1 2EITTHA=H. 95R2—a—KTIEI R
TOHFBIZOYRART7—T4FX 2L —a a R TEHWNMEENHYET,

BIDEODKEARDLEWMED, ALHMFITHERDOO Y X7 —T1F2L—
DAV EEFSELIEHICONTIR, BEAF T avITHLGEMINIOv X7 —
T14F¥aL—a> (Jazz Articulations) IOR—U CHREITEET,
RAL—RBOXRT—T4F2L—3ar: RL—XRYTh, AT RARERIED
+—IVEERTEEE . ThThADRDTIAIVEORSEAEL, BEF T ay
DI XF7—T14¥2L—3ay (Jazz Articulations) IOR—U TRETEET,
FEE PP CTREATIOBRORIGNEZAH TESH-H. RORSEAEILEH
[CEFETEET . MEEBRLTHS [Tab] ZHLTEIRPOKRIFEETIYEZ . [AlY]
ZHRLGALKENF—CHEZREMLET, (K (Edit)] » TR avEtEyh
(Reset Position) |Z:&RT H& BDLEEZT I+ VR TEET,
AL=RGOw AT —T4F¥2L—2aV DD AR )L (RR., TR, KIR) DT
AIWLE FEF T VDI O XF7—T1F2L—23a> (Jazz Articulations) 1D
R=UTRETEET, [Shift]+[0] DRYTA—N—THEREIN=OX X7 —T«
Falb—2aVIETIHILNDBD RN EFERLET N, NRILOSERLIZIGE
[F. ARV TEIRLIZARIVICRIBD RIS TERESNE T O¥ X7 —T1F2
L—ab DIRDRZAIVET IV T BI2(E, THRE (Edit)) > TH8%E
IJyk (Reset Appearance) 1Z:&RLET,

ZOMDI Y XDEME: LTy T RIT7 . Ov X 2= (FzlEizM9). N
VED 4 DD ADERANGERRENANTEFET . CNIFTEHT
(Ornaments) 1/XRJLIZFHLGEMSNI=TOR X (Jazz) DI avhbRIRT S
M, [Shift]+[0] DRy TA—s3—I(ZTilip]. T'smear], I'shake]. lazzturnjE =%
Fbend1EAALET,

Dorico M UBID/N—2arTlRR.IhoDREEFTIEEHZE (Playing
Techniques) J/SRILDIEERER (Brass)IDEI 3V IZA>TULVELZAY., LLAET
DN—=230 TERLETRD oV MERKRICIE. ShoOEREE L BBMICEY]
REMBICEBRINTT,

SDECH, INLDOYADEHENBBMICEBESNSGEFHYEE A,

TURNYI DHEHAHEEAH

Dorico 2 /N\—2av R

BLE, TV 7 —LDODEEERICENTIE., EHRFF(THEHBFICEHIR
BELN, Fa—POTOPIIFOBEICEESDELELGDIIENILHBYET,
Dorico 2.2 (&, MIDI 7LD TURNIYIDFEMHAH, T=IFBWEDNTOD
TODEDTURMYIDEESHLETESHEETEALELS,

TURMI YO EIE, ERIZIE MIDI 27450 TURERE T TIEEL,
SMPTE #7tvh BFRBOI—H—REFIIVVICEHET S BEMLHERE

27 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

{ETHDTY, Dorico Tl&k, MIDI Z7AILHSEINEDERD—EFEETATE
FAAA, TO—ICBREDLDEBE A DD, REDDMOERIRFLAELS
JO0—%BEELET,

BWEDI7O—IZTURMNSYIERARADIZE. TIFLIL (File)l » THRARAH
(Import)] » IF2RrSYH (Tempo Track)IZBIRLET ., TURINSYIZET
MIDI 74 IVEERT DL UTDFAT7AT BNRRENET,

@ - Import Tempo Track

Import inte flow:

Flow 1

Import and replace:

B4 Timecode display offset
Tempo changes
Time signatures

2 Markersas JSERICIENN  System Text

[ Cancel m

FA47RYT EBO) A SHARAAFDTIO—ERIRL, HAHARLTATLDEZA

TEBERLET .

» B4 LO—FRRDA TV (Timecode display offset)Jl&. 7O—FitAGI &
DRIDEA LA—FDUBERELET .

n [FUREE (Tempo changes)lld. 70— DT RTHEETUREELS LY
BEHTREEL . MIDI 77/ LD SHARAATZLDEEETRAET,

= MAFEE S (Time Signatures)lE. 70— DT RTHAEFEEEE MIDI 77
AILDERARAATZEDEEZTMZAFET,

» FR%IZ.MIDI J7AILHBDT—hH—%ETT—hH— (Markers)]ELTHRARAL A,
T TF AL (System Text)JELTEHRARALIMERTEFEFT, v—hHh—&,LT
SARATHE. JO—FICBEEDV—H—([EITRTESBRI SN T TN, HET
FRMELTHEARARZIGE L. BEOMEBETFRAMIEIBRINEFRA (BRET
BRETHXRAMHIRE T RRICEEMRAON ST A TLEHI A TELRN=OHT
9)o

FOKIZEV VYU 2L EBRLIZTATLANERLIZIO—ICHARENET

TURNSIYIEEZTHTICIE.TT7M4IL (File)] » TEEHL (Export)] »
[Tempo TracklZERLFET, EEHT MIDI I7MILDIT7AILEZDANERSD
BNFET, ZDT7AIL%E Cubase HED DAW TiHrAAH, JH—DRAAZIVT1E
HEFNFNDTODIIMNIELETEET,
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J0—RHL

BHEOIJO—%ETT7O00 TR FHLVIA—ER—SDEDTHIETIHE
DHIEENHYET  CNIFFICEBDOEENSEIERD ARG ILAT RN
—MIKKEON. EDEBEORTHREDICHEITHLLWEEIFHIGSN LD M —
BREITY , CNETIL, Dorico TIEEHED7A—% 1 DOEMIL—LICHHEIC
RRTEDIZEIDDOLT  MELGREL (FAML EHELRE) OERIEI—Y
—IZERon. FEITTXFRANIL—LEZEMT ZBLENHY . LATIMIER—D
DEEENFEELFELI,

Dorico 2.2 OHLWLWIO—RHLEEETIE. F70—DHIIRTTEINBEERET
B —UIDOFENRENFEIZHEYELE,

.

-t

2. From C major to D major

e

e

JR—RHELEEMET S JO—RELIEFHFRIOC /O MEARETIEA DI
BoTWET, [TI4IEDTILAAF (Default Full Score) &l TFI4ILMMDI8—
RelE (Default Part) IlIADIRI—R—CDEYLDIZH (First)JIOTRAZA—R—
JCICETad s MERM D =IO BMERSh . JO—RELARFO T7O0—DFH]
[CHASND&SICHYELZ, TRV MRICTA— 1 DEEIFTHNIE, 78—
RHELEATICTBIEIAKMEELEHYET,

LATIA T3 DIR—IUHTE (Page Setup)]R—DI7A— (Flows)lD+

g avicHLGEmMEN =4 T3 Ion—RHLERTF (Show flow headings))

Tk, 7A—RHELERTI HSFHZIEETEET,

m [EIZHEL (Never)l: JA—RHLMNEMESN . BEIRICKRRSNGAGYE
ER

» [RFIOZ7O0—LIS}+ (Not for first flow)]: ZA—RHLIE. LAT IO RTID
20—PADTRTOIO—IZRRENET , h(F, FRTEYREG—R—DD
Y BBERSNEIHRE (Firs) I OR—SORTHREFEL, ZOMRH)
(First) IOR—=ORF7IZTAD IRV TIFELTB—2 /LR RSN D
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58, ZYNI7O—DRITIA—DEANLNEET HDEHEET,
s [FRTOHOZO— (For all flows)]: ZA—RHELATRATHOIA—IZRTINE
ER

JO—RHELOLETITEMENST I4ILEDRBBIICTHEELET . 7A—RHEHL
FEBEFHEREICEREESNS O, EBRBEBAEFEASNELAL. TEHRA
FEICERASNETY, THREAEODEZEES. JO—RHLO—FTDIL—LD
TN, ETO70—DHRDERD—FLDERDE 5 RICEMLET,

THRMIDTAI—R—C%EFERH (Use ‘First’ master page)lD7A T avd#L<
BMEhZELE, ZZTIE. &Y (Firs) IDRAREZ—R—CEFHETIDIELATY
FOBIBRAIBEDAHET D (TRADIO—DH (First flow only)]) M, R—PD—
BEENSHIBTEI7A—IATET S ((R—CO—FBLETHIKRTSI70—FRT
(Any flow starting at top of page)l) ». —8IfERALIELY (TEIZEL (Never)))
MEETEFET .

JO—RELEHRET S JO—RHELEIRZ—R—SDEvO—ETHY. TR
A—=R—=—DDEIYNMIEENETNHRBEDIO—RELERETEET . [TI4ILED
Z)LRA7F (Default full score)lEl T4 ILbD/A—R5E (Default part) JOTR4A
—R=CDEYMIEFAEFN 1 DOTO—RHLABRESL., ChICIKTHY
(Firs) IO RRA—R—=—UDRTF7ERmLEHKR. 2FY.70—4214L)L
(M{@flowTitle@} 1D +—H U %EH). 70—D1EfE ((@flowComposer@} #
#/A) 8EV0T0—0EHEE (@flowLyricist@} Z#EMA) NRRENFET . Ch
SNDE—22TIII774IL (File)] » TFOCIHMER (Project Info)jcoa—C2
LISTEESN-BERMNMERSINET,

FREEFOARID/AR)LIZITZA—RHL (Flow Headings)lDtoav gL
GEMMEh, EDITRE—R—Y (Master Pages) o avGEIRSNTLNVATR
B—R—T DY TCHERATEHIIA—RHLARTIINET,

J0—RHELEHRETS5E. [70—RHL (Flow Headings)lt913a>T74a
DESITNIVVITHE. JA—RHBLOITA2—hHEET . COIT(5—IEH
AHIZIEIRI—AR=DDITA3—LREILEDTT A ESLDTHAHILZEEIAT
51012 BGSAERBTRRINET FEVE. JB—RHELIER—CDER
TREDEDLLLENZHIZ 1 R=ULMRIRINGENIEE, EHTIL—LFT7O—
RELO—EELTIFERTELRNILETT,

JO0—RHELOIL—LIF . R—COECIZEHRBELTHLEWER A, Dorico [F—F&
FDOIL—LDLEIHE—BTDIL—LD TS, IL—LIZHEASNST7O0—R
HLDTEEFERELEFT, 70—RELE2KRDSIIELEEIRINEKLT, FL—AIC
INFELEEDEFZVELULITHSIHWKSIZTILENHYET,

J0—RHLIEERIL—LIZHTIHERMMEICEASN, ZTNHAETS70—D
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RYDOMEICHLT. ZEEARICBBMNICEHLET . COH. 7JB—RELDT
L—LFEEAAOERMNEZF-T . A—C0—FBLFEATICOYIENETE
FHYERBA ZOHDY . EEVWTUOEITEADR—IHHISH L TEETEE
ED

JO—RHELOEE: IRA—R—UDEYMIEBEHOTIO—RELEZRETESE
9o TIAIMMIIEETEST70—RELIE 1 DEFTIA. BEEDLEDZELHEITH
RIOO—RHLZERLTHLIFRAIO—RHL (New Flow Heading)lD% A7
04 TlM847 (Type) &l T4k (Default)JIZRFETBHET, TIHILNELEE
TEEY,

TIALNUNDTO—RELEFERTAHE. LATIFOEEOR—TIZT0—
RHLOZEZFEAL. COTA—RHLEZOR—JFEFICERT A0, LIET A
TOR—SIZFEATEIMEELET, [R— (Pages) |/ A RILTHEDR—SEE
UL TAVTHFAAZa—RAL. [JA—RHLOZEEZEA (Insert
Flow Heading Change) | ZZ#IRLTUTDF A TRTERTIEET,

K} Insert Flow Heading Change

From page: E ,E Displayed: 5
Use flow heading: | Default ~

Range:

From This Page Onwards

Current Value

D Heading Top Margin: IﬁS.UO H ‘

(3 Heading Bottom Margin: |

YRA—R—=DDtyrMIETHT70—RHELEIJD—RHLEER (Use flow
heading) IMA=a1—Mo:ERL, EEOMREFEREDR—PDH (Current
Page Only)1&TTRIEDAR—U LI (From This Page Onwards) IO WV b
ELFET . T . FHHRIO-—RHELICERINSGLAETHORBLLEETEEY,
CCCLEZFFRELLGWMEE  LAT VM T av THRESN KRB DDYIZE
RAEnZFEY,

JA—RHELEBET S LAT7IMIEBMEN-J0—RELIE, thEF R H5ELR
DIL—LTHAHZEEHOMN)PFTLTEH0IZ. TL— LD IR THEINET, i
DOI7O0—MEHFINDE TJO—RELIE. TNARTH70—DRADERIZED
T CHBMICBELET . ERORR—UTY—LEFALT. 7JB—D—& LD
HEEZBELIGEE. JR—RHELLZTNICERLET . JO—RELZENTIHE.
—HBLORERAONSVEADNVRILTIEEL HBEEAAOREVTEAD/\>
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FILZEERYTIRENHYFT,

JO—RHELOIL—LEBERKRL FET—FOREDHETBITETIN. ChE
TEIER—VDEEEHAREL. UREZDAR—DIZETEHIL—LDLAT I
(ST HEBEENTEONELBYET,

R=—VN—FLOI7O—RKHL: JO-RHELAR—SD—FLIZKDIFHE. LAT
AT avFERFTN-—RHELOZETHEESN - LERABERSAEE A,
J0—RELUFEHBIL—LDO—FLIC, EBRELGLTRESNET,

BT HRTOC I TIR—RHELAR—CD—BLICKDGEE . R—CD—F
EICHREINTOEIAYT —POR—DCEFLEHMICERTICHEYET Chid—
R HIRMO . EEOELHOIELEYICETIET ICHSBDTT . LAT7VH
T3> DIR—TH/E (Page Setup) IDR—JIZIE, COBEEEET 4TS
IVDHY . TN TNDOBEREIFERRITTEINEIMEETEET,

BRI o070 —REL: FRERTOAS I/ TEIA—RELAFT VA
STWETH. EFEOTOD IR TIEA TIZHE->TWVET , Zhik Dorico 2.2 TH
WEEITHBNEEEINSZEEHLET 5T 1L, #Hi/NN—2a THRHFED
Tz IRERKRICIE, TRTDIRFI—R—=DDEYMI TIHIEDTRE—
JO0—RHELOTUITL— O BEIMICEMENES . COFOH. LAT I T3
UTHREEAVICT BT TIO—RHELEFERTEET,

BENTOADIHMEERLT, BA—2av TFHTEMSN T IRANIL—LOD
MHOYICEB VO —RHELEZERTHIEE. LATIMOR—20 L EEZEHEIRT
BZBHEDBY. CNICEO>TEEDLATIMDOYLEELADBELLLDEENHYE
4. BH70—RELE MLz E TERMBRICIRFIREEDEICXT S Dorico D
(X, 1 —F— D FETIOO—RELERELTE =T DB L. [TFFEREIC
EL55-0TY,

BAF Tk

JO0—RH LHREZ#5E T B T, Dorico 2.2 [ELAT7 IR DTRTHOIL—Y—
PEAFIybTHSHI7A—DUNEBELEYR—MNFT, TL—V—HT70— (BLULAT
I8 [CEYETONTWVGED S EEZF -G5S Dorico [E70—2KITx
FTERKRFEZ. TUREBRLYN—HILI—ILRELEDTRRLET, Dorico 2.2
Do, LATIOMETL—Y—DEY LB TONTWVENWIA—EHTHESITHY,. Ch
[ZIF7n—RHELDOHEICTacet IDTFRANERREINET,

AFTYRERRSEDIZIE. ZA—DLATOMIBIYETONAKET,. ZDOLAT
ROV TNDTL—Y—LFDOT7O—(ZEY L TONTULVLVREEIZLET,

AFIYMERTT S FFIVNERRNIZT I T avIiE LAT oA Toavnl S
L—¥— (Players)IOR—2DIFFyb (Tacets)|DEI23avIZHYFET, FiR

R EN =T AP 2V TREF Y MIERE TAUITHSTOFET A, BEFDT
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AR TCINERDIZTBICE. TFL—P—REYHTEIATLELTA—IZS
FryhEFT (Show tacet for flows where no players are assigned) &4~
[ZLET . COATLav@FEI7n—RELOFEAZRIRLEKTIF UICTEFT AL C
no 2 DOBEEFRRICERYTSEEETIOLET . 2T DI EIEY . 4T
YEMEDTA—ITRIET DM FAMLHASELUEHELIITHRYET,

JO—HDITRTDIL—V—NEF v THIHERITRTT HTXANERET
EFT, WHRETIETacet 1 EWSTF AR, IEFE (Engrave)] » /85552
ABA )L (Paragraph Styles)IIZEif=IZBMENI=ERD/INSTSTREAILIEAF
vk (Tacet)JITBELIZRAZMILTRIRINET , PHRETIL, TacetlOTF
AMIABEOZA—RHLNL— B TRATEDLIITRETHENTLET . T+
AFEADERABLUBROKREIOA T a0, B REFERRICT AT oavIE,
FEEA T AVICHITBMENZ-IFF Yk (Tacets)IDR—TIZHYFET,

AFIIEDTHRALEED LOTOO—RHELEDMERIX. FFzvbD LAIKE
(Margin above tacet)IOA T2 avTRESNFT ((7A—RHLOTAIKA
(Flow heading bottom margin) IQEIZZCTIIERALELEA), FFTvbEHEIC
H<ZA—RHELEDOMERIE. T2FzybDO TFRIREB (Margin below tacet) DAY
VAVTRESNFE T,

HRDAR—L VY GEE—RTEROAR—V VT EHRETLHEE, 4F VML
ZTNEARTHELLTHEDN KEVEADN\UFILTR—UDOETICBETESE
9, SNISEBEEMFON T —RELELERLETS,

L EBERDRAR—2 0T O— BRI FFYMIEMRLILENILITEEE
LTLEESLY, 2R E [Alt] ZHULENSRSY T LT B IRLEZERKYV EFIET
TARTOEREDEREZLLHINICERT T AREGENCNICHYET . 2F Uk
[SIEFFERLGE 0. [AlY] ZILENSFSYT L THAEBEILEE A,

IL—LREYY: Z3FybAIL—LDRBMEICRTINSLIITTHICE, BE
E—FTEFvbDOTHXRRAFEKREZRZRIRL T [Shift]l+[F] 28I . THE
(Engrave)] » NEMIL—LOEAERTE (Format Music Frames)] » [FL—A
Et1Y (Frame Break)] Z#Z#RLT. FFVYFDFRIICTIL—LETYEERLE
ED

I

Dorico 2.2 TlIh))ILD2EMGRELAITEHNELT-, Dorico DLIFID/N\—
AVTIE MDD BEETRTOIC LD LIRS ER R TEELEN. SN
(FHFECENMTEITOEDOTL -, BBFRES FREDF—Z RBRLGEL O, D
BRAEBOLATIMIRREIEDIGELRE . RGBS LLTRRT ILEN
HoTH, TN TEFEATLI=, Dorico 2.2 DRJLIEINEYT 264 T)PT
UMIBMELET . RED/NMETDERRFE S DKEE RGBT THEZ DIREEIC
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BEE5ZBIELTE, MLOBEORTHELEMHEPHSRIRTEET,

b ¢r
tr~—~— fr~=_
) ][!i- He—ge
ﬁ I
U |

RUILDERE: FICERERTEL TN IILEERLIZIEE . Dorico [ER)ILAET
ZEHO—BLOEFEFEAL. REOF—L. RAL/NHRNORIIZHIE R THERA
SNDERFLBEERBLTEREZHELET, LR E. C ADYy—DF—IZHBIT5
E 7Fa3IDRNIIILDERIEI.F FFaSIICANMTERTYS (B HE 2
E) LRYET, 1L, EAERC/DERDRICHIECAVFI—TDERFICI v
— TG EIE. MIILDEREIE F ry—TJICmh-T 1 AT7v7 (2E. K 2
E) LYET MIILOBIEIL [Shift]+[0] DRy TH—/R—m5, F=lETON
TAINRILDTRYIL (Trills) 1T IL—TIZHBTERE (Interval) IO TONTEF
VISLTHETEET . Ry T4 —/\—THREEEE T HICIL. [Shift]+[]] ORyT
A—N—TCEREREEETIDLRLEXEFEALET,

» BFEATE. BEOF—LRNIILSNLIEROBEEXFEALTHERLLZEED
BESNES, DFYMN2IELBRICHITS 2 EIRYET,

" EEREEEEIAICE. MXFOMIZEALES & ETm21d5RE 2 EIC
BYET. REEZIEETHICIE. AXFOIMIZERLET -z ETM211&
£ 2 EIThYET,

» EEFREETETAICE. TpIZERALET, X ETp5IEESR 5 EITHYE
¥

m BEERFIEETSICE. TauglZERALET . & (ETaugdl g 4 E(2iY
F9 L HMEREEETAICE. dimIZERALES . A ETdim51ERE 5 &
[ZRYEY,

FIILDBREIE. ZADDEHAYDFEDHETHNIE, EDFIIUT TLEETE
F9 . BRELEET BITIL, [Shift]+[N] F£/=[X [Return] Z#LT/—FA N %
Y HDIETHRYLYRNERRIE. MDA BRTAIFEDS>6LVT N ERICAEIC
FrLybEBEHL T, [Shift]+[0] ML TEMBTDORYTA—N\—%RE. TED
BERZANLET, EROERILERFLS. NIV YFREMIILDOERE. FEFv
LybDRIEDFEOARICH<HEMBERLLTRRINET,

FIILDERE LZETH=-HICTER (Interval) IO TONTA4ZRZYIZF LT
EE.ZOTAONTAEMIILOBBRESN-REDFEICHRESATLET . Ch
([2&kY, M T HIREBY LA RZBELLTRYET,

FIILDEZRRONE: DERETE. NIILOBFREILTF |BEOLICEREFTESEL
TRIRSNET L. DHOYICNYDIRDOREBHRANHEND . FRTYT (#F) #MH.T.1.
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1 X797 (2F) 2IWT.ILLRETEFET. BEENE 2 EFER 2 EXY
REWVGE . HHEROBTRREINET , ChIT/NSLFELZLOE RN EIIC
A= DT MIADNBTHERDICABICRTSINET,
FILOERONBERIHSTE2F T av B #EA T avnlEHTE
(Ornaments) IOR—I(ZFHLGEMESN TR OEFFE (Trill Intervals)ID ¥ L
—7 (IBNN—2arTIETEEEEE S (Accidentals) IDF IL—TEo1=1M) I2HYE
T, RS ELIEN)DYRRAAIVIZLEERERTTHIME. [¥r 1EEED
E.TFEEFEONTNUAEIEETEE T FLMHTISLUVTW.TIDHEIE, LK
DMDRABAILHSEIRTEE T MBI EFONERICEET 54T avLRLEMIC
HYFET, CCTREBREE, FNOHYEL, BLUSEIF LRSI T HM
fRORESGEMNEETEET

BATOEANT-M L DRADFEDTaL—a0h, 16 FEFUTLHEFE
[CRWMESIE AR—2 VT DENEHIET 5702 HMEFIIRVDOFEDH
ETIFEL 2 DHLUBORWNT2L—2avDEFOHEIZRRLEZIESAKLVE
EDBYET . B HEIADOENYDERADHEBICBESEIEADTL—
aVOLEWNMEIE., BEF T3V OIEME (Ornaments) I THETEET,

ML OESBR S EERTIST S MILOSRERTTHNESHD Dorico D
W7 iZ. FRSTF 1/ 8RILDTRIL (Trills) 105 )L—F CIEGEEEES (Accidental)]
DFTRRTAEAVIZLT TR (Hide) |FFETRT (Show) 1DV HMIE
ETBHECLEEZTEET,

L DIRED EFEDONELEREFFRRE LS. DEVHEBIBRHNIDYRREAILD
HT.I®OIW.TIDERETHAGEE . CNEERTRTICTBHITIE. FTTRIIL (Trill)
DT I—TDT51 88 (Appearance) I DT O/NT1ZFUIZLTEREDNERZEGRT
SITEREL. LEDOKSICTEFEE S (Accidental) IO T O/NT1ZFE AL TR
BEERTIZLET,

FILDEHROEYFIZH->THRUSZEE. EVYFAEHLLEICN LD LIZE
EABRTRINFET  EHOEFICOTERERENEOLLBWNMEE (X, BEICIG
CTIE&FEDOEFICRCIILOERNMAFLIFESE (Identical trill intervals on
successive notes) INA T aVEFERLT. N\UIYRRZLILDR) LD EFEEIE
RRICTEFEY, FEL R RE S LA BEREABICRTEINET,

FJILEEREFEES: Dorico (&, /MEAICR RSN DEEREL S ZRODRIZMIILD LD
BERERBLEY . HIRETE. LOBHERILSELIDONASOEILESTH
BBEEERVT, MJILBRIZEENRTEINET . RL/DMEICHDHETD B DR
REICEOTEDERNELLTHEE. FIILIZEBEICEENRTSNET . ELT
ARSI —ThITZVRDMIKEYFENIILBARAELSEIEE . HEITHEKEL
EvFOEFICITBEUGERLSHARTEINET . SHIS MIILO LOFFIF. BT

EBSVLURQPMEOMDE Y FICHERR LS EZRRSEDIRIZEVT, BED
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ERERILHEEEHLET,
WAEIZKDBNILDETRE: TIHILLDRMEL AT LTHS 12-EDO LIS} TEEEE
THHEE. NILDERE, CESN-EFISDEERDRTYTHES B DI
THETETEET . 24-EDO THNIX, BEIIETREEZZTOME Aov— M5
E) THLERABTEXTA, AR AT LOREIHA LY KEZNGE DL, £2EBD
FEATYTRIDO DB HA T —THEEEIE. HEICKEIRTRIEIFETHY ., F
BIEAI84—TOHEITRIRITIHENHYET,

FIIWDER: FEF T3> DIEHE (Ornaments) IOR—U (T HIREER OB
IRBIEDSR)IL (Label for start of system)1DA T avhit-I2BMEhEL =,
NITHERTYEFRCRMIILONREFIFEL, T4 1REEZEEEBYRTTHH.
BN DETRRT DM, FIEERRICTEINRBIRTEET

RIILDBRRBBBED 4 15885, TO/SToDTRYIL (Trills) 10T IL—TF (23 LL
BEn=-IcJILT—H%FETR (Show trill mark) IO TA/NTAEFUIZLT, F
VIRV IREATIZF HEFRRIZTTEET,

FJILDEE: Dorico [FRJILZEBEIMIZERLTBELET . BETIESIETY
TV ESnM)IIVEFERL. 25 THRWSEFEBD/ — ) FT—LTRIILD
2aLb—2alETHEVWET, MIILOBEICET AT avid. BEA T avic
FLGBMENT-TR)IL (Tril) I DR—STHETEET,

Dorico &, VST THRTLyiar Iy ITEEREAERZSNTLSIGAE. F
ATYT (FE) B&LUY 1 R7vF (£28) oYU T TShizb) L EBEIRIIC
BAETESES(2HYZELTz, ZNi5lE HALion Symphonic Orchestra MDA
VARGILAVNIHHBRE CTERINTEY . @YCHBEINSLSITHE>TVET,
YIURSATS)—ITH T YT INFZR) LIRS N TLVEWNEE . 1 X T
YT EYKREWNEFRRDRJILIZDWTIZL, Dorico [ZRJILDIIaL— 30 F TR
FT YTV TINZM) LE T TIERZA GO ILOBRENEHANTRS >THE
REnBGE. HoT)odESntztILOFERZEFEILEL, 32— avanfkY)
WEERTHEATIEINAFELNMGEEILHYET . COBE. TMILOBESE
(Playback approach for trills)1ZT &£ ENT=F)ILDH (Generated trills
only)IIZEXELET,

B4 1T NotePerformer AL TSI ELEMKIC.TFIILOBEFZ
(Playback approach for trills)1ZTE£BEhf=FJILDH (Generated trills
onY)IIZERETHIELEHTITOHLET , CNITKY Dorico [FEITIELLY—ME
|EabO—S5—IFFHEXE TE. NotePerformer [XERARRUTZILICR)IILEB A
TEFEY,

HBoT)oGENER) LIRS SNIIL—TUREINE=Y U TILT—2THbB=0 . &
HHRERISDRJILO, FJIILDINZ— [ ZE M FFORIEFTEMZSGE . M) IILDE
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EQON)I—23VFBRIIODNTA—F—[FBERAESNTLERT A, HIZ
BEIERSNIZMIILIE, AP LETEEMDYITEVERERMEZHLET . (ML
(Trills) IDR—C DEY DA T3> TlE. BBIERINTZMNIILOEREHIHTESE
ED

Dorico [FEBEREINTN)IILEERTHEE. NILDERISLUVR) LD T L
EMEMEY—LLRICHARAATT . MIILOFRBMEDEFIZ 1 DOR
7//1724,0) EMERNIEE . INIETRO Yy —FEH-T 1 EHO LD
ERRDICGYET, —A. RUDERICEROEMETFANIIGE . ThiEb) L
DINF—UITHAIRAENTE T, F2ER L= PZ DD ) L DR IE/RZ—D T E
FILDICHEDEFITAKEIMETFL. FMILDONF—VICHARAFENFT,

(BB RE—F (Start speed) &M TRAE—F (End speed)l®70/874ThJJL
DRSIZECNEZONTEES. FNILOBENBFERTHNIE Dorico [£Th
ERRTEFTY COR. ML DRSELESE DIBERTET SIIE. HEVRIL
ARE—F (Slow trill speed)]. EENIIAE—F (Normal trill speed)l&H&U
MRLRYILRE—R (Fast trill speed)]DEAMEARAINET , ChHD{EK, FAN
FASRILDTRYIL (Trills) IDT N—F THIET BT ORTAEF T BIET,
RIS EITEEETEFT MIILODERLDESE LEEL DD, ESDELLEN)
ILBORRBICKBREELWIGEE T FLEMESATEEDRKEEZ M
(Suppress drawing speed changes)IDTA/NTAZFRIFIZAVIZTHET B
EOR) LR RTEINET,

HADEBEETIEREE. MNIILOBERFRESN-EFIORRBLES . — A,/ \AY
IBLUVHBEIRBFROBRIZEITHEZFTIEIEE. NJILOERTLED (FJIILT D
D) ERHMLEBLET, COEIMEL. TERSHT-M)ILOBAREYF (Starting
pitch for generated trills)1Zl EDEHRH (Upper note) IMI FTOER (Lower
note) =BT T AT ETHETEET, Shb, FO/SF4/8SRILDTRYIL (Trills)]
DT IN—TTITEDOEFN SRR (Start on upper note) IDTA/NTF1%EFIZT
BHIET ML EIZEEETEET,

£5 1 D.HFICATVIROET7 /EBIZEWT—HRMHGEBELLT. $RTONIIL
ZoKYNSIFLHTREITRS, MESE TERTHREMIULBHYET . Thzt
BEIBDICIE.TERSNIZNILDTIALEDEE (Default playback of
generated trills) |ZEEMNSENRAE—FIZMZE (Accelerating from normal
to fast speed)l[CERELET . COFRFETIE. 7°D/\T4‘Cﬁ$ﬂ#®;$é’&_ti%é
NTOEWLRILITTRT, TEEMIILAE—F (Normal trill speed)Jic 1 #Z
DEFOHTHRESNESIMSEELFEIBESNA, EOMILRE—F (Fast trill
speed)][CHEESNEIETIEL T HYET , Dorico [FEITEUN LMD B FF

NERINDLIIC. ERICTRNLREINHIGEDH M) IILDERSEEILSEF
ED
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AV ARYILAVRD T V=T e EimET 5:

Dorico Tlk. KIFMEFIFIMDTH A PLNEDF T areébIz . LATIMH
DAVRRY LAV MERIEIMERFIMTT I =TT HIEIFLHT7TO—FHRHE
SINTVWET . INDF T avIgigEA TV DIKIER (TS57vk) EhiEil
(FLAR) (Brackets and Braces)IDR—IIZHY., (FEAEDEHIZE LTI,
TIHIEDT =IO T7Ta—F D56V T nhEFERTNIE. AZEICHK ST
BEOREENEONFET, TN TLLEE . FERICA VAR IL AU DRHKGE T IL—T 1L
PLBEEIZE ., Dorico 2.2 [CIFINERRICHRITAXTHFEARABINTL
FY,

ARAFLAT7IMNIBEHTHY . AV RARIILAVNDER, T4 I« DEE, AV AR
GILAVIADFERDEBMEHIFR. ZHDERDIERTGEIRST, HERIZHITS
ERORTEFERTDUYEBEDLDIGEELHYET ., TDH. REDEREHBIC
[E. REBMEFENMDAREITARXZRIBT HRNC AT DEREEEET A TEE
. ITRTOTL V=AU RMYIL AV ERTELTHELIEERTITHLET .

Frz. REEMEFIFBINDHRITA XETESEFTT7A—D— BRI TITEILE
BTTOLET . COEE. BT LAT AT a> DIERDAR—I LT (Staff
spacing)IORX—I TIEZHDEREIET (Hide empty staves) | ZTEITRT
(Neven) JISLT. XA DMRICT R TOERSA RTINS LSICLET . 3B5HA.
ARSI AVRD T IW—TELOHICHRELE-HEE. ZED/NEIEIFRTRIC
LTHEVERA, RKRIZ. 70—DHRADIESTIVRARIIWAUCD T IVL—TEER
TRIDLELRHHIGEE. 70— D—BmAMNSEDLYICRAMNSIH THEELXTHEOTE
S, RIEIMEFFEMICR T EHLWVERILENSH DT IL—TIZEDNTITED
NAHH. 70— HOYNSIELDICHAMN > TERAMEITERETLEOIZLEET
ITOTETFEHA,
FEMDEY 3y FEE—FTIIT1IDHmEY—ILHIER
SN REEDEB D/ SR ILIZ(E. THEL (Bracketing) D&% [ [[ [[[
DavhFzIZEBMmEN, SSISIXAVRRSILAV DT V=T
EHRIERTESRAVDBHYET , LTORIUHAHY . EH
AN, LOTILTODITALTATHLET, i
» [KiEZEIEA (Insert Bracket)l: ¥ IL—TIEDE 1 LA
IV (—FBRE) T, KIETHEM M. BEIIRICTI7IV—IZET 51 ARy A
UrEBEFELET, KIFIEKFINRILEGYESILIETEYS . £-FENLHHAE
EBQ/INEHRICEELTERESNET A, CNELELRYEIILETEEH A
n TEIFIIEIEA (Insert Sub-bracket)l: JIL—TIEDE 2 LANJLTT, #iLy
WRTHEIMN. BEIEI7IV—ADORLISTDA VRS ILAUS (TIL—F 2 K
HE) ZEELET BRI, ThEEHLSKRFIMOMNMAICEIET ZLETE
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FEA BIIENDORRICHIFNNMERESN S ELHYFET A ChITTHEALDR
A7 TIE—EMTIEHYFEER A,

» [/PEIFEINZEIEA (Insert Sub-sub-bracket)l: ZIL—F{EDE 3 LANJLT
T, BIEMENRITFE-1-KRILT. BERFRLCEILIVIZET 51 ARy )L A
Vb (FzERE. NAFVwIa0DEIIIV)—F—YOEZITED/\VE
—DIZBITBT4 T4 DR 2 D) EEHELES . /NEIENIX. ThEEDHD
BIEIDONEICIE T ILFTEE A BIFENORRICHFENZERT 55
EITE->TWWAIEE . MEIEIRERTSNFEE A

s [hiFIlEHEA (Insert Brace)l: ChIFE 1 JIIL—TIZERINET IR T
N, BEIRERDAVARIAVL (ET/ON—TRE) #8FELET,
PIENEPIENRI L TH. KIFMELELGYEIZ LI TEFE A PIENEER
LTE 1 VI —TELTERKBINERICIE. BEEREIE/DEIFEINIERRT
EFEEA

» UNEIRRODIEREZEE (Change barline joins)l: #HAKE TIX. /NETFRDHE
BIEE 1 JIL—TIZH#5, 2FY—FRAIOKFNMFE I ENTEREEINT
ERBICE/NEHROVBESNETA BFICETIERICTELVTX. VIL—T
EISRARAGNEIRDIE S (XBRERINFE T, ST/ ETHR & HRER L D E 2R 2% [E 8
TB5=HTT,

FRIIN—TZET 5 KEM. hiEE(EBIENEFIRIER T HICIE. T
—TDBRADERDTATLERRLTHOTIL—TDREDERDT AT L%E
RUFEE—FOEBIO/RILOTIEIR (Bracketing)lDtoarh bt iR
BP9 LET , KiE. RENELIFEHEIIOSBIEE L O ER SN E
T BRBEDARNYIIAND T IN—TEFRITIL—TIZEHLET. BEICTELT
HESNFET,

BEFEDTIV—T&mET 5 FESE—FTKEEN, PEIN, F-/NEHRERRT
BEEDLETITNVFILBRTENES 74T LOBEIRL#EIRIL, [AlY] ZH#L
BHAGETFTORMF—TLETIZBBTEET  KIBMFEGYEZ G0, K$E
D Einz EICRET HE. TD LICHo-KRIEMEEHFIMTELYET, —
EEGo=1ElE. BBL-FENZXDMEICRLTH. TORSICERYEE
Ao

REE, FEIL BHENE(S/DEHEIIX. EOLETEYIVRATRIYI $4HIET
LERTHERELEETEFY EUNFRORSE, F—FKR—FLa—thvtz
FRALGHNIEEETEEE A,

HAR: FHRITW—THEfShdL. HEBEORABAEICTKIBME/NFROESE
(Bracket and Barline Change)lDA A FMNRRSNFET , A O HRER DBAA L
BICRIRSNDIGE. JIL—TOERITREDHENSHREFELETHN HED
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RPICRTINDEE . EEIROMBASNRERLES,

INGHRDIES: INEROBEEOFRERICIE. KEBIMEIEHEIMOFRIERE
BICIEEZTHEVET  INFROTIL—TORYVDERDT AT LEEZRLTHD
TN—TOREDERDTATLEERL. 3EE—FOERD/ARILOTEN
(Bracketing) 1DV avIcH B /MEROEERIVEI )V ILET,

BEFED/NEHRD T IV —TERBMRLT, FERICEFNO/NERERF-EDITIE.
FEET—FT/MEREEIRLT [Delete] F—Z#LEY, (RLEE—FT/MEIIRZHI
BryHL MAIDNEZT—ILT 1 DORUVVNEIZVER T HREICLRET=0. IE
LOWE—FDNBIRSNTNDHIEEHEREL TS, )

KIFBIME/NEHIRE) YT B DRITA XINFZA VAR AUSD T IL—TE—
EIZBIRT 5156, TKIEME/NEHERDZEE (bracket and barline change) DA
ARZHIBRLET,

HRBARARXEINTF2A VARSI AVRD T V=T H#FERLIz\vE—CDHET, BE
FILAVITHEESNT IAHIEDA VARG ILA DT V=T ICRTIHBE. T 74
IWEDTIWN—TIZRTHEEEIRLT. IFF (Engrave)] » TKIEME/NEHRDY
tyhZE{ERK (Reset Bracketing) & ZIRLET , CNICKYBRLIMMEIZAAF
PERSNETH. VEyr DR IERDOHEEDBIREIEMSITHEYET

FILDRRO VT D —AZERIC)2yh T 5l LB TEET . ChETEIHEE.
HAREERLTTONTANRILVEREE T FILGEMESN T KIFME/DETRD

Z® (Bracket and Barline Changes) D5 IL—J T, [K#ElEZEE (Change

bracketing)1ZI BB (Auto)lIZERET HE. DREITA RSN KB FEI%E

HIBRTEEF 9 . MNIT#REZERE (Change barlines) ICRIERDEMEETEIL BR

BRA RSN INEHIRDIE S ZFHIBRTEET,

BEREEITA5—

HLGEMENT-T&E (Engrave)] » TEEEESE (Music Symbols)]DF 47O
TR MDFAT7OT (A—FEE. BIFEES. BREE. f58) TIHEETER
WIRTDEREDHNEERETEET,
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Ecit Music Symbot

g
&
I
s
I
-

xofset: (000 |5 xseale: [100.00 [ Zode: gy T

Yofiset: [000  [5] Yscale: [20000 15

Add Glyph

=] -

RBEEATIT) IR ESN. ChEFAT7RTDELADELIF—TERTEE
9o e T DERFEEISICRYVADIFEIE, ATI)—ELIZ—DITSTDIT1—IL
FISEREREXFIEAALET (ERGENFELTIE, THTFIY— (Category)lt
LOA—%IFTRTHHTI')— (All Categories)]IZRETDHE. ITRTHDESEY
ESIRBEITA—ILEDXFHNERETEET,)

CDFATAY THIROEERBETEMERLIZGEE . N Dorico TEEIIFERT
EEEA. NBHENSF. BRBEES. SNES. BFiLS. ERGEEZRTITD
EOISERASNLDIE. TIAHILFTHBSN TWSEREEEZITTY,
HEBDEELESEZEELT, LBERTHITRTOFRITOCcI/rTHRES N5
BEERATHILICTDHICIE. BEEZHELTTTIAHILLELTRE (Save as
Default) 129y oLEY,

41 R—2 Steinberg Media Technologies GmbH



WER

Dorico 2 /N\—2av R

@ steinberg

FREFECS

FREFELSZET Y1095 hRAZLDBRESET VA0 T5LE. E<LDBFRITE
HOT)IDEAMGMEDRENVELLGYET . BREFESITHLLI YTZEEM
LI=&E. ENENDTVITNR—RFA B EELTEISh S LIITRYELT=,
CRIZKY, TORZEELT DIV ELGRBOEEZRRTEET,

7—T4Falb—ay

ERANDEEZHAISNEED ., RAFVNATAVVEDT —T4F2L—230®
R T HMEAHESNEL=,

MBS

JE—k: NABFBITVE—rERBRLT /INIAERINSZ LI/ AT
meEgohdLS5HGYVELEZ. CNIE. BEF T3>0 INHES (Bar
Numberts) IO R—2 [CHLGEMESnZTYE— b3 DO /NHES (Bar
numbering for repeated sections)IDA 7L arTHlEIch, A ID TR
TOLATZIRET RTOTA—ITEASNE T IEARETIEIVE—FEAI UL
ZZLy (Do not count repeats)]IZHRTESh, COBEVE—MI/NEREIZFEE
BEzFEBA TYE—FEHD UM (Count repeats)IZERET D& VE— I RIRS
NBHLIITHEYET,

JE—rERBSE/NFBSDOLATINZEDRTAEIL. LAT I Ty
QOUPNEESE (Bar Numbers) IOR—JIZFHLGEMEIN A T3V THRETESE
9, TVE—FrEhHDk (Count repeats)1ZIFRTHIYE—F (All repeats)]IZE%
ET e BEINSZBRONHESNEATRRINET 2EXE FLHD 8
INEAAY 2 EIRYRESNDIZBED 2 IMEIHIZIE, MHARETE2 (9)1&FR TSN
FI . [HRBETHRAL (Prefix)IETREBTHRL (Suffix)IZZERTHE NEIHESD
RUWVAZIEETEEY (FEAFTEBETERL (Prefix) 1zl IICLT. TRKETHF
Ak (Suffix)1ZHELIEE . "RRIE12,9112YET),

AIUMIVE—rERMLTEMNSE DD, RRTH/NHEEE 1 DFEIFIZT 55
Bl . TEHNDOVE—rDH (First repeat only)JIZRELET . COA T aviE
FALEGEE . EARIEILHD 8 INGFIDTIL—X% 2 BIEELI-HEDRD/IMNE
DBESE, T9TERHGLML7IIZBYET,

EINFICRA TR REDNHESEZRRIELIEE L. [REDIE—FDH

(Last repeat only) JIZERELET . COATLavEFRALIGE. EXIEIELH

D 8 NEIDTL—X%E 2 BIRET D5 DRAD/PHDESE. M1ITIFELI9)
[TRYET,

INHBBEDERT: TEa— (View)l » /NEIES (Bar Numbers)IOA 7T 3o
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HESN MBS EEBREO—BLOERD LT TG TARTOERD LIS
KRR TESDHFIITEYFELL =,

B THEIINTI/NET: LAT O TLarDlINGES (Bar Numbers) JDOR
—VICHERZFOVTHASAENMMIOMBRORBMEIC/NHESZRT
(Show bar number at start of system for bar split over break) |74 T3>
FLGEMENEL ., CNEMHARETAUICESTOWET . COFToavEed o
(29 %<&, Dorico [FHEBERUIVEF-LTHBEISN /N DI=HDAFEIMDED /I
HBESZRTLEGYET . ChITEHERFORBMTENGIZEENAHYFET .

LAT AT oay: LAT7 AT arnlNNGES (Bar Numbers) | OR—
DEFEREIN . 7T av 0T L —THEOBGREN LMY PFGYEL, X
IRTOATLav L ZRR (Show..) JEEATHRIIH—Sh. [ ZFERT
(Hide.) 1ZERAL Tz 3 DDA TLavERFMDORBICEESAELT,

AT

EHDA: BEF T3 DEH Beams)|DR—CDIEELBE (Vertical
Position) 1D avIZIHEIOFEDRAENERLELEHTDE 2 E#ﬁblb—jd)
fiii (Position for secondary beam groups in beams with opposing outer
stems)IDFA T3 NFHLGEMEINFELIz, SNIZKY . TRTOE 2 EHfTIL
—J%%8 1 EfORBIOHZRRLTVALDYT IIL—TEbMPTLTE5nMH
DIZE 1 S ORMBIEHOANRETHLEHRTHN.E 2 EHESE 1
EHOEANESRICRELT. EMOAORLELHIETENMDYIZUXLOTIL
—THDOMIKLERHEENH D LEHBT M. WThHERIRTEET,

FTEEENORS: FEF T3> DMEH Beams)IORXR—C D48
(Appearance)lD o av(Z, IRELEHDES (Partial beam length)1DF
ToavhFlGEmEnEL,

EHPEES

TAT4OELVEBNMDERDERELES: TAIPDERDBFHEE. BLULIV
ARYILAVCDTIAILEDERD ENTICEMSNI-EROEMILTDORKESH
EFHEIN MHETOEREFTRLEEDY A X TIIEL BEE2HEYAXTRTREINE LS

[TFYFELE,

TAT42
ERINIL LATOMF T3 IR M (Staves and Systems) D R—
[2H 2=  BERIRNUADTAI4ODEIAVBDRTRIZEAT 54T awm,
[ DRI 3V R%ERT (Show section names on first system)l&
TRUBDOMERIZESar£%RKRT (Show section names on subsequent
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systems)I®D 2 DDA T avIcHEIINELIz, AT avhpElashizCeizk
V. T4 T4 DIERAEBRDOFIRMEIZHEBEE. TAT4oDN\vE—D DK
PMDMEDHIZTAT14oDEIAVBERTTHIETERTESLLIITHYEL
T=o

EROMRRHIZ: LATIME T a>DIBRODAR—I YT (Staff spacing)1d
RSN F4 T4 HERIERT SRR (Gap to use for divisi staves) DA
vavhFHLGEmMSh, TBHRMSHMERFT (Staff to staff) IOMREER (FiH
ERTOS IO TIHILL) §50 . [EEHRNOESHER (Braced staff to
braced staff)1EZTHORIM@ZER (Dorico 2.1.10 UBITHDTIAILE) THM%EE
RTEDKSITHBYELT

TAT4ORROBRRAE. ThDMERTIMEREICRVNET, EARERIES
§3® (Braced staff to braced staff)JAEIRSNTNDIEE . EAERELTICE
FlERIA (L BERASNGLD LRk, T4 J4OERATICHLERRZ TERINEE
b TRERDVSFERFET (Staff to staff) INBIRSNTNSIEZEE ., T4 J(PHERR
TISIEFERESI A A BRINET,

MEERLE

M5B 2R 95 Dorico RS I —TIZBT SR BEELERICHLEE
HIICERBILET  HIEARETIE, BT HRBESIFIEEMICT L—TLEhFET,
— AT, BELGVEBESOREINDERBELHYFET . T, EEEIXTILZD
TEAVRRGI AV TEEREBEN RS-0, BIIDT-HIZEBIESES
V=TT L. BLREHLATIRTIEEIDHERLITEIH->TLESIBEELHY
FI,CDIEADORUELT, AT RTHRE (Edit)] » [385FES (Dynamics)l
» [TRSFFESZEFI (Align Dynamics)IDFLGEMEN ., T IL—TIE LK THIE
B DEF TP S HEICEYTESLLIITHYELT=,
COATURITHFEE—FTLNMERATELRLV O FTIXFEETFICYIVER, B
S HEBFBEBLEERLET, CRICIE, FILGEMSh - U RTERE (Edit))
» TEHITEIR (Select More) 1z ERATHEEHFTY (MR (Selections)IDIE
5 M), MBS EEHN (Align Dynamics1ZREINT H&. BIRLESBERMND
—BHNBBERSICEHLETC. TR TORBEEDEEMENRIALONET,
BIILI=-HEIT R TORBES TBIRREBOFETHL-O. BEESY [Alf]
FRLGNLETORMF—Z2FALT. IRXTCRAFICETOMERSHEITERAE
ED

BEESOEINF)EYNLTRDUEBICRTIHES L. BBREEERLTI{ESE
(Edit)] » TR av%Etyk (Reset Position) 1 Z:&IRLET,

BHROERICHEBESEERT D BHOERICHT HEBELESDEME 1 [
DIFEETTLRADLICLRYFEL BBRESERRSEIERERRLTHMD
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[Shift]+[D] ZIRL THRBESDRYTAF—/N\—%FHE ANZEEET DL ERL
Y RN TOERICERBESIMERSNET,

245V

Ry TA—IN—%FK(5EDHD: [Shift]+[F] DI« HI T DRYTH—N—% %
EN¥%—. [Space]. BKLU [Tab] ZFEALTHEITEDONDKIITHEYFELT, T1>
AV T ZEEBMTELDITERTOEFDOATHD 2. Ry TH—nN"—%%IZ#
5L, Dorico [FREDERICET BV LEREIEINBTLEHMIERLE
¥, BRDEMDERELEMBFIZ T HIVTEEBMTDIER. THIEEFHD
BRELIIREIC—EIZT140A) T EBMT 5 E &, [Shift]+[F] ZiH9 8IS
FHCEFFEMELERTIVLENHYET . EEDKRENF—(E. WAEDEE
BT ARIEIERDBEFEIFHEICHELET , [Space] & REDFLRIZE
FTORDEFEEMBTICBHIILET (F=12L. 11, 2, 51D KAV TERR—R
TRU =74 AT BNERICAATESLSIZ. Ry TH—"—IZAALTLVS
REOXFHNHUT () THHEEEFNEBEYET), [Tab] & REDOFIICE
TRARDINE DRI DERFE-(XFNE. [Shift]+[Tab] FIREDFEIZET B8]
DINFDRVDEFEIEIBFICHBELET,

T340 DEERL

1200dpi MEEFHL: 1200dpi DEBED TIFF Ff=I& PNG REVbIvTY
ST49PEESHLTEDLSITHRYELT-,

A ARIL AU

FLLWTZUH TN BREE—RTEROFLLT IHILOT oSV TIILONRAT
EBEINTHYFEL . SNITIE YTV RYNITAT . Ry THR—20 X EVY IRURR
—VRBGEITMA SESFGEIV X LBV AV EFENET,

AR AVIDER: FTEBZIL—V D ESELEBTREREXEICHELE
ASIGE. . BERESNICATRERERICHLEZASMRIZ, Dorico [FAMGEERED
SITMATENGRBTLRTT HEIIHYFEL,

LA47k

LAT7ORES: —HOERATIE. FERMICFTFONITEFERALET  HED
EREBANTH=HICHINT BEEE-IIERBSEFEAL. TOHRMICEET
207 (LYBLDIFR) /SA—MIlE, HE2OTBELHETENA—FEHENES
EHERALET ., &AL, ZULRAT7ICZIEHEAOT ESDI23512 )% F AL, 78—k
(F723512-011. 123512-02]. ELVSBEXDBESEZFERIT HLETT,

CNZERBICEETESRIIZ. ELATIMIEENIZEAEMTONA TS, L17
TrDEATIZBEREDESEEZAONSLIITHYEL (TILRAT  N—F BLU
ARBLAAT T RTEAMZFT NI T ENFES) LATIMDLATINESE
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BRFELIFZEFTBHICIE. ZREE—FDILAT IR (Layouts)I/SRIILTH—FERE
e 5L T TRENMTHZAET,
LAT7OFEBRIZLATONESZHRTHICIE. TFANIL—LT
{@layoutNumber@} DOr—2 Z#FERALET . CNIERTORIZLATIRESIC
BE|AONET,

FrLAT7ICESIE. NRIE—R TS 74v0FESHTELEE FETT7M4L
(File)] » TEZEHL (Export)] » 20— (Flows)Ih o777/ ILEEEHT EE(IC
Dorico NMERT 577/ LB DEEBEIZHEMEINET,

R=ULERDYARADERTR: HEE—RTLATIMIRILOLATIMI—FEE
FToL BERECTHELLEREORMTR—IULEROFIINRREN, R
—TSENT)EIRDR—SH AL XDNTIANIERTHHERER—CT) vk
BDRRENDEIIGEYELT,

&

MADNATY: BEATLavDOTREA (Lyrics) 1IOR—=SDTNnADY
(Hyphens) 1ot o< av Iz TREAIONATVICERTSXFE (Lyric hyphen
character) QA 7L avA#FHLGEMEN ., BEDEDNATUIFERINDT I+
IWDNATXFE EEESTEDRIITHYFEL=,

v—h—

I—HA—DEA La—F: HFEF T3 DIIT—hH— (Markers)IDR—I(ZTT—5
—®D A4 L3a—F (Timecode in markers)IDA T avhEFHLBMEN, ¥—H—
DEALA—FDRR/IFERTEERTEDLIITHYEL,

MIDI OESHL

e ERANLBEETEDORAE (BRK 7 20V v—TETSYMILDBED) A
MIDI Z7A4ILIZEEHINSLSITHEYZELT -,

HFES: ESHINE7O0—-(ZYE—IMNEFIhBGE HFEEENIE—LER
MLTELKEETHINALSITHYZFELT-,

MIDI DEed*+AH*

Y—7#—: Dorico I& MIDI 7ML —h—%5HEAAL KIIZEYELT-, MIDI
T74ILIZ SMPTE #A7tyMEAERESNTLNSIHEE . Dorico [FINLFRAIAF .
JO0—DRBMEDRAMLI—FRIOIIVDHFREICEALEST, v—hH—I(F MIDI
ETHLBICETHINSSSICEHBYEL -,

TURER: RATHAEHDANA/—LI—ITHAINNZDIEEHSTZO.
Dorico [ETURDINSHERIIHARFELTHEARAHA, 100pm LU EDEELEDTY

REBEDQHAA/—LI—PELTRRT HEIITHEYELT,
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TIHILER—TDERFE: Dorico (&, bSO D Z LN MIDI 774V EHFKMAAD TR
[SIE. ZUBTIFINIR=—DEERTAXDEREFRADEIIICHYEL=,

RAZFRBDORI: MIDI 774IILD&HEHFAHE-IE MIDI FEDRIZ. RE2RED
ELWREEZERTBEHTILTIXLNRESIN, A AHEBOANEICFEHTE
ELRBTENKIBIZHYELT=,

REJLER: MIDI 7ML DERAAFHEIXITILEA L MIDI FREFDORRIZ. MIDI
aAVbA—5— 64 DT—REZHAWMBIEIZEY | YRTAURS JUIRER A AT &
SITHYFELT=,

TL—¥—5)L—7T: MIDI I74I)LEFRMAHAATELE SR AOA —7r AL —23
SDI=HDYV—RETBHEE . FHRAABERDT oYU ITINDTL——LHEHA
EFNd MIDI J7AILDBIERESNTzTL—V—% R TEDERITIDFEENLHY
9, IMIDI 27/ ILDFEAAH (Import MIDI File)IOF A 7O 1Z#FHLEME
NEIFHRTL—Vv—IZTL—Y—J )L—TF%4ERL (Create player group for new
players)1&#4 129 %&. MIDI 74 ILDRSYIRBICEREIN T RTOTL—F
—h BT IL—TITEMEINET, SO N—TERBEISHCTHENSHIRT
=FET,

IN—KL ATk EHRIZ. MIDI I7M L EZEAATRITEMSNEZNVThDOTL—
N—IZH/IN—FL AT IR ERSNEBVIESIALWNGEEEHYET . CDIGE.
MIDI Z7ALILDFEHAAH (Import MIDI File)IOF A 7O IZ#HLGEMENT-
THB|IL—V—IC/R—FL A F7IRZERK (Create part layouts for new
players)ID#A 7S av& 4 II2LET,

sHY—

READHAZFERTICTS: TNEND VST AVRRYILAVMEIESETFGH
NOBREHLEETHN. TSV AV DBBRRETIE, SFY—ICRRINHHEHID—
BORFEADEFELLRY . CNIZK>TEFRY—HREL EITRVDEDFEEMN
HYFET, [RIDERE (Endpoint Setup)IDF A F7RJ ([CHLGEMENFISHY
—IZRERT BT —T14AHADE (Number of audio outputs to show in Mixer) ]
DA TV Tl SFY—IZRTINDIE N OFEHIBTEET,

RUHF

EARFZzRE: RNFZRED/NHRTHET 2T/ FHLEMSNELS =,
NIE 1 DDIDELTRRSNSGERFFE 2 DULDURFICHEITILENS
BIHEEICHERATEET , CITEY EAEEMDTIL—XEBREEHLMY PTLLE:
Y. UN—F IOty a P Fa—EEERADHRIICLIZYTEEY,

FETFTRUNFZDETHHLED/PMEREERL T, [$E (Engrave)] »
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[RAFZSE (Split Multi-bar Rest)1Z:EIRLES , [938 (SPLIT)IEWSTFH
AREHFDHAEDRRRIN, TRTDAVRAMYILAU D N—FTEDNEREE
FSCRIFNDEISNET . REIZIYETIZE, HAREERLTHIBRLET

E e

THERRANIAEEETS: [HE (Engrave)] » TFEEIA2F (Music Fonts)]

DFATATIIBEIA VN EERTHEEETFAN IV MEEE (Update text

fonts when changing music fonts)1DZA 7L avhAFHLGEMEN, BE I+

EERLEEITTXRANIA VMG E TEEET HAMEETESLIITLHYELE,

COATav FMPBRETEAVITHE>TOET . ChICKY . BEI+ UM E

[PetalumallZtIY &R HE. TIHIEDTHFRARRA T+ M Petaluma Scriptl |

ESN, [BravuralIZUIYBZ DL, TI4HILEDTFARAT 4+ & Academicol
[SERESNFET,

MusicXML DEHAH

TIHIRR—CDERTE: TRARAL MusicXML F7AILIZRF AV RDR—=DH A
RERBADRESNTIVSIHS . Dorico [EZDIEIZHELY., IEELBNILERY 4 X
HRARAL KIITHEYELTz, MusicXML F7AILIZR—DH A LR Y 1 XD MR
ESNTLEWLMEE. Dorico (FT7UHUTILDAU RS ILAVMRIZEDNTT I
AINDEBYGER—CH A RERER YA XERELEFT,

EHOAS

RyTFd—iN—: BBEE—KFT [Return] 2T Hh 1 DDTATLEZTILI)YY
3L B RRYTA == ZOTATLORBENT TIZEEASNIREE TR
KESITHRYFEL Iz, SNIKIBN—23 TIEHFFA LR RS ITEH> TV SHEET
Li=BS. Ry TH—N—%FRT 281 TDT AT LT RTICHRRINELEz, ZDX
ATDTATLICIETUR, BBELS. BHELS. 72— TR A5 AFES. &
EREERRESEARLERS . RIULBR.VRIVIT4—IL, Fa—  TILRIOFE
BTN EME. ZLTRILAHYET,

NEDFEY., CRFETIHEIRLT [Return] #WTEICKH-T, ZDREIZF YL
YR RREINTZT AT LD ZLTIE hDOYIZRYTA—N—MRRINEKLSIH
SfzEWVNSITETT, FrLybERTIEDICIE. BT FIE . KR EHTE(E/E
BEEIRLTH S [Return] 9 H. [Shift]+[N] ZBITRHELNHYET,

2 DDEROABTEANEZD: aAvURTRE (Edit)] » TEFKRREY T
(Paste Special)l » TAKEZ (Swap)IWFLGEMSH ., RAD T OLU XY
IWAVEDERBDANBZZESICHBISHKEDILIITHRYEL, BEMICIK. TT
HRXTA—F (Explode)lIZk>TERSINIZRAL VT IZERTEZMAZWMES.

BEnfz=\yt—20dhhs 2 DOEROBFHAZERLTIANEZ (Swap)lx
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BIRTLE BRIV TERBEAEFETS
Talb—2a vzt BFEOERERFICTIL—2a0 DEHlEREEILHRE
RRTEBLSICHYEL -, CRIZIBNR—2ay TR E T - ITKRBTEA DT B8
RCLMERETELZWVEDTLIz, Tab—2avElHL TANSIN BT E (3K
FEBRTDHE VIR IIRDORIET DRIV R TEHEIIHYELIZ, Ta
L—ar DiahilEfERR T BIZIE. Y—ILiRy I RDRIAVERT A, F—FR—F3
—rAYk [O] ZHEALET . HIC. BEREBRLTC EAFEROBREDHEE
HEBELE-EERSELERTCTESLSICTaAL—av %t cExd, MEOEFE:
FARFOT2L—230F@HTHICIE. TNEBIRLTY—ILRYIRDREVEY
JuogdHm.[0] ZHLET, TaL—2avDBHNERESN-BFOETHE 2
DLLLERATESET BHHEE. Dorico [FAA1DOENYDZREDEDTaL—3ay
DEFIEHFLLIELFET,

Yo OIN-R5—LREIES: RERXEDEFDANLESE (Note Input and
Editing) IO XR—C DIERE (Editing) 1D L3V (ICTREYMHTEIEEBRE ERS
—ZBEDT AT LIZ) 2 EES (Link dynamics and slurs to existing items
when pasting)IDF T arNFHLGEMESNEL =, CHIFHEAZRETHUIZH-
TWEFT BB EDTIN—TFLIERST—FELIERDIALLDORLAEIC
FELTaLb—2a>THYMITTH. ZNODRBREETORT—IT) IR LA
F5MNFELLMES (T, COATLavE 4 TITLET,

BOZOMD/NEFUNDTAL—a 0 EFAT S [Shift]+[B] DRyTA—/\—
ZHEALT, MHEEDORSE T THEL EEDRIDAR—REBATES LIS
HYELIZ BATERSE, FTHRAMICH T HEHERFTIHREL. RICELLZD
D%, TaAL—2avITHIGTHHF (f&AI1E 4 HEFICIE6]. 8 AEFICIE
[5].2 HEFICIEI7145E) FIEXF (&R 4 2BFICIENgL.8 KB
[SIETel. 2 SBEFICIETh], 16 KEFICEIx1HE) #HEALTEELZ T 12
(M1 (EVAFR) 2EALTANTEET BREELOVWTNITLEFEFERTD
BRIE. 2 DDEFRR—RFIFNATUTRYZBENHYETH. EICXFF
FAITIEEEERNLIBEETHYFEL A HIELTIE T4ql. Tw]l. T4-61. T2 711F
FTRT 4 DEHF 4 DPDERIEFBALET,

ZDOHDhYIZ, [Shift]+[M] DRy TAH—/N—THFILEEZRHLIDIZFERAINDE
DERBEDXFEINBLANTEFT T =EAIE TAAIEANTRE 4 BEF 4 29
DRIDEAINET,

MFRENEEOHI/IEZEEAT S Dorico DIAN—S3vTlE, HFRELEE
RLTHD [Shift]+[B] DRyTH—/\—ZMUHLT/MAZBEMT DL INEIAE
MENZDFEIHFLENHETL, SN/ DB EICHEEHE L
KFAEZERLTNEZEATHESLRPRDEIETY , Dorico 2.2 TlX.1 DRIN
HFEE. FEEFOBATENTHAIMF LB EEALUNMIZEATESLS
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[TEYFELTZ, BFRBZOHLDOEEIRLT [Shift]+[B] T L. BFREBIETN
FYBBRIDTRTORABRE—REICHITBEILET,

F—R—Fia—thyub: THRE (Edit)AZ1—md, SEIFHIATURITHLF—
R—F2a—brhybZEIYETONDLSITHYELTZ, CRITIFA—FROKRD 3y
[CRBBERDIAINEIT  FRIZEDBERD IR T GERLE-EFOFH
DEBLBENEENET,

DALTYyR: VALT)YFDREEEBREIELBRFDa— v MIMA T,
DX LT)IREBEDERDTAL—avIZR/ET 5ODF—HR—Ka—kh
YREEYBTONSELIITHRYELT=,

BRORSEZEETD BERNORIEHFEDTAL—aV TERTHITURAH
LGEMEN., SRISIEF—R—Fa—bthyrEBIY B TEHIENTEE T, CNIEH
FORSEZREDIVALT VYR TERYT AREFNITUREHTELET . choda
IR BEZREDF—R—FPa—rhyk (Key Commands)IDR—I T,
[FalL—Sav%&%EM (Shorten duration by) 1B LUTFaL—SavEEREER
(Lengthen duration by) I CHRERTEET,

UM GRICEIFEOREREZER: BE—OFHHILLRLIBERLEELMYMITLHEE.
Dorico [FEICFHEDEIREERT DD TIEEL, YR ITED AU RRYILAURC
BED, BEAXKEZBLOHEDAMMNIE—TLRLERE. TOFEFEFEHATSL
S1TEYELT =,

v

AV R RMIATEHIEFHOI=YUICHITEHRmONBICET 4T3y
NEBICHBINELZ, FEF T a0 EHF (Notes) IOR—U DI+ R
(Rhythm Dots)1D oL avIZ#HLGEMESNZIFILTEFEBTOIL=YVIZEIT
A{tm (Rhythm dots on unisons in opposing voices)IDA T ar Tlk, BFF
CEICERDMREEICRTT S BICRRLAGLD, A2V U DEFINERBRLIC
HEGEDHERTTD (COGEEFREERFOLTOMICHIICEESNET)
DVFThNEIRETEEFT,

BE

J)a—)LOBE: 7Oz 0 1 DUEOT7O—H 1 PMEE® 1 AE KV
DEMBFFAINSIRFEDIBE. BEF T avDIRL324 (Timing)iIOR—CTh
ITHLEREIODT)O—)ILEIEELT, Dorico A 1 /MEED 1 B KYADLETIAND
BAEZRBTHESCTEET . [70—DFIOF)O—)L (Pre-roll before flow)]
EEYAEICHRELEY . TR 1 DITHLTIE. 0.25 RIEEDETHTAT
ER

TILFR—k VST 7545 14>: HALion 6 ¥ Vienna Ensemble Pro #&—&iMD

50 R—T Steinberg Media Technologies GmbH



@ steinberg

VST AV RRSILAVRE 16 D MIDI FroRILMDIED/NUIEERIEZETH.
Dorico [EZMBMNUIFIRETEDLIITBYELT=, FovIAyF—IZkay TS
DUAZa—pBmMEN, TSTAUDLREINIR—IEBIRTEFET .1 2HD
NOOIER—MAIZERL. 2 DOIEAR—FBI.3 DOHIER—ICI ELVSESE
[Z7RYET, [BImDERTE (Endpoint Setup)IDF A7 BT LIRS, 2 /3298
LBOEFvoRILIZ VST THORTLyavIvT B8 LU NR—hyiareyTs
BETEDSIITHYFELE,

Rl

SVG Y 574v%: Dorico (. BIERR., J 7747 EEHLELUHIRIEIZ SVG
T349I DZRIZARETESARECH. TS T4 I LGHEEGSEFEALTE
BLOA) T ETEIKIITEYELZ, SNITEKYT7AIL YA XHME/ML . PDF
ESHLBLVHIRIBFOELSA M LELTLET,

MEENRL: T)oa—DHMARICE>TIX. MFOMEARIZEFETITESLE
(REZHMRIL-HLEAMEERLTCERMNRBIDOLOIZT) U A—IZHELLEETL
E). HAIOR—C DO HIRIEAEZ>TWSIGELNHYFET, FIRITE—FDOAREID /N
FIVICFHLGRESN=THAIR—SOMNRIIEZFEIZT S (Reverse order of
outward pages )IDATLav(E. A—0 1 #& (R@E) OHAIEEHICLE
Y. CNIE—FBDT) o A—IHEGEETHY . EEERIDT=HITHEHLGEE I8
[CFERTR—ZHEICHEARGEETRENGLBYFET,

FEEBEEIR: TXTOLIT2A4T T MFERICMATCFEREEIRIZIEE T

EFBL5ITHYELT=,

N—TEE DL FRIOR—JEHEZERICIEE TEDLIITHYFEL I, [A/N—

D3 CIBAsR (From)J1&MET (To)IDRE OV A—ILTHLE=ED X I T4vb

AVFO—)LICEERAON ., BHOR—CHEZBERAICAATESLSITH>TY

T, TNTNDOR—CEHIEHOITRYULN ., BT H2R—CHEBOEEICIE

INIDVEFERALET F2EAETL,3,5-7T1EANTHE, HIRIENEHZR—T 1L 1, 3.5,
6.7 ITBYFET, FRZOEHE LY R— S, BRINFZZEER—DZFFIEIZED

RILET,

YS9y I4—IL

AHEIZRBEIESNHDAD4UT: 4 DEFHLDEISNT 8 49-16 7-16 4
15154 . Dorico [FCDE—FERO4 T TEEL, (FLHD 8 nEFERL &
AN 16 HEHF 2 DFHBFDEVNIALIZINFEERLSICELLTEETALS5I124HY
il./f:o

ER
IHITER: O RT#EE (Edit)] » TEHITEIR (Select More) 1A #FLGEMSE

Dorico 2 /A—CaV B 51 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

NELIz, T4 D F—R—Ka—rhyb(E [Ctrl]+[Shift]+[A] (Windows) &
f=I& [Shift}+[Command]+[A] (Mac) TY ., CDARUFEETTHE. RAEDE
REZENSEDARNUNIATERBIRFRET HRED . F12E DA —LITER R
RERDDD DI EITENET . —EITHSIAANU I T OEEOEUHIR AR
W= BIREEIFERDERICENDGEELHY . FERICABETE4ITY
IOMDAGLTHERIFE T 5TV RELET,

E5IZ®IR (Select More)llE, #EYIRLEITTHETEIRGEER L ELITON
FT. 5T . BEO/NMOHBEDERIZENYET , RIC.R—CE2—THDEE
FREDHBEDHBEDELRICENYET (FrL—Ea—IT(TMEEA 1 DLHE
W= BIN EBYVET), &ZIT. 70—2KICEAVET,

BREFOILKIIEICKFEABMERYET . RIDBRHRICEFENTULRNRL
J=LDTATLITBRENERE A 12EAE. 1 DOERTHEN LRAZOFEH
CERIAEFERRLTUSHICRRIZRITLELEE. ALEROFENTRED
BEITERSNT | FMOEROFEN LAZOEFEHLERSNF A,

REQCHEATETATLESLITERLEISELTHERZEOELGWNEES (fz&X
(X 414 DINEITEBE/ERIRLTIESITREIR (Select More) 12179 54, #iR
LI=BR/HT TIT/PMEIZHZLTLES TSSO MTRTIN LU LD EFFEER
TEFEHA). Dorico [H:ERFEOEIETAETEIMNICEHEZR (/MET. FHER.
70—0JE) ISEHFT (=L, BIRTELHLUDTAT LN UL EFELAGL
BREAEAAIEKRTEEEA).

TATLDHZ/NEF(THEENSIBFEYRDPDEF(FHETERDHLHEES. C
(& Dorico NZD/NEIFEIFHEDERFCHELILALILEEITERSNFET
(fEAE. HBEROVEFCATEV L. RUDOMHEEDRFRSFZIRL TN
[FFBRENDKSITHYET),

FESIZER (Select More) Il REEE—FEREE—FDELLTLHEATEET,
SO, 12ERFT IN—T LSNP REFERL T ETICUBREHETRIG
B.REE—FIUYBRATHEE—FICRT LR EEZESTREWTERAET,
1 DOTATLOHFERUIRETIESSITRIR I ZRITLIEE NI A —3h 5L
DO DR —REUTIZETFET,

» IE: BALTEIRTIE. TDTAUBE ME. BFUTIU 21 TH RSN
FE5ISEIR (Select More) 2 R1TTHEGEIRSN TV =TFAELSAIUES. fiL
BEBLUTIVAMTH—BT 2MADHIEIRSNET,

" 5BREE: WBRELERLTIEHISEIR (Select More) 1ZETLIIGA.
Dorico [FZDFEXRDRILYT IL—TIZET HiDEBRETE—EITT X TEIRL
FYT (R—CEa—TEH. ZhoARILHEEIZHIBEEDH), [EHITER
(Select More)1&xELITETY HE. AREBECH LMD T IIL—TIZET HHhD
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@ steinberg

RIS TERLES,

n EERGE 1 DOERBEGEEEIRL-GE . TE5I2RR (Select More) 1%
TTHLEICHTI—DBEEEEDHBINSNET , SOITHBHGET—RELT,
EFBETIFBEOVTNADERBEEREIRLIZBE. [SHITEIR (Select
More) 1% R1TF 2EMREERRNTRTOLITBELIETIFBDEREEMN R
RENFTH, thOFEDOBERBCETBIRSNEL A,

BIRUTATLORTIERTEZVNYEZS: AV TATLERT/IERTE
(Hide/Show Item)IMFHLGEMEINELTz, SOATURIEAZ 2 —IZIERTINF
HAN REZEDIF—FR—Fa—rhvk (Key Commands)|DR—I TH—
R—F2a—rAYbrEEIYETEHEIENTEET, COATURIE ERTIZT B8
DERAOTO/NTAEHD, I—RFES. EERE BFELESD 3 2OE/TD7A
TLIZKHULEEELE T, Av U EAEITSN D&, Dorico [FERMRESHLT, E
RRICTESTATLEHAILFET  BIRLEZT7 AT LICERRERTEA DIKED
HAEE. MEDETTIEIRTODTATLMNERTKIZEY . ROETTIEIAT
DT ATLDNBRRIINET,

HBFEBEERTIITIEEIL. TNDARRINDITATOLAT7 I TIERRIC
BAHIEITERBL TSN, HICO—FESLESRHEE. a9 REETLEZLAT
DEDHICENTERTRITEYETS,

25—

WMEEDRAT—: HEIDATI—DALA—IM, CNETIERASI—OAEICEADLL
FTEICEETHO>-LDON, AS—DHEICHLEAICRTEINSLIITHYEL.

FFASILEDMT S BEA T DIRAS— (Slurs)IDR— DT EZRO [) 8
(Avoiding Collisions)1D oL avIZTRS—O BN FTFaIILDEITEVES
(When slur curvature passes close to the stem of a natural) JOA T3>
FLGEMEN, RS—DNFFaTILETDMDBEENT HEHLEHTHH. £
(FiEMZEZIE T EMBIRTEDLSIRYELE,

HEBET7ATL

AV TIZ S BELE: Dorico 2.0 TAYI THERNBEASNTLE, TR, U
— NIV EDHETATLIEBICAIODEROT L DFEYASUERD
FDOA Y THRIZHLTIETICLARETCEELATLIZ LAT IR T av®
MR 4B (Staves and Systems)IDR—U(Z[ERO LEDA VI TITxT 54
BAITOzUPDAIE (Position of system objects relative to ossia above
staff) IOF T avhFHLGBMENzZEIkY  BEBIZR L THET7TATLEFY
UTHERDEICRETESLRIIEYELT,
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@ steinberg

TUR

FURDZE: [Shift]+[T] DRYTA—/N—, Tr=IFTRRE—RDT LR/ SR
HFLGEMSEINE=TFURDER (Tempo Equation)Dt9S 3 EFERALT, « =
) OBRICEBI VT NETUROEXIER TESLSITHYELE, SXOTEA
[TERASNLIEMERET DX ULTOXFEFERALET,

= 25w

= 2 2ERh

= 4 HEFq
= 8 nEFFe

" 16 HEF: s

EX OB OFMICIIN.] (EUAF) ZEALTRKR 2 DOMFRLEMTEFET,

TURDEXLBE (F/NERNSHREFRE OO, TURDEFERZE/NE D FLEA
BIT/ERL =154 . Dorico [FEBMIZCHENREARND/NGSEO EIZHRRFIZ
LET AFREBOEFLZHHLTTUOROBEBRMNERINS. BLUVEENFKLET
BINETHRDREE DR DYIZEDEVSIFNGERRICEVTIE. EXDOKFELEE S
EXT—FTCRBLETNEESHEVGELAHYET,
TURDERTBEICRBEINET,

AT TCTURERET S SEE—FOTURNARIVIZTEYTFURAN (Tap
Tempo)lD YL avhFiL{BMEh, XKELTRYT (Tap)lRE2 & E D)V
T AHCLETHRTUREREMERTEDSIITHYFELZ, ThEDYVITHE V)Y
Y OBERBERMSHESNTURNTOREVRYIRIZRREINET , TURIC
ERTEEMEEIRLTIER (Create)l&V)v3 5L BIRLEICTURY—Y
PMERENB D . XRORRA U A—IZTURMNA—RFEN, 70—DY) vy LT=AE(S
TUREBRETEEY,

TRk

BEDNSTIITRIMINEFERLTCTHRFRAMAER TS SERF(GTHERICHLT
FRARDAANZ BEDINGTSTREAITHIET SF—HR—Fa—thybEEY
BToNBEIICHYFELE. BREREOIF—R—FYa—rhyhk (Key
Commands) | DR—I T, [T RXNEERL (Create Text)lFE-IEMH#BTF R E
{ERL (Create System Text)IOATI)—MoERTE/NTTTTRIAIVERFLE
ED

I5IZ. TREEE (Write)JA=a—ICTHLGEBMEN I TFRAME4ER (Create Text)]
ETHBRT X AMEER (Create System Text)IDHITA=—a—(Z(F. BENTOD
IVFTHEASNDT R TDNTTSITREAINIRRTREN, YIOXATERY S
CETHTEDRIMNNEFERALTCTIRANTATLEERTESLSIZHYELT,
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INSUTZTREANLDE 47O THE (Engrave)] » TIRSTS57R44)1L
(Paragraph Styles) IZFFUN § FRICEE R F = (FERITHALKTFRANT 4T LHMEIR
SNTWBBE . TXRNTATLDORDINGT ZTDINTT TTREAILHERS
NTHRETEHIRETHATRIPEEFET . TFRNTATLNBIRSA TN
HBETHL DOYICRRICHRELIZNSTSTREMIILAEIREN-KETH 47O
THRL=O . BEEDINSTSTREA VIR RAREREYRTELREIERT
ED

T+ bRAA)L: T%F (Engrave)] » [Tx2FRAA)L (Font Styles)IDF AT
AJIZEVWT. REDHRE Y a3V ICRIEIOZBIRAFREFEINSLSICTHYFELZ, C
NIEFRCTAVFREAIIVIZHEIOREEZMZA SV ENHSHZELEEICERTT,

B¥ies
BFEEBZHIBRT S AFESZHIRLIZEE. TOHEDBFESTDIXLLED
MEFBEILEFEA. ZOO. HIRLBFREEOHHAENSRDIBFERE
DUEBEETCD) X LLEDAR—ZHN, ZORIZHIEMHAFESO/NMHOREID
BRICEHLGWVEE ROBFERORICER/NINELDIGENHYFET,
NZEREET BICIL. HFEBZRIBRT ARIICEAT—F (F—FR—F>a—rtavh
[)]) ZAVICLET HFEREDEAICE TS EDEEELT. Dorico [ZERI/]
HOREZRETIH-DIC. BLEICRLTROAFEEEZBRHIEET,

DFENBOMR: —HOMEREAILIZENTIX, AFREEDHFELBORIC
DI LEEBENELIZELNHYET . FEF T av D BFREE (Time
Signatures) IORX—2 DITERE (Gaps) DI avIZ BESAXDAFES.
AREGHFES. ERONMUIDHBFRETNTNDO R FEIPBORREE R
ETESF T avhZBESINEL .

b=

FLWLWN—o2: UTFOFHLL—IUAEMESNFELT,

= {@flowNumber@}: REE—FD7O0—/ARILIZHBTO0—H—FDETAIC
KRENBHIO—FSITHIELET .

= {@flowDuration@}/{@flownDuration@}: TNZNREDNDIO—F=(FTHE
DO7A—DTalb—avE I 10K Bl: T14337]) TRERLET,

s {@layoutNumber@}: SREE—FDLAT IR IRILDIBEIZHILAT O RE
SITHBLET,

AV TIDADIENN—D 2D FR: Dorico DIBN—230 TIE AV TYIRDELN

b—=o> (fz&ZIE {@flow3Title@} TIFEK {@flowTitle@}) &, b—Y2 &R
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T5EOHICHAET—42% 7y F3570—¢LT . R—CDELEAICRLALNTO—
EEICHEALTLVELSz, Dorico 2.2 TIEZOEENERIN, 1V TYIRDELY
=2 ZOITCTOMENRBT H570— (FEF—IOBR—CFTEHOT
FRMIL—LIZHZEEIF. FDTCLOMRIZBT 570—) 2EHTSE5I1C
BYFELTz, SNIZKY ACR—DDEBDUEICAOTIIRDEWNREICM—I0%
FRALTH. TNETNERSZTIO—IZLETFRMERRTESLSITHYELT,

A—HP—A8—T1—R
FENADEFOEL—: aTURTEa— (View)] » TEFEAFDHS— (Note
and Rest Colors)] » IFEADEFER (Notes Out of Range)IAFHLGEMSH,
FRITOC VM CRMBRETAUITHBYET, COFTavhronLEF. 1o
ARYIILAVDEZRTREETEHNHLIEFIL. ERBRFILTRTHRETRIRINE
T, ZLDEFICIE 2 DOBENERINTUVET . BEOFHL, KifiomWnT
L—V—IZDH. F=FHFRH RSN - EREFEFRALTCOAERTELIENES
CRELGEETT . FEOTHONT. SELTHONAICHLER EEHDI R
TRISN. WThOBEETAREHELYVINCHIEREHLIVFTERREINE
ED
FEERDY—IURYIR: BEE-FOERIC.IBN—D300 1 E
EDAHDNTILEBEBRZ M T, V— LRI ZANFLGEMENELE.
BANA=232 DRIV DAYE —ITF DTN =R FITIE, TL—LiRE.
RDAR—L VT BRDAR=UGENS FEE—FD 3 DO
FREY I DA EATENYEZSHENHYEL-, WEIXIh LI
HIBRS . Y —IL R D ZADRE N EDHEEEES XS ITGYELE, R
IEENSLUTOIRIZIEATINET,
m J57490D%mE (Graphic editing)
= JL—L (Frames)

m FERDAR—I LY (Staff spacing)
. BERFOAR—2% (Note spacing)

ERDAR—V VT FLEFBEHRDRAR= VT DREY—ILDF UIZHE>TNSE
EFE RRLERTEINWFERA CNWETEEZEE—FOEADO/RILOTHEERDR
R—=IV4 (Staff Spacing)lta>DRAVHLEVHEIIHRDAR—IY
4%atE— (Copy Staff Spacing)IDF 4704 (X, [%& (Engrave)] » MR
DAR— Y (Staff Spacing)l » MHRDAR—H%EIE— (Copy Staff
Spacing) 1MoV A KIICTHYELT:,

AT—HRAN=—DHT—: FXa iR IDETHIZERGEROY < —
FKRMBMESNFELz, ChICIE 3 BEOBHRMNRTRINET 1 DD RBED
LA79bDFFIRE (TEHF (Concert Pitch)1E =X EF (Transposed
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Pitch)IOWLVTHh), 2 D& ERIRETHNIETRER RGP O/NETOERH, 3 D
BHIE RERBRFDTATLOY T —IERTT, ERERIRTHL. EROESE
YFDNRFRENET, RALHBICHIEHRDBEFNERINTNSIEE. EFHNLE
EHINEO—FEENTIACRTINET,

ATavDFAT7AYT: LAT oA Ta v iiErToarnFd47ad 0TH4
U FLLGYEL - EFAT7RT BRI ENRENLATINERETO—DY R M
KERL, CNICKYEFIATATOR—CFYRSNTYTFTHRAY T IO A=a—%
ERICRTTEDLIITHYELz, ERIDURNMIMDA T 3o DF (70T L
BOBRT, FATESLF T aoDhTI)—%4—B ThMYPILET,

SHIC.BEDR—VIZEBDOEILaVvnHLEEE L. ER
Accidentals
FDOR—DEZDOTICEIaVvEDRYTAYT—LLTRTES D
Gaps

NBESIHYELIz, Y ITAYFT =0y 3 HEENFICES [
LAV DEBEITR—UHARYO—)LLET,

Parenthesized Accidental...

Arpeggio Signs
Dorico [SlE4 T av g7 O5 DNFRAERCE. BIER e
WTWR—CFBRTIDMENAHYEL=N., KN—230 TIEESHIZ, miEEFE

WTWR—2DEI2aVDEBEEFTR—IUOMNRIA—ILT S EIITEYFELE,

TURDGFGEAEL: V—ILNN—DIZ SV RR—,B LUV RR—bD4 2RI,
BEANYFIEORAEDTURNRRINDLSIZHYELI,

A—L: AERRLTCOVEVRETA—LAVFRIFIX—LTINETHESEE,
Dorico [EFFEDR—IIZTA—HRTEHDTIF L, BAEDRRBEHO P REELE
EFTBRINTGY =LAV R = LT IMREETESLEZED AT DRRUEN R
BT BEIIHYFELT,

ROAT7DEE: ERGEFZELITHEE. Dorico (L:EREEAZELITEARERIEL.
WEIELT, ERSNSHERGEDKRENADSIICEL—EBETHEIIT4HY,
BROFRMEICFHAEITBE T HIENLAGYEL,
FAT7ATDZA4TZ)—HeE: [TEF|HE (Playing Techniques)l. IfFEEtE Yk
(Notehead Sets)]. /8545537 XBRA )L (Paragraph Styles)]. XXFER4ASI)L
(Character Styles)]. I'&E#&S (Music Symbols)1i &, a—HF —hMERFE (T
WETDTATLEEETS-OOHBLIA T avDybET)2ybeLTHED
NEDFAT7ATIE. FRTATLIEKR. §EDTOCIMDIHDTIAILEE
LTRE.RELETATLZHEROREICRIGE LN >-REICEALT, #£8&
LI=7AavDtybaERRT HEIIHYEL,
F—AR—FIa—bOYRITA2—DY—ILFvT: EREBICEOTIE . REREDIF
—iR—Fia—kAvk (Key Commands)|DR—C DEEEA V) —FRKEEDIE
FYLLGBIGEENHYET  VANDARELRIZRRSNZEBICYORRSA U 2—%
BHEDE VIV FVTICRERTATLENRTIEINSLSICHYELT,
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@ steinberg

VAV DERIME: DAV RIN—EDIREYB/NEGESTI5E .5 DDE—FRE
UHBEEIMIC 1 DOAZ—RAVICES#EH S LIZLY . Dorico ®FATTYb
VAVR D DRIMENKYNSAGYFELT, ShIZKY BREBEDOTARATLATE
Dorico ##AMEALLITHBYETH, AIEETHNIET A RT LA ITIEEREBEAL
1280 UEDKERBEBEZHE ODLOEFERIT I LERTTOHLET,

MEE—RD/NARIL: BEE—RFOBRID/ARILH, Y=L RVIRADRETET A
AV%ED)VITHETHBATESKIICRYELT =,
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Issues resolved

@ steinberg

ID # Component Issue
STEAM-8802 Accidentals A problem Wherepy setting a microtonal acudgntal with a very large pitch delta can
cause the note to jump up an octave has been fixed.
L Arpeggio signs are spaced correctly relative to notes on cross-staff chords where extra
STEAM-8722 Arpeggio signs staves have been added below the top staff of a piano.
STEAM-8445 Bar numbers Changing the size of the chosen paragraph style f_or bar_ numbers now correctly
updates all bar numbers throughout the current layout immediately.
STEAM-8505 Bar numbers If bar numbers are shown every bar, when a pllayer.changes instruments with dnfferent
numbers of staves, bar numbers no longer collide with the staff at the change point.
STEAM-8651 Bar numbers  Bar numbers no longer sometimes disappear when making an edit to another staff.
STEAM-8603 Bar repeats Using Alt+up/down to nudge the bar count for bar repeat regions in Engrave mode now
works correctly.
STEAM-8642 Bar repeats Nudging or dragging bar counts for bar repeat regions in Engrave mode now works
correctly.
Key signatures at ends of systems no longer collide with the double barline shown for a
STEAM-8456 Barlines start repeat at the start of the new system if single barlines normally shown for key
changes.
STEAM-8510 Barlines Start repeat barlines no longer collide with large time signatures shown in the staff.
STEAM-8527 Barlines Wh(_en a sys_tem begins with a grace note,' DQI’ICO would sometimes incorrectly use the
barline sections from the previous system; this has now been resolved.
STEAM-8520 Beams Un_der some circumstances, crossing beamed notes between staves cc_)ul_d cause items
to incorrectly avoid the beam once it was no longer between staves; this is now fixed.
) Beams crossing barlines no longer incorrectly attempt to avoid time signatures if they
STEAM-8595 Beamy are drawn above the staff rather than within the staff.
Brackets and The position of wings on brackets now correctly takes the value of Additional vertical
STEAM-8403 : :
braces protrusion beyond top or bottom of staff into account.
STEAM-8399 Chord symbols Hidden chord symbols no longer cause multi-bar rests_t_o be split if they are shown
above the top staff of the system rather than above specific players.
STEAM-8644 Chord symbols Setting or unsetting a prope.rty ona chord symbol with the chord symbol popover open
could cause Dorico to crash; this is now resolved.
STEAM-8406 Clefs Moving a clef before a dashed barline in an aggregate time signature now works
correctly.
STEAM-8426 Cues When showing the dIVIS_I §e_ct|on_name or number in a cue label, the player number is
now shown before the divisi section name or number, rather than after.
STEAM-8431 Cues Rests in rhythmic cues are no longer forced an unnecessarily long distance away from
the staff.
STEAM-8607 Cues Under rare circumstances, changing the clef of an instrument that is cued in another

instrument did not update the clef in the cue; this problem is now resolved.
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ID # Component Issue

STEAM-8264 Divisi Restorative clefs no longer incorrectly appear on the wrong divisi staff.

STEAM-8444 Divisi If verse numbers are shown for lyrics in a passage of divisi music, the lyric verse
numbers now appear only on the correct divisi staves.

STEAM-8743 Divisi Cue labels and clefs no longer incorrectly appear in divisi staves.

STEAM-8714 Dynamics Creating multiple Qynamlcs with a run of grace notes selected now handles groups of
up to three dynamics correctly.

STEAM-8696 Engrave mode When edltlng‘ the text in a frame on a master page or flow heading, the text editor no
longer sometimes appears in the wrong place.

STEAM-7603 Fingering L_Jnder some circumstances, setting and unsetting flngerlng on one note could cause
fingering on another note to move up or down unexpectedly; this is now resolved.

STEAM-8420 Flows When exporting .ﬂows, Dorico now ensures that each exported flow is attached to at
least one layout in the resulting project file.

STEAM-8408 Graphics files It is now pos_5|blg to set the anchor position for a graphic in a fr.ame tq a negative value,
S0 it is possible (in a roundabout way) to show any part of the image in the frame.

Graphics Importing a graphic file from a path including accented or other special characters now
STEAM-8792 . ;
import works correctly (Windows only).

STEAM-8479 Key signatures Creating a key signature that references a custom tonality system now always works
correctly.
When selecting items in a flow using multiple tonality systems, the panel now

STEAM-8529 Key signatures' immediately updates to show the correct tonality system and custom key signatures
and accidentals.

STEAM-8585 Key signatdres In some projects, creating a key signature in the 24-EDO tonality system would cause a
crash; this is now resolved.

STEAM-8634 Lodaioien The key (_:ommand for startl_ng tuplet |n_pu.t wz;s_mcorrectly disabled outside note input in
non-English-language versions of Dorico; this is now resolved.

STEAM-8609 Lyrics When typing lyrics very quickly, it was possble for the_ last character of one lyric or the
first character of the next to be dropped; this problem is now resolved.

STEAM-7408 MIDI import If a note cannot be quantlzt_ad into a tuplet correctly, it no longer causes subsequent
notes in that voice not to be imported.

STEAM-8186 MIDI import Step-wise MIDI con_troller data (e.g. controller 64 for sustain pedal) now imports
correctly from MIDI files.

STEAM-8428 MIDI import Qua_ntlzatlon for notes in tuplets now removes overlaps in the same manner as notes
outside tuplets.

STEAM-8518 MIDI import Under some circumstances, the option for vyhe(e the split pomt between the staves of a
grand staff instrument should occur was being ignored; this has now been resolved.

STEAM-8665 MIDI import MIDI controller data is now correctly imported when importing a MIDI file into an

existing project.
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ID # Component Issue
STEAM-8551 Multi-bar rests  Mid-bar changes of key signature now correctly cause multi-bar rests to be spilit.
: The size of chord symbol accidentals and the vertical position of notes for metronome
Music fonts ) ) ;
marks and tempo equations in Petaluma have been improved,
MusicXML Lyric extender lines on the first line of lyrics in MusicXML files exported from Finale no
STEAM-8576 .
import longer end one note too early.
MusicXML When importing transposing instruments from MusicXML files, Dorico is now much
STEAM-8681 X . o
import more likely to choose the correct transposition.
STEAM-7949 Note input Pasting lyrics fronj.notels W!th!n a tuplet |ntp another §|.mllar tuplet now pastes the lyrics
to the correct positions in similar tuplets without requiring chord mode to be enabled.
STEAM-8336 Note input Chan_glng the duration _of_a tied note split by Force Duration no longer causes the
duration to be changed in irregular, non-notatable ways.
STEAM-8421 Note input When copying and pasting notes spanning tuplet boundaries, Force Duration splits are
no longer lost.

) . Typing R when note input is active now correctly repeats the note or chord immediately
STEAM-8434 Note input to the left of the caret, instead of the note at the caret position.

STEAM-8461 Note input It is now possible to use R to repeat an implicit rest to the left of the caret.

STEAM-8468 Note input It is now possible to delete tuplets with a 1:1 ratio that have lyrics on the notes within
the tuplet.

STEAM-8477 Note input Rests, like notes, are now selected after they have been created during note input.

STEAM-8582 Note input Selgctln_g mul_tlple notes of the same pitch on instruments held by dlfferent players and
adding ties with T now works correctly, even for notes of the same pitch.
) : Pasting music from a multi-staff instrument where some notes have been crossed to
STEAM-8621 POtz L another staff to a single-staff instrument now resets back to the original staff.
STEAM-8750 Note input When the caret is positioned between grid positions, moving it left no longer incorrectly
moves the caret to the start of the bar.

STEAM-8808 Note input Moving the caret up or down _betwee_n_ staves belonging to different instruments held by
the same player could sometimes fail; this has now been resolved.

STEAM-8860 Note input Cop_ylng and pasting a local time or key signature to another staff at the same rhythmic
position no longer incorrectly links them together.

STEAM-8861 Note input Using Force Duration to set the duration of implicit rests on multiple staves now works
correctly.

STEAM-8425 Noteheads thkmg Revert to Factory in the notehead set editor for a notehead set no longer
incorrectly also reverts changes made to the notehead types referenced by the set.
Under some circumstances, dotted chords in opposing voices would be positioned

STEAM-6650 Notes further apart than necessary when accidentals are present; this has now been

resolved.
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ID # Component Issue

STEAM-8469 Octave lines  The illustrations and labels for octave line continuation options on the Octave Lines
page of Engraving Options have been clarified.

STEAM-8454 Page layout Closely-posmoned text events in galley view no longer sometimes cause items like
dynamics to move further away from the staff.

STEAM-8462 Page layout Adding a key signhature in a fI(_)w containing explicit system breaks now correctly causes
all systems to be cast off again.

STEAM-8504 Page layout Under some circumstances, moving unrelategl |t9ms (e.g. arpeggio signs) could cause
dynamics to move further away from the staff; this has now been resolved.
_ Under some circumstances involving instrument changes, allowing empty staves to be
SEAHIEAS Page layout hidden could cause all staves in a system to be hidden; this has now been resolved.
STEAM-8539 Page layout Changing the staff size at a system break at the start of the flow now correctly causes
all systems to be cast off again.

STEAM-8683 Page layout Staves. containing bar repeat or slash regions, or.corr.]ple.t.ely empty staves with bar
rests hidden, are now adjusted correctly during vertical justification.

STEAM-8686 Page layout _It iS no longer incorrectly possible to remove all of the staves belonging to an
instrument.
When two projects are open with multiple windows open for each, opening the master

STEAM-8749 Page layout page editor in Engrave mode no longer sometimes opens it in the wrong project
window.

STEAM-8571 T, Slash mstruments in percussion kits now correctly use slash noteheads after importing
them from a library file.

STEAM-8777 Percussion The plgyback playing technique for_ th_e choser! perCL_lssion playing te_chnique is no
longer incorrectly removed from the list in the Edit Playing Technique dialog.

STEAM-8560 Performande The speed of editing in galley view for large projects with many cues has been
improved.

STEAM-8851 Performance  The performance of Duplicate Flow has been improved.

STEAM-8872 Perrmance The p_erformance of inputting music in a part that is used as a cue earlier in the flow has
been improved.

STEAM-8873 Performance The perform_a_nqe of inputting music in scores with divisi where a fermata is used
following a divisi change has been improved.

STEAM-8457 Piano pedaling P'edal _Ilnes no longer t_)ecome misaligned after an ossia or extra staff is added to the
piano instrument to which they are attached.

STEAM-8435 Play mode The e button that shows whether a VST plug-in window is open is now correctly
updated when changing playback template.

STEAM-8629 Play mode A tempq marklngs now correctly ignore any tempo changes added in the Timing
automation lane in Play mode.

STEAM-8633 Play mode Tempo changes that reset to an earlier tempo now appear correctly in the Timing

automation lane in Play mode.
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ID # Component Issue
STEAM-8701 Play mode A prqblem whereby changmg .the audio device in Edit » Device Setup could
intermittently cause no audio device to be mapped has been resolved (Mac only).
STEAM-8724 Play mode Changing the VST |nstrument, MIQI device or MIDI channel of an mstrument in Play
mode no longer causes the view to jump back to the top of the track list.
STEAM-8850 Playback A hairpin on a grace note will no longer result in the following note becoming silent.
Playing Creating a new glyph-based playing technique with differing above/below appearances
STEAM-8494 . 2 .
techniques based on an existing one now correctly makes the below appearances independent.
STEAM-8599 Print mode Instead of printing in solid black, when printing or exporting graphics in monochrome,
watermarks are now excluded.
STEAM-8458 Project files Opening project files that contain a lot of MIDI controller and other automation data is
now considerably faster.
STEAM-8396 Properties Edit » Propagate Properties now propagates the placement properties for dynamics.
Rhythm Under some circumstances, shortening a rhythm slash region might leave it in a state
STEAM-8611 . . . - . : L
slashes in which its length will become incorrect after further edits; this is now resolved.
Rhythm Moving or changing the duration of a slash region with an overridden staff position
STEAM-8648 i I
slashes could cause the slashes to change position unexpectedly; this is now resolved.
STEAM-5759 Selections Extending a_selectlon with Shift+click no longer sometimes moves the view to the start
of the selection.
Selecting the contents of a bar including a system-attached item such as a tempo or
STEAM-8430 Selections chord symbol and then using Shift+click to extend the selection now works as
expected.
STEAM-8464 Selections U;lng S_hlft)_rc_llck to extend the selection now works as expected if the selection begins
with an implicit rest.
STEAM-8531 Setup mode Dorico no longer c_rashes _when you detqch and then attempt to re-attach a player to a
layout whose music contains a slash region.
STEAM-8532 Slurs In the unlikely event tha§ a project contains slur_s wnh negative durgtlons, thesz_a are now
leaned up when the project is loaded, and Dorico will not hang trying to open it.
STEAM-5548 Tempo When a gr'_oldual tempo item crosses a system break and the top visible _staff in the
system is different following the break, the tempo now appears correctly as it should.
Under some circumstances, a gradual tempo item would not appear if it ended at the
STEAM-6547 Tempo same rhythmic position as another system item, like a chord symbol; this is now
resolved.
STEAM-8498 Tempo Under some circumstances, changing the Ilne_style of a gradual tempo marking could
cause it to move further away from the staff; this has now been resolved.
STEAM-8653 Tempo Under some cwcymstancgs, a tempo marking |mmed|atgly' preceding a rehearsal mark
could cause vertical spacing to change unexpectedly; this is now resolved.
STEAM-8387 Text Italic fonts are no longer clipped at the left-hand edge of a text frame, and optical

overshoots are no longer clipped at the top edge of a text frame.
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ID # Component Issue
STEAM-8395 Text Baseline shift now scales correctly as the font size of a paragraph style is changed.
STEAM-8480 Text Changing the V\{eight or italic/Roman style of a font used by a paragraph style now
correctly immediately updates the score.
Time The positioning of time signatures shown outside the staff at system object positions
STEAM-8565 . . : . -
signatures relative to different types of barline has been improved.
Time Adjusting staff spacing now correctly adjusts the vertical position of large time
STEAM-8698 . . ?
signatures signatures centered on instrument brackets.
STEAM-8414 User interface Creating a new window from a project window that has the tab bar hidden now works
correctly.
STEAM-8493 User interface Window » Counterpart Layout. has been |mprovgd SO thqt it can be used from
Engrave mode, though the selection cannot necessarily be retained.
STEAM-8534 User interface Opening a new prolgct cpuld undgr some circumstances switch the layout shown in an
already-open project's window; this has now been resolved.
STEAM-8567 User interface Opgning the same file repeatedly from a network Iocatipn will no longer cause other
projects to be removed from the list of recent projects (Windows only).
STEAM-8593 User interface Switching between Write gnd E_ngrave modes with multiple tabs open now correctly
sets all tabs to the appropriate view type for the current mode.
STEAM-8601 User interface The appearance and position of the Cancel button in progress dialogs has been
improved.
STEAM-8615 User interface The list of open prOJec_:t windows at the bottom of the Window menu now always lists
the correct number of items.
When switching between page and galley view, Dorico now uses the bar in the middle
STEAM-8755 User interface  of the view to set the position in the new view, rather than returning to the start of the
layout.
STEAM-8868 User interface New project windows created by right-clicking a tab and choosing Move Tab to New

Window are now created at the correct default size.
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2018 £ 9 A 14 H

CDN—230DFERFAHDEBEEZUTICERHLET,

ID # Component Issue

AD-355 Audio engine A pr_obl_em whereby the length of the first note in the flow could be truncated in exported
audio files has been resolved.

AD-356 Audio engine Un_der some circumstances, Dorico could crash when waking the computer from sleep.
This problem has now been resolved (Mac only).
Exporting audio would hang or export an empty file if the name of the flow to be

STEAM-8538 Audio export  exported ended in a trailing space or multiple full stops; this has now been fixed
(Windows only).

STEAM-8454 Dynamics Edlt_lng unrelated items no longer sometimes causes dynamics to move incorrectly
vertically in galley view.

STEAM-8223 Key signatures Key signatures for transposing instruments in divisi staves now appear correctly.

STEAM-8479 Key signatures Key signatures created using a custom tonality system no longer sometimes reference
the wrong system of accidentals and set of octave divisions.

STEAM-8502 LoraTatioy When running Dorico ina language where comma is used as the decimal separator,
spin boxes that use decimal values now work correctly.

STEAM-8455 Mixer Outputs f_or plu.g-lps a_dded in the VST Instruments panel in Play mode now appear
correctly in Dorico’s Mixer once more.

STEAM-8516 Percussion _Percussion playing _techniques now play back _corr_ectly in the event thaF one or more
instruments in the kit cannot be mapped to entries in the chosen percussion map.

STEAM-8398 PeraiiiE fDailteetrmg notes at the end of a flow that has explicit bar rests near the start is now much

STEAM:8417 ST Inputting notes in scores with Igrge num_bers of players is now much faster, at the
expense of reducing the automatic balancing of bars per system at the end of the flow.

STEAM-8447 Performance Shoyv_mg the system track in galley view no longer causes editing and redraw to be
significantly slower.

STEAM-8458 Performance gg;aerllng project files with many MIDI controller automation events is now significantly

STEAM-8418 Play mode Dorico no longer crashes if you do Play » Reset Playback Overrides with items other
than notes selected.

STEAM-8435 Play mode The e button that shows whether a VST plug-in window is open now always correctly
reflects the current state.

STEAM-8432 Play mode Exporting a PDF of a 2-up document using a non-European page size now produces a

PDF of the correct dimensions.

Dorico 2 /N\—2av R

65 R—T

Steinberg Media Technologies GmbH



@ steinberg

ID # Component Issue

Under rare circumstances in projects with divisi and local time signatures, Dorico could

STEAM-8429 Project files hang when attempting to re-open an existing project; this has now been resolved.

Under rare circumstances, Dorico could crash when attempting to save a project. This

STEAM-8475 Project files
problem has now been resolved.

Dorico no longer crashes if you type a character not included in any of the rhythmic feel

STEAM-8419 Rhythmic feel names into the filter control in the Edit Rhythmic Feel dialog.

Under some circumstances, moving a text item on one staff could cause a text item on

STEAM-8423 Text another staff to move unexpectedly. This problem has now been resolved.
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SDN=Ua0 DHFHEE WERBLVBRREADHEEZUTICRELES,

A9 T BE

Dorico 2 [ZR1> T BEMEEEYR—NELIZ, TOC VM ERIZHTET I+
IWEDR D4 TINF—2 DERTER, BEDEEDFRETDRIVAVT DFEREDER
EAHBAET (RRL—hERDAVT DY BZBITHAET ), Tz, BHGDHTL—
NI EFICENTNELGDIR V(T I\ Z—VHEETEET,

Anders Friberg &1 Andreas Sundstrom DEEICKSD, RI4 T HNI21—D
DA UICKYERIZEDKSITERTINSMNCETHEMAEICEDE, Dorico D
RIL G NE—V [ FTURICKYEELET BT URTIERD10 T & KYTAR
L. BOTURICEDIFERN —MTALGYET , TRTOTURTRERCLEIZKS
BRETEIRVAVTDITA—ILERABIN . AV FTILDRIDAV T INF—V%TFE
&TEFET,

TOSTOREED AV TEE: R 0407 %TA0c IR TERIZT HICIE.

TB&E (Play)l »IBEA T3> (Playback Options)1Z#BAWLWTIZA43IV Y

(TiIMiNg)IR—C%EERLET  [TI4ILEDY) X2vHF4—)IL (Default rhythmic

feel ) IAZA—DSEBEDR V40T IN3—VFERLET,

m 211 R (—5E) (2:1 swing (fixed)) - 3 ERHsUF ELEEN. 8 &
BERORTD 1 DHDEME 2 DOOBFOEORIICSIFEEL., BEL
2.1 DLLED 3 EFERBELET, COLRETURICEAINTHEFIIE
E

» 31 X425 (—5E) (3:1 swing (fixed)) - 8 HBEFDRTD 1 DHDEHF
2 DODEHRD 3 EORSITFIFERLL. FR 8 EFE 16 P EFD
EEFRBLET , COLEFITURICEEINTHIFINET,

m FWVRY12J (Heavy swing) - TURIZHWR DT DLLEMN BT
RT 3.5:1 Mo EWTFURT 1.5:1 FTOHETEELET,

» BUL\RDs25 (Light swing) = TURIZHWR D42 DLEEMN, EVTUR
T 1.51 55 EWNTFURT 1.1 (RL—F) ETOEBTEHLET,

n SFUTLRD4VYT (Medium swing) - TURIZHWNARDA T DELED, E
WFURT 251 Mo, ENTFURT 1.1 (RL—h) ETOHEETEHLET,

» ZhL—k (R4S L) (Straight (no swing)) - IRTHTURTEER 1:1
DA—T i 8 P ERERBELET,
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TJA—DEHR TRV EEET S AP IFDFEDTH R TR I42T 1358—
DEEBRYBICE RV TNE—VERRTHMEDERF. KFEITZTOMD
TATLEEZRLTHS, [Shift]+H[T] WL TTURDRYTA—N—&HEET,
ERT IRV T INE—VDRBRDRDDXFEANLET F-£ZETmed IEA
NTBEEZTATLRIAVTPREYAMIKRIREINET, TRAF—ZEMALT
EIRL. [Return] ZHLTHELET . HROKEROERICHAEARTEN,
RIYIIT4—ILDRRTERTEINET,

ToHUTNED 1 To—NY—HERTEIRI4T 13—V BB BITIE.
FIRREGIERDER . ARFFFZTOMDTATLERIRT D, FrL b
ZEEL. [Shift]+[T] ORYTA—N—%BHNTFRENF—TR 10T 18— %
BIRLFET , ZEZIT, [Alt]+[Return] ZRLTRYTA—N\—ZHEESE DI L. ER
LIzt RICHARARTREIN, VURIVI I — LD BRI ERTINET,

YRSV T4—ILDEBIFT/PDEDERIBMLENSLNNREFRELLUV =0, MEID
BHRTYRIVIT4—ILVEEBLIZER . TONENEN DD L RO /N DBASALL
ENBISRYFET,

RILTING—2 DEBRZHIBRT BIZIE, BICERATEHIREERLT [Delete]
EFRLET  URZIVI T~ IILDAARERTELITERTTDICIE. TE2L—
(View)] » THAK (Signposts)l » T X3v9I74—)L (Rhythmic Feel) ] TEiR
TEET,

RILDGINE— Ve mET D TIHIVNDRAIAV T ING—VERET B, Tzl
FVCFINDR I T INE—%RET BHICIE. TBE (Play)l » TBEFTay
(Playback Options) ] TI2434 (Timing)IR—Y#E. TYWX3IvHIo4—)L
(Rhythmic Feel) 1o arDIRE (Edit)1R2E29)v oL T XIvHI74—)L
Z#mE (Edit Rhythmic Feel)I# 4705 %#RAEET,

@

Name: | Medium swing

2:1 swing (fixed)

3:1 swing (fixed) Depends on tempo
Heavysuing Lowtempo [100 [ o 251, T1%
Light swing =
PR Hightempo (200 [ m 1.0:1, 50%
Straight (no swing)
’ New l | New from Selection ]
’ Save as Default ]
o]
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TOCIIMIBREINTWD YRSV T —LIEERIDYRNMIRREINET . T
AIWDYXZIY D T4—IVEFRITIERLT HIZE. THR (New)1Z DV ILET,
BAERLTNDYXZIVIT4—ILDAE—ZEER T BIZ(E. LRIRB S DS HIRE
X (New from Selection)1&#9vILET , BEBIRSN TSI XZIVIT4—)L
ZA1—H—F1T3)—IZRELT. ChUBITERT 2T RTOFRIADLIMT
FIATERESZTBICIE. TFI4ILFELTREE (Save as Default) 122 voLE
ED

FAT7ATDEBICIE. RI4TNI—2FFET HI-HOBEZIFO—)LA

WO BYET,

» [FURIZEKTEE (Depends on tempo)lld, R4 T IRE8—0NFRTOHOT R
TEICRCLEEZFRATEINEINEZRELET . ATDEEL. BLVTUR
(Low tempo)l&lELVTFUAR (High tempo)i®arkO—)LAESHELY . R
AT DEEEQRSAT—H 1 REFRRSNET,

= ELVFUR (Low tempo)ll (1 #REISESRIND 4 REFOET) TUR
ZHRETDE. TNUTOTURTEABRDRSAE—TEET HRV10T DL
BENMERASNET,

m [EULFUR (High tempo)lISTUREEE T HE. TNULEDTURTIEGE
DAFAFT—TEET DRAV4V T DELENMERINFET,

n AOAVTDHEORASAE—(F, 1:1 (RFL—F) M5 5:1 (1 2HD 8 HEH
N 6 EFD 5 DRDRIELD.2 2HD 8 NEMIEY 1 DHDORIL
B3) ECHEMATHRETE, LFEE AV T DIN—E UM KBEEDTEA
ZRRLET,

[T 2RICHTE (Depends on tempo) 1WA D EEIE,. TBLWTFUR (Low
tempo) IITHE SN B TURUTICEWTIXZIITHEESNERD 40T D EEMN
FRINET, ZIHLTURMEMT SE, [FEULVTFUR (High tempo)lITIEES
NBETURICET HFET. ZIITHESNDRAV42 T DLEIZAMN>T Dorico A
A1 TEDHEZETEVET . [TURITERE (Depends on tempo)1AF 7D
LEE. L RORSAFT—THESNDIRAVAVT DLENTRTOTURTHERS
nFEJ,

HBERELT14—

[#%& (Engrave)l » TFFEEEXTE (Notehead Sets)I|¥ A 7RI M#FHf=ITEMEN.,
NEBDMFEREICEREMATHICHILOREEERTEDLSIHYEL=,
FEEREE. BEELHIHEE 1 DIFEH=LDTY  ALHBETHEHRDFIESR
ETHEATESO. L DOMFERECHELZRELIGEE. TOFEEERTS
FTRTOFEREISHLEENERASNDZEITEREL TS,
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BEOHBERTICITREDLED 4 DOFEARTEINTVET 4 HEHL
TOTaAL—2avDEFICERTIEENDHE.2 #EFICHERATIAEDFE.
EERIERTIREVAENDEN. FLEFICERAT S @AIC 1 Ah 2 K
DEVRBEN R VIREVAEDORE, F-EOAVAREOFREI HYET,

Dorico A Y HR—bFHRBEREFINLUNC 2 BHYET . BEROBTRICHK-ST
BRULE-BRANELRTBIEVFIE. BEDORBICHTIEMDOBTEICH > TER
LI-BRAELET S EEITT EVFORBERETRL—MBNELDIE. TEYF
L #F5E (Pitch name noteheads)IDFFEEFRE T, CNIEFEBFFD/—FEETIL
7Y T (BEHESHMMIUGERZEAIEDHT) EROBKOFIZRRITLHLD

TY . BEDOFEREICIE. =2 YRN—THRIEOL 4T /— RIBIZERSH
BT Aikin 7 O (Aikin 7-shape)IZENBYES .

BEDEHEOMERE (BE. . EvF. FEEE) IZE. RALEEOFELIE
RATEER A, EAL EVFOFEREDRITIREDFBELERATELGL O,

BFOMESREF - IBRFOMEOBBTEATIERETEEE A,

[%%& (Engrave)] » TFFEEERTE (Notehead Sets)|# 4704 3 DOIY7IC
FITFBENTLET,

L] Edit Notehead Sets

Notehead Set Category:
Notehead Set

Common v
Name: Larger Noteheads

Circled Noteheads Category. | Common v | Type Defaultnotehead: | noteheadslackOversized v |

Default Noteheads
Large Circled Noteheads
Larger Noteheads

Stashed Neteheads (Bottom Left to Top Right)
Slashed Neoteheads (Top Left to Bottem Right)

& c}ﬁ H}E—

Notehead

Name: | noteheadBlackOversized

Duration: | 1/ nate v

| New | | Mew from Selection I Use for durations shorter than and equal
- e [Z] Use for durations longer than and equal | Double Whole Note
Save as Default ‘

New Natahead | New from Soloction | Edit Note|

,‘7 Cancel n

EAITIE. BEZTEOATI)—EEIRLET , CCOATIV—IEEE (Edit))>
[%EE (Notehead)lHTA=—a—DAHBITHIELET . TNETND Y ITAZ2—IZE
DFBERTEERTTINEEETBHICIE. ERIDURID S FEEREEZRLTH
5. A LDOIFHEERE (Notehead Set) |0 avIz#HBIhTT1)— (Category)l
FOYTZOUYRMTATI—%EELET,

ERIDYACDTICIE, FEEEDIERRI LHIBRRIVAHYET,

w TER (New)J(&. T—#& (Common)|ATI)—ITEEL(TDEBDFFEE

EEERLET,
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n LRSS HSPHIBIERR (New from Selection) (. IRAEEIRLTLNSFFEEER
ELRILAATTRILATIV—IZBT 2aE—4 R LET . FILLEREICEEN
SR ZTDHELLGS-BRELRLTHAZEICTEEIZEN, FIRBEIZE
FNOFMBLITICEREMALEEE. BFOREICEEFNIFMEELEICLT
M- ICREREER T H&IITLTEELY,

» [FIHILFELTRTE (Save as Default) (. BIRLE-HFEREEL—HF—54
T5)—IZREL. CNLURBEICERT 5T R TOFRITAD I THATES LS
[TLFET,

s THEEOBTEICRET (Revert to Factory)lld. RED FERTEICHLTOH
BRELGYET . NBORBEREICASMIDERLMA T ZHE. ThiTkY
TIHILEDIRENETENET,

n THIR (Delete)lld. RETOS /DB HICFERSATIVAIMEAIZERY.
HRELOFEBREZHIBRTEET . NBDFEREIFBIBRTEEE A

A LDIFEERTE (Notehead Set) |tV 3Vl BREDEYMIREINTLD
mENRRENFET A EV)vIL T BEDIMNBFEDOFELEBMLES . B
EDEILERLAATDTRTOFED) AN A= 2 —([CRFTINFET, BED L
YN RIEBZRIFRT BHIZIE, Z9)vILET, CNIEZOFENTOD I
THEASA TV EWMEEDAEDIGYET  COFBERENRTENDSGHTI)—
ZIEE T BICIE, THhTT)— (Category) IV R SEENDIERF#ERLET [T
74ILEDFFEE (Default notehead)lld. EFDERICERTHFELEVFAIC
RELGWMES . EOFBEEZERTINEEELEY (EAR. 2FFRLVRVE
RIS LB ST 2L —2av DR ENEYERIZERIN TGS, TI4/LE
DFBELNDOYICHERINED),

FMEREDIZL4T (Type)lFEBETEF A EVFFLIIBTEIZKDFENRTES
T 556 BEOFERENEEDI(TDLOEZIRLTHLHEIRES
MoFHRVER (New from Selection)1ZERAL T, ERICEDHRFEERELE
BLET,

ETOIFHEE (Notehead)l v avidk. G LDOTFFEERTE (Notehead Set)lt¥

a0 yRarbA— LV CERFPOFEDTONTAERTLET . TNEILD

FEICHL, UTOTONRT12RETEET,

» AR (Name): EEHDTJyRabOA—ILOTHa0IN—DAZ21—IZRTSN
HFEDABRITY

m Fal—>3ay (Duration): TDMEEHEATHT1L—a0 T, FEDH
BOXBRIBEWNT. 4 PBFEETNUTOT2L—23V OB FICIERCATEE
AEREINET, COBETOHEICIE. T1/4 B (14 note) IZBIRLTH S,
TOIZNUTDTaL—avIZfER (Use for durations shorter than and

equal) JZERELFY
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[ChEUTFTOTFaL—>avIZfifA (Use for durations shorter than and
equal)lZF4Izd 5L, EDOIFaL—3> (Duration)l THEELfzTaL—Y
AVEFTIEAEL TREYEVNEFICHLTECOFENMERASINET,
rChlEOTFaL—2avIZERA (Use for durations longer than and
equal)|EA I 3L, EDTFaL—a> (Duration) ] THEEL=TaL—33
VEFTREL ERIYRVDEFISHLTECORENMERSNET,
IFFEDOAR (Stem direction)I Tl FEA LMZEDEFEIETREZOE
FICHLTOAZDOFENERAINDISBETEET, (AL (T /—k
DEZRDGE . FEN LRAZFETREDEFICTENT, FEO=ARIIHF
BLFFHEDARIZAEFET,)

&2 & (Double whole note)JTl&. CDFFEEAE B LMK (Round) FE /-
ETEA (Square)INDELLTHIMNEFIBETEET , CnIckY. IIFELF T3
> (Engraving Options)IOTEH (Notes) IR—CDIMELEFRF (TL—) @
FEED S8 (Appearance of double whole note (breve) notehead) (<. [,
(Round) JE71=I1XTHEA (Square) IR ELLMNBEINTLEIMZHELTRERS
NAFRBENREINET,

rTEvyF (Pitch)l] ((EvFI2(TOREDH) X, COFELZHERTEIEFD/
—h B LR AL S ZHEELE Y .

[ZREE (Degree)] ((BEIZATOFEDH) L. COFRELXFEATLIENDOE
E @1 »b 7 OBH) #HRELET.

[FFERE (Notehead)l /S av D TEDT I3V N—IZIELUT ORIV HY F
ER

FFFHADFFEE (New Notehead)lld. TIAI LD EFEDFEICEIMZE
(Normal) 134 T DFRFBEEERLET .

BIREBOMOHMER (New from Selection) 1lF. EDTHFERTE
(Notehead Set)|to>ar D) yRavbO— )L TEIRLE-FEERLAITE
NEEDORFBEEIHRIERLES,

[FFEEZ#EEE (Edit Notehead)ll&. FFEEZDEHDDNEREE R CEHMBEI T«
B—HRAEFET LTESRLTIZEL,

[FO4ILELTERAE (Save as Default)lld. BIRLF-FEEL—HF—514TS
J—IZRFEL. SNURBRICERT 2T R TOFR IO/ THERATESLSIC
LFET,

MEABEDEREICEY (Revert to Factory)]ld. REDOFIEICKHLTDOAER
ERYVET ABDFEIAIGMDEEREEMA T HEIE, ChIZKYTIHIL
FOKREDETINET
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[FFEEZ#RE (Edit Notehead) &9 v I3 BEMEBEITA2—MBEEET,

% Ecit Notebwad

m Text  Graphic  Composite

OOl
» "]
J : D =
|*J : ["‘7
K g / L LS ) = o o L
1% e
O—=C0—— | ! | | !
¢ ” = >
x ® 4 < ©
Joom: Select | Previouy Next Delete Selecied $
+ e L] [ E]
Compoment m )
- <l © © < )
A o) S
€ w A a A
ASS Ghyph
[ e | IS

EEARIT. SFETFELIMTOEROHANSHED T FAUITEMT 51D %EEIR
LFET.

12 (Glyph)ITlE. AVE1—3—ICAVAR—ILENTWDTRTHD I+
MoXFEEMTEET, SMUFL #EHT 4+~ (Bravura 7E) #EIRLTLND
H&1E. T&FH (Range)l') AMZ SMUFL XFDHEEMNITRTRRTINDIDT,
XEMNRDITPFLE>TVET,

[T%ZF (Text)ITI&. %#E (Engrave)] » I+ kX4 A )L (Font Styles)]
[CERSNTWSITAVIRAMIVEFERLT. 1 DUEDOXFEZEMTEET,
NERBIHERATIILEWHmTT L, BIRELLTARHESNTLET,
[4524v% (Graphic)ITl&. PNG.JPG Ff=IE SVG BKXDTS571vo%E
MTEFET AVI—BATHY. EOV A XA TLERBE TR RTINS SVG D
FERZEHSTIOLET,

[#i#&hHHE (Composite)JTIX, FACIHMIT TIZEEZESNTWStDRES
ZEALTEMTEE T L BBRR TR I I714ALGETUEa—NEESh
TLWVEL =8, BB DAREIEELTVARENHYET,

EBMTEEREERLT. REDNRILTEIZHAMEBM (Add)IRZES)voT
BE. TARATUAIZERNEBMENET,

FEOTHAVIX KEAADER (CHIEFRENTRAZOEROFEDMEIC
HVFEY) 2RTOLKROOHD T JYMRICEmMNEBINEN . EEFRDERER
(CNIFERBRLEOFEICHTIERBROMEIZH-YET) 2RI DPLRODIE
DTV IFRIZHPRNEISN ST TRELET
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FENLMEZOEFROFEOLA. BLUHENTREZOEFOFEDLAIC.
FENETHAEMGMNEZIEETEEY .. T . FEZDEIL-AILE—F21 VY
[CRENEAINDGE. ERICHOICETIREDODEMDTAYF AR
AUNLIRETCEET . FRDT AV FAUNRA U EBIMEIXHIBRT B2, #7586
DA TARTLADTIZHDTHRE (Stem)IREALEL YV ILET . HEDTAY
FAUNMIETHEMIE. LTDY V&Y SMUFL OiE#kiEHREZEIZELY,

https://w3c.qgithub.io/smufl/gitbook/specification/glyphswithanchors.html
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F—ForWEHL

B20O70—DHRDA—TAAT7AIN~DEEHEL. BLVEL2DTL—Y—0
AMRDA—TA4AITFANANDEZTHLETERDEISITHYFEL, F-. &T70—
DA—TAFITFANERNRDIAINA —IZEEH T ENTEET, ChIZkY. S5
BAIXFVUTOTRR) T HTEST=01Z, Cubase LZFDHD DAW [ZKSy
J7UoRRAY T4 50ICELIZ-IFRIOTIVRAR—IDARBECHEICITHERET,

FREFECS

EREFEE DAV T D=HDOUYIRE: TBRFEEEZHE (Edit Accidental)1¥
A7OJT.RBED 4 BENTNDOYYIRENRETELLIITHYEL Iz, ThiIC
KU BETIINDBRBELEDIVF T OI— T2 EDKSIZTHESIE
Dorico [CHERTEET,

~ Lot acccerts)

propy
o | IER

ERRFEL B DUIVIREZRMET HICIE. F47AT TEDOMYIYIRE (Cut-outs) 12T
) OLT. RRELGHAIDAEDIER (Create) |TRAVED)vILTHL., D
RENFREORNBOADNIRILEI)IILT OYIRED YA RXEEELET . U]
DIREZHIBRT BICF. HRELGLHADADIEIR (Delete) IR22 &) vILE
ED

PIYIREICEET HEEMIE. LT DY I &Y SMUFL DE#kiERESEIZELY,

https://w3c.github.io/smufl/gitbook/specification/bbox-cut-outs.html
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BERFEC S LMNER: MIROERIZERRFRE S AMH<EE . MROEAZERILGENELSIC
BETEDLSICHRYFELEZ. COBEEZEMNICTRHICE. TBREBF Ty
(Engraving Options) IO & (Notes) I R—U T, BB RSN MI<KETHFOMER
(Ledger lines on notes with accidentals) J1ZT M ZHEELALY (Do not
adjust ledger lines)IIZERELET , nIzkY. EREREESHH<KFEO LA NS
[THHSMEBDE (Ledger lines protrude left of notehead with accidental)]
[CHEESNEOIDOYIZ [FEIIEAHSIMBDE (Ledger lines protrude
beyond noteheads)ID{EL. MEEDTIAILEDRSELTHERASINET . xbA
[CHAIBBRSET IAILLOMBEDT I EDOERIT. FEA T3y
(Engraving Options) IO TEEREESE (Accidentals) I R—IIZ#ksnf-MEMEs
ATOWEWINROERICHSHE . BLEDERKESOARAEDOMMAE (Gap to
right of rightmost accidental, if to left of unshortened ledger line) 473>
[SEYRESNET,

HEEDE FICHEEREEDIYX Y &L T3> (Engraving Options)]
DOIEERFEES (Accidentals)IR—U DI (Gaps)ltoiavic [HEREDOEFFH
DERICHIBZE. RLEDBRBESOLABAEOREBE (Gap to right of
rightmost accidental, if to left of back note) JA 7 a> izl BMESNELT =,
BE HREDERIHLBETHL BRESEIREEORBDIEERTHEAMNFEN
FIM. COETHEEL-R/ERETIIRFSNET,

FURSARS

[% 847 a> (Engraving Options)IDIPILRIHEE (Arpeggio Signs)l
R=VIZ NRSYVAEFDTILROAEE (Arpeggio signs on slash voices) |
AT arh#hit-IcEBmshELIz, C2TIE ASYVaAMEBRRICTIALRCARE
ZRRG DNESHEHIELET , TIHILLTIE RSV aFEFHICKRTINDS
TIRCFRBIFFREICENTI N, REEFEE—FTHRETEET,

INETER

& ZE[E%EE: Dorico (X, ERLEDT7ATLDMNEZRTET I, EXRD L TFIZEEH
FTINETER (FEAFITRBAVRANYILAVRED 1 BEIZEITH/NER) ©ORE
EBDPR (RERSNBEEHE) ZRICERETHLILGYFELT,
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# - HDRE/NEER: Dorico 2.0 KYBASNIZFEERRIMILADYR—KIfE
LY, T &EAX T3> (Engraving Options) IOT/INE#R (Barlines) IR—C DIKR1E
(Repeats) 1tz 3>, THABRBRAIE D RERGER (Start repeat at start of
system)1A T arvhEtfzICBMEnELz, COATavicky, HAREABREE
DO REFBKRT, BRLEINFREVE—FDEDOEAERTT S0, JE—FD A
DHERTT DNEEIRTEET,

ZER BEBMCEVT 1 MEHIYRETEELDEMERYS=OIZFERS
hB=E%. [Shift]+[B] ORvTA——I=TtriplelbAAT BoETHRTES
FOITHEYFELS,

aO—kEES

[##E&4Fa> (Engraving Options)1DIa—REES (Chord Symbols) JIR—2
DIFIAL—3> (Alterations) [ 222 avI [FIWEL— 30X HERREET
B ODHIE (Position of accidental relative to alteration) 147 3> h#Hi=I2E
mEnELT=, Chl=&kY. Russell Garcia MEEIZLSHL1)—XThe Professional
Arranger Composer|[ZH#RINLHRECEITHIELZZITHEAFT , Garcia KIF3
—FRERDEFEEIUVTILAL—avIZENT KEARDAR—IAWNEHTE
HCLEEAIC. BRRESOMDYIIRAFTRETSRETEHEATHILEHELT
WET LI ODEESZEAYTSHHAE. FEICHLERE LIEFEDIEE TR R
F 5. DFEYN-9ITIEALTO- | ERTFTHENEETYT , YA FREEFIETIR
NEEEEDHIICRETHE. IL—V NS FRESERERALHELLZY. TR
RBEBET —F1AUMNFATREBLIZYTELGE . HOFENSELELTLFENET . £
DEHFHLWA T3V &Y BEICHLTHRBELEEETEDOHLICRTTHED
IBETEALIITHYEL,

*a1—

DALIZ&BFa—: VALIZKDFa1—ZERTBEE . A V54— THARSFIZF
—ZE TG AETHOTH. TIALANT A V2—T OBRIEF 1 —IRNILIZRTSE
NIENEIITHELOTVET,

TAT1T

HEBEDPDTAIT4PDIN)L: TLLPIRA T ay (Layout Options) DIEERE
#E% (Staves and Systems)JR—UIZ[ERD EIZTA IS DEBIRNIVERT
(Show divisi change labels above staves) 47 avh#izISBMESNEL -,
CDAT2avEaFUNTTHE ETAT4ODVI)RERFRIVaVAICERSN
RTINS ENENDTAT4DERDTA T4 PHBRMED LIZRREIN,
CNIZHIET DIV TADINILD, ENENDTATADERDT A T4 T L
BDLEICRTENET,

[&4 7 a> (Engraving Options)IDIF4 G4 (Divisi)IR—T DHLLA
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ToavIckY  MEF DT I EBRDIRNILICHL, EERINASDTIAILEDEE
HMEEETEET, FINIK BFEE—FTHRICHMEBEZARBLIZYRSYI L
YTEFET . Flz. TANRTANRRILDIT 4G22 (Divisi) 17 IL—TITFEESN 1=
[HRALTHRE (Custom text)IFTANTAIZ&Y, FEZEE—FTHEADT1I1>
ERDINILONBEE LEEZTEET,

FYLICDMEISTAT4CEERT S BERANDENRICTAI1ODEEE
R TEDRSITHBYELIZ, COEETA TPV DEEIL ERDBFIBALE TIF%S
FrLybDMEIZEREINET,

by TADHAR: Ta4T4DBBERT SEL2HICTh Y T4IZERS (Restore
Tutti) JZEATHLEEICRTINBIHARIE. T4TPEEDORAREGE X FIAD
LESIZTTutti]ETRNILAMFLKSIZIEY E LT,

T4ILE—
RSy A E BT A—EN TS TERE (Edit)] » TI4L8— (Filter)] »
&R (Voices)] » TFRTDRSYLa{FEEE (All Slash Voices)1%:&RT S
M YITAZ2—DIRIMDOHEEDFENALAEZ, FEATRE, £IEFELEL
DAFYLAMEFERIRT S EICKY RSV aEREIZTAILE—FENTS
nFEJ,

70—
70—%kK L [Shift]+[B] DRy TH—/"—[ZTtrimjEA DT BHIETT
(Write)] » Fo—%kJ L (Trim Flow)12E{TTE%9,

E

LAT Ik
TIHIEDIN— L AT o TASIIRDIN— L AT I bERH>THIBRLTLES
=B EICEA. TR’E (Setup)l » TTFIHILEDIS— AT E4ER (Create
Default Part Layouts) A< RAEzIZBMENEL, 7B—ZEDTL—V—
ETNENIZ 1 DDIN—FATINERETESD T, N— AT ILDTIHILE
DEyrERBCBERTEEY,

RUKF
BEEEDAtyk/\—: THEFTL 3> (Engraving Options) IOTAFF (Rests)]
R=UDIREKH (Multi-bar Rests) o avI(z, T2y b/S—DWE (H-bar
width)JA T av i git=lsBmEhEL -, [BEIE (Fixed width) ISR ESIT
WBIEE. AybA—k. RAFOBEAO/NEREIIEAT IO TIEEL M1ty
FX—DEEWE (Fixed H-bar width) IO EZFERALTERRTINET,
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REERTZAWVDIEZRD/NH: HRSNhTOWSEETEIREE. . E7/GEXRERE
AUWSERIZBITHRAFTO/NEHHIE 2 DOEKROBICRRINSZITTT A,
NJIIRDFEE Y IVITERSNS/N—ETIX. MADERD LIZ/ME#ZE
RERTDON—RITT, THEEAF 3> (Engraving Options) ] DMK FF
(Rests) IR—C DIRHHF (Multi-bar Rests) 1o av(cgskant-ITKEXRER
WD EEED/NEE (Bar count on grand staff instruments) 147 aviz&y, =
no 2 DOXRERAEFENSTOoNEHKIITHEYELT,

ltacet al fineJMLELVE: THEAFS 3> (Engraving Options) 1 DMK FF
(Rests) JIR—T(Z, IoA—D#HY(Ttacet al fine JZRTTIEAD /MK DR
/ME (Minimum number of bars’ rest at end of flow to show tacet al fine) |
FToavhF-ITEmMENEL =, TI4HIMER FRITOD VDB EE 4 b
gfi. Dorico 2.1 &YBWWAN—2avTERSN-TOD VDG E L S EREREF
FHEDIC 1 IMEMNRESNET . ChIZELY, 70— DYICEH TEIVENK
FLOVELIEE TH, Macet al finel# R RT HESICHEETEET .
ERRDTLRT AT L 2EREBEE—FOTURMS VI THRRENEDHE,
FEE—RCRTINBVTURTATLIZOVWTIE. RKRFZLEIT2EAERE
SNELKEYELT=,

MusicXML DFEHAH

TXRNTZATL: TIRIFETFE (Preferences) JD IMusicXML @ & & A &
(MusieXML Import) JR—DIZ, ITFHXRNFAT L (Text items) 1A T arh =
[CEMENFEL. CNIETIANRTEATICHE>TOWET AT B E,
MUSICXML 771 ILIZEENDTRTDTHFRNTZ AT LA [Shift]+[X] DTFRE
TATLELTHEARENET , CNSDTHFRANTATLIE, TURPEBRELRE
ELTERAREN MO TATLEEE T HAHENERICELHRYET,

ATV afFEE: Dorico &, FEREEREETEERDELLICIDONNTH,
MusicXML Z7AILHBRZYL ARFEEEIBER DY A fEFERZE L) ZHRAAH
HEIZHYELT=,

INEAYE —WESE: Dorico [ MusicXML Z7AI)Ls 1.2 XU 4 /INEID/INER
JE—FEEZRAADDEIIZHYELT -,

TED#EE: TBEATL 3> (Engraving Options)IDTERF (Notes)IR—T D
[{+ M (Rhythm Dots) 19> avIcH T mD#HE (Rhythm dot
consolidation) 1A 7> avh B En, BEN LAY PTALY, Fiz, HILTEE
BTOLIZJUICB T RDRWEIEET 54T avpBmanELr-,
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TROHEE. BEYESESITLOEENNEVMTRBRN—RKICERESN. A
DESIATLDBRIZENZENDOMRE 1 FIITRRTESKIRIZTDULT, Dorico
NINZEEDESITHESHERLET  CNICKYKFEARMDRAR—REREZEL
TEFEIHN REMICEELRAFENIRRALELLDEENHYET, Dorico [Z(E
TEDHEIZEALTUTO 3 DORENAEINTLET,

n [EE&LAELY (Do not consolidate) i, TR IXEIZENNET 2EFEIEH
BN CHBAIZRTREINEIEFEKRLET .

» [RICLREODEFH (Notes of the same duration)ITlE, RILKSEHFEDIHEIC
RY (Fz&AIXELLBMAR 4 FERDBZE, —AMNTR 8 #BERTEI—A
MR 4 REROBEEHTEFYFELA). BET LIS LOETFOMNAE
MELET,

s [EEDRSOEFR (Notes of any duration) | Tlx, FEEDHLP A EDH
B (FEAXLRZDEEHN 4 PERFRTTRZOEEHL 2 2EF) THEZE
METEFT . RULAV/N\IMIERENRBELET . RAFENVDEETNLE
CLEd,

CHNICMA . THITEIEBTOFRLI=Y> (Rhythm dots on unisons in
opposing voices) A7 avhiBmMEInEL . CNITKY, R T EHEEIZEIT
5TaLb—2a lEYFARL 2 DOEFICOVWT fFRE 1 DRERTHIN.F
&S 1 DY ORITRIAINEHEETEEY,

MFEDKFELME: TANTA/IRILDIEFERFHF (Notes and Rests)17 )L—7
[ZTfF/m X (Rhythm dot X)17A/NFAHFHzITEBMSN, FEE—FTHRADK
FHEZHREBETEHLIIHBYEL EHOEFLARLCLEICHFRET 5. O
TANTAIFRDTIIL—TL2EIERINSZLITEELTZEWL, ¥ IL—TIC
X 2 DULDOFEEHOoDERNEENDIEELHYET .

MEEZEIERTIZT S TONRTARILDIEHFEKRTEF (Notes and Rests) 14 IL—
TIZIm#EEERER (Hide stem)1FO/STFAABFH=ITEBMESNWEL, ZOTONRT
1EFBEE—RTOARTEIN, FUICTHEEFITHESITRTOMBELIERTRICE
YES,
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R—=SLAT7Ik

[N—FERXBREEZIE—T % (Propagate Part Formatting) 13 47045 h3$f=IZ
BmMEnFELz, CNICKY R—PBRABESLUVLAT I T avEaEl—xL
AT7ID5 1 DULEDEEDLATIMIOE—TEET, ZDFA/7OTEFUS
HTIZIE EEE—FDLATIRNRILHADLATOMEE D)9 $ D (ERLT:
LATORDRAE—TL AT O RELTGERSNIDIKETEA A 7RI HRETET) H.
BREA—1—HIOERLET . ROIIBFATOT HNRRINET,

L] Propegete Fat Formeting

(o] IED

ZEﬁ'JMB:II:"-in(?'?FEE?RM BRIOVRRAS 1 DULEDEED
LAT7IOREBIRLET . VRRDTD 2 DOFIRVIRIE. FAT7OTEHEE
LIzLEDRMEZERELET

n [LAFZIRATa EESHS (Include layout options) i, R—CH A XER
B, T4 EDIRE—R=DDtvh, fEDES. ERODAR—V T EF
DAR—=2 2T REHRTE. RKFOEE, ERIRNILDA T avigd | T ELG
LAT7 A TavEaE—TLAT IS EEDLATIMNIOE—T M ES
NEEELFET,

n [HHERDEAREZZHS (Include system formatting)Jl&, FEDLATD
FOEBMERICKR TS H/MERE LUV EIL—LICK TS S EHE. aE—xL
AT INMIEDEDINEINERRELET . ChEERITTHE BEICKELT. Th
TNOEEOLATIIDZHBEORIBMEIC, HERYIVELUTIL—LRKY]
YBMERENET . EEDLA TV EDOBFDOHEERTYEIVIL—LRYIY(E
FTARTHIBREINET , SHIT. BRODAR=S VT OEENIE—TLAT I
BFRTOLAFYMIAE—EhET (QE—%(LATIFDEEDZTHFDRR
— VT DERITTRTHIBRENET),
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AE—TLAT7 I rDHEBEORRABRENRIZRFEE. FETLLFIMEToay
(Layout Options)IDIEEEKE (Casting Off)JITKFLTLSISEE (X TLA7Y
rFarE&®H5 (Include layout options)1ZFERAI hIEL, BHEERICHERRY)
YOI —LRYYEERLECTEH, RLERFZEERCLAT I EONDT =0,
MEBRDOBKXBZETEZHS (Include system formatting) JA T avEERAT 51
BEEHYVFEE A,

BROEHRIV—LF—UEEATOEMB/ AL AT, [I—MERERE
#aE—9 % (Propagate Part Formatting) 1447045 ®aE—xL A7 OrET-
FEEDLATIRELTELTULVER A, Dorico (&, AIREGEBE T, aE—xL A
TIORBEUVEEDLATILDOMAIZHITEHEMIL—LDTSAI)F—DE
EREETLEVETN, AE—TLATIMEEDLATIFDERENKELELD
56, FERGIRBRLLGDIGENHYET . FIC. FETFTITEbIh=~—
URED LEXFOE—SINFELEA,

LOLZLD Y —RATIE, 773 —F=IEEI230D 1 DHDAURRYILAED
LAF7IbEFzyvoLThL, TIR— X EZEIE—T S (Propagate Part
Formatting) 1ZE AL TEYDLAT7INMIEBEZZRRBGERTH2ET. /U ARy
IWAVEIR—FORLXRENTOLRICET HEMEXKIBICHBETEZET,

B4

INYITFIVRTDYDUREDFHEHAH: Dorico [, A—HF—(23—Tx—R%E=
IESEBIELL, /3999590 RT HALion Sonic SE [TH U REHRAADD LS
[TEYFELTz, CNITEY ., ZLDOBEXTRONITEAFET . LA E FHR TS
IhERIBL CIL—V—Z BT B5E. R IL—V—ZhTNITRELGY OV
RFIENYI TSIV RTHRAREN, A—FBNETTIETHF O LD TL—
—ZBIMTES-0. BIEICHI DA KRIBICERBINET, £ BFEOTED
IVMERKIEE . TRTOYVURDREARENDIDEFOILLL ANPHEESE
BB ICITRAE T, TADIIMNEUYBZBI5EL. YOURN NI T 5O R TR
HRAENZEZH.FLLWITODIIFTOANPHREZANHICTHEAET,

INFYE—FESDBE: ME—FESABBHICHBESNSRIICHRYELT,
INERJE—MEEOERIZHS 1 /& (1 PMEIDVE—FESDIHE) F-IFEHK
INER (2 INEREFIE 4 NEIDYE—REESDIHE) AL NEUE—MEEDT 2L
—2avIZEHETHEESNET, Dorico (X, HED/NNDRIFES (ERYIRS
3N E— MR SRR SN SR B RS TR NET,
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ERBEDRAML AT LDOEAL: Dorico 2.1 (£, Dorico 2.0 KYUEEBRINE=HIETD
FREFEL S DBEEMEEZREIE . 12-EDO 4> 24-EDO [TEFELHWVHLOW LM
AT LIZB AR BEDBEETLITYR—KLET, Dorico &, HALion 773
J—DIN—F ¥ LA AR ILAVE (/AU FR)LAR HALion Sonic SE 3 &%) (X
VST3 /—hIHORTLyiavEw . DDAV ARy)LAV L (NotePerformer &
) IZIE VST2.X TA4Fa2—N\TA—43—%¢FRALT. BRI BB EE > TR
EINTVAINESHICEOLLT . TRTOEFICEULBEYFTILIZEHLET,
Zhizhz . TBEATL3> (Playback Options)lIc#&xenf-IFa—=2%
(Tuning)IR—IIZEWT. BEBOREEYF (TI4/LME 440Hz) ZHEETSE
B&IITHEYFELT =,

JL—XELTDOEFERIT®REEEES: Dorico (&, imiEd 5B D EH RO &S H5E
PFRESZIL—XELTORBES LML, FilT TRECERLFNDKLTLLDT
[F7<. B BERISRTEEL BTN TN DOFRIRGIE T, BRERBLANILIZYEINFET,

ATLAHADREIR: THRE (Edit)] » TT/NLRERE (Device Setup)lF/47H
FIZTRTLAH A (Stereo Output)JarkO—/LAFT=IZEMEH, Dorico HE
EICERT A —TAA A= —RDORTERIRTEEH LSV FELT=,

App Nap: App Nap [& macOS DEIEREET. /\vI T IIURIZBITLIEZT T
r—ar@7F oty ERAKRE BBMNICHIHLCEAERZAEIBLET . i
KUY BERICZ Dorico BN/\vOT T HURIZBITLIZEEIZ. BELNRYINEY., T
ITFEUELTLESYTHIENHYFELT-, Dorico (45 macOS IZxiL. BE
IE App Nap ZERASEGENELSITESTEEY. Dorico A/ NI T 50 RIZHT
LTEEAEZHITFONGONESICLETS,

BEE—F

REDERT: FMSYIDERKE.L—OEEY (X, §F—bA—avL—VIC

BEINTLVS MIDI OV bA—5—LEDFBRINTRTRES LV ETINDLD
[CRYFELIZ, SHICEY . BEE—FHOSHDOE—FICUVEZ. BUBEE—FIC
ROTH. CNbDEENT A TRESNET,

Bty THE (Play)l » ThS99 (Tracks) YT AZa—A#FESIh,. BE
E—FORVDTL—Y—b,SVIDLICKRTEIED 4 BEOHFKRINVIEERT
EFH&ITHYFELZ [B4L (Time)l. [A—F (Chords)l. TET# (Video)l.

[Y—h— (Markers)ID4F%E VI DRRIFERTEENZTNER THRETEET,
JalzobO7a—ICETAMNRMEIND L, [Video & Markers IO RSO DB

EICRIRENFET,
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F—bA—2a0 OFEEGIE: BEE—ROTURERIE MIDI OA—tA—avL
—UTRAVNERSYT T HEEIC [AlY] F—EHFTIET. RAVMEDLT DB E
TEHDT, FYBREGRBEZITEAET,

FoVIDHAXEERTT S BEE—RTOERLIZMNSYIDOBESEEET ST
RAEF=zIZBMENE LIz, T 74D a— R hybME [Shift]+[G] & [Shift]+[H]
TY,

E\EEDBETUTIL—b: Dorico NREDTADTINTH I URE—YHEARAER
WESIZTB5E1E. TBE (Play)l » TBETYFL—k (Playback Template)l
No FE=LBBAETUTL—MEST (Silence)l#BIRLET . 7O IHTHHY
FEBATBHIZE. COFAT7OTEL53—ERVT. ChUsNoBET TL— 2
BWALFET,

MIDI thru TERT Y IUFEER: BEE—RTrIVINYE—ED)vIT B,
BERAANEMNDLEEIC MIDI F—HR—FhSERINz/—,OIa—/\YYIZfE
ATAIURRAVNERETEET, £, TEE—FTHEREREIRTHILTHY
VUREZEETEET,

WERE

RARAENTT ST FERT HBERRERT BREICFL O BOBRART
S ERRENHERL LI <BYELE,

TOaozHMI74I0L

Dorico DIBN—Cav TREIZRFESNIZTOD I ERCE. BHRAVE—DRY
DAPRTEN, TAODTIMNRFSNT: Dorico D/A—avh@MEh (BE
TE35E). HLLWA—23 0 TRKET O o O B HMICEH SN S ENESE
SNET, TADHOMITY) -2 JIHRE TR MNET . 2FY . B|/AA—Yar i
xRV TYCICHALEE S IREZRLEREA. CNIE COEEIZTEDA
EHIITRTC. HETIOTADIINEINLUBEDNN—Da 0 THERWV-15E81
BHRIZITEDONENETT . COAVE—VFRERIELRVEE . RERTE
(Preferences) IO £#& (General) IR—UDI77A)L (Files)1to 3> T, 8]
N=2av KYHOFERFILLWA—2ay TRESA-TOD M ERCEE X E
&9 % (Warn when opening projects last saved in an earlier or later
version)1&A4 7129 5 ETEMICTEET .

Dorico DIBN—23aV TREORFELEZTODIIMNEN—J3 TRV HET
BROTLEEZELTLEDLHBNKSICT BICIL, TRBEERE (Preferences)DRILHAT
[2HBTRIN—=Var YT NFEEFIHFLLA—SavhslnE=7Fad oo, Hl
WBFRICERET S E%{RT (Prompt to save projects from an earlier or later
version to anew location)1ZAUICLET , COFTav i+ UG- TNVSESE
(. T274IL (File)l » TRTFEF (Save)lZEIR. F1=(L [Ctrl]+[S] (Windows) *+°
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[Command]+[S] (Mac) Z AALTZETH, Dorico [FBEEEZZTLRVEE
Ao DOYIZ AZEDTFAIIEBIRFTAT7OTHNRRSN, TOD I bOFHLLVART
LRTFEFOBRMEINES . COLE BREFEDOTODIINIFAILELEEZT S
CELEIRTEFET,

TONT«

[#&5E (Edit)] » [FR/8F4%aE— (Propagate Properties)]a< > RA =12
BMEShFELIZ, ShIZ&Y . BIRSNTWSTATLOTOANTAEZREDLAT Ik
N, ZDTATLRRRIINSGMD T RTOLAT7IOMNIOE—TEFET, BT —
FTEATLELBE. BEE—FOTONTANRRILIZRIRINDTANTL DA D
LATIMIOE—23nFz T, FEET R TETLESBE. BETE—FEEEET—LD
WA DTOANRTANRIIZRRENDTANNTAAAE—ENFT,

BILT. SBEEE—FTHRIRSINDTO/RTo (TRTOLATIMIBERASND D, L
AT IR ELICELGDGELHINEHIL—LDFI—V LD ERTELLEN)
[E. AT LOEKRNGHEEH OERALHY . FEE—FICLhRRSNENTA
INTA (BE. LAT7 IR ELTTRAGL BOL—LDFI—UIEITHLERNAE
Cd) [ BG40 0N OMEICEDLAERZFLET,

F2ERIE RS—DEBETHF AV (EIR. BIRGL) [FREE—FICRTINETA
INTATHY. FLEE—FHSITANT1EIE— (Propagate Properties) & 3E4T
LIS EISERSNFET A RA5—RIGOHIER AU DB BELGAE T RFEE—FIC
LORRSNEBWNTONTATHY ., BEE—FHISIFTAITEIE— (Propagate
Properties) |#R{TLIzGZE DA BERAINET . ChIZKY . TXTOTO/NT1%
AE—F A0, ELATIVEORABREDFHMIC Lo T ERATES LD FIE—
JONETERTEFET,

ATy 18R

ATV ABBOERDEREERTICT S ATVVBE TR, TOHERNIZH
SMOFEEODERFET IAILNTERTRICLTVET  ChITEY EAILHEER
[CYADEENBEFRLEL DD RAT7BLVN—MIERIY2DHERTT DL
WSTENTEET ATV BBITHOBEREZRRASEILENHLHEE(E. TO
INTANRRILDITRASYS 14888, (Slash Region) 17 IL—FTClhDEEHERT
(Show other voices) 1 7R/ T1EAVIZLET,

Aoy BEONE#: THEEAT 3> (Engraving Options) DTN &EF #F
(Notes) IR—TIZHERESN =T IMNIER (Count) o3Iz, RSy A BE D /N
#ERTT DA T avhFifzSBMEShEL,

s [ RSy afEDO /NG ¥E n IFEZEIZERT (Show slash region bar
count every n bars)I Tk, /NEI#MERTT SEREIEELE T il
BETDHE TRTONMAIT/PMEFHDRRIEINDKIICHYET,
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s [R5y EEO/NIBDIE (Appearance of slash region bar count)JT
. DEIBHELEDESICERTRTEINEHEELEFT, HFEIMDOF (With
parentheses) ], NEilA& L (Without parentheses)l.JEZERR (Do not
show) I OWFIHEERLET,

n [RSYLaBEO/NMIBOEIE (Placement of slash region bar count)]T
(E. DEIREERD LFIETOELELICRRTEINERELET,

n [ERHNSOIMHHKDIEEE (Bar count distance outside staff) 1 Tl&, ERD
HImFEETIRMS/NEBDEFETORREZEELET,

BEETFTRBEICECTMNIROBFOMBELZRAZLIYNFS VI LEEYTESE

ED

ROV
ERSRNLVICHERTDIIIFTHERRARM ARSI AVMEERE (Edit
Instrument Names) |[# A7 AT (2 FERINILOLYVEH LG A BREETEI-H
DAVEA—LAEMENFELTz FTEDAVARYIILAVEDRBEDIZRTIND
ERINIVERET BICIE. EETE—FRDTL—VY—/IRILTEDAURARY LAV
NEYETEA TS TL—V—DA—FERRALET . AV RRIIILAVREITTIR
A—INZEEV TR 1ZRREE. [>120)vILFE T, AV THXFRAMZ2—
Mol ARTZEMRE (Edit Names)1ZFBIRLET . ROKSBF (7RI NRRSINE

j— S @ 0 Instrument Names
Editing instrument fdating Plaral names
Full name
qlsutines o] AflDNose +Fl w0t “" ﬁ |8 M;::-:;' [ uoist M
[e——— v ) [rabc B3 coose 2] 372 oooe |2 ;7;;:.‘.-7 NI
Piano
(for rehearsal
only)
Short name
T A - ) Al T atfcwn [2] ()G il
X : oeox [2] 22focex 7] [EZIHE) (YA) w8
Pno
Show transpo RIS _
ve a3 Ml !
Cancel m
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COFAT7ATICANEIN-TEFRMNE EREBDRBICRRENSERINILE

(FTHEL ERLEBOAVARIIILAVIDEBESNILICHERSAET N, COHE.
BITOERZITT RTHIBREIN T, SANLA 1 FICFEHONET BT, F(470

TOBREICETIEEEERINET, hbVYIZ. 8STSTRESILDEBNEIC

FRINET, ChICKY  HBOENSTET. ERINILOEED —EEEHERF

TEFEY,

AVRRGILAVRDSRIVET IHILMNZET T BICIE. TFIAILRZYEYE
(Reset to Default) 1% 2')vIL%ET,
RO IL—TIN)L: TH§EEF T3> (Engraving Options) IDI#EERIRIL
(Staff Labels)IR—JICIEETHIRILYAEFRDOERSNIL (Staff labels for
identical adjacent solo instruments) |47 avh FfzIZBMEShEL -, [FER
B®DS IW—F4E (Group between staves)JIZRETSE. ACAVRRYILAVRC
BLEBZET DHERTATITHL. L DOAVRMILAVRE D P RAFZ TERES
NETEAL 2 DOTIL—FAA—FDIZE . TFlute JSRNILA 2 DDEERMIC
PR{FATEESN, LOFERICIETL], TOERIZI2IOFNILHFEET,
TIWN=TINLIE BCAVARIILAVNIBT HEREARICHLP RN Z TRES
NETHEROBNTHRDIEES. JIL—TIRNILIZEATDERDE 3 #RIZ. B
HDFZEIFEATD 2 DOEREBDAR—RIZ, hRFATRESNET,
AVRRYIAUNBEEB LV TAT40172aVIC@EHFHLLNTTSTREALTH
BHIERTANIL (R) (Staff labels (inner)) I1AMERAIN., T IL—FRELDAV XY
IWADR TIN—T DN, BLKUOTAT4ODTN—TFEFTL—V—DIR)L
(ZIE, REEDIFERSAIL (Staff labels)IDREAIILAMERSNET  ROEIL, £
DIBEDSRNILDBEDINTT TRV EFERTEINERLET,
ERINL
ERINIL(A)
1

Flute

Bassoon

Solo
Violin

gli altri
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HEBEONFRENBSLIUNUOERINILEDERE. IFEF Ty
(Engraving Options) |DIEERSR)L (Staff Labels)IXR—L OIEBRDBRARGIE
(Start of System) 1A TS a & FRALTRESNET

JO0—DRBEBEDINIL: TU—V—ITBEDAUXRYILAVIDEIY B THNT
WBBE. TL—V—(E, EEEDORBEFICEDA VAR LAV NERETTRENE
BELTEIENEERTT, ZILRATLAT7IRCIE. BERVDOMBEDO L AIIZFE
RUNILDRIRENFT A A= AT IORTEHBERREINEL A TLLT7IL
#7733 (Layout Options)IDIFL—A— (Players) IR—I DI ARk LA
YRDZEE (Instrument Changes)ltoavIZ [7A—DRBEIEIZA VXY
ILAVRDERSANIILERKT (Show instrument change label at start of flow) ]
AT av B FzICBmMENELIz, SOFTLaviEk HFRIOD I D/ —rLA
T ILTIETIHILNTAUIZHE>TUWVET A, Dorico 2.0 LARID/A—2a> THERSE
NI=TOO IR TIE NBERBETHOITHIITHE>TVWET A UIZT e &
VDD ORRBEIEICA VARG IAVCDEBSRNILARRSIN, TL—v—IFE
DAVARG VAN BRI RNENDIHOAYOTLEYFET,

TADAPDTIWN—TSR)L: T4 4P%4ER (Change Divisi)IZ 4705 OIS
L—Y—&F XTI —T8%RKT (Show player or group name) 1A 7 av i,
[LAT79hATFar (Layout Options) DIz 4B (Staves and Systems)]
R=IDF T3V FYBREINDESICHEYVELIZ, T4 T4PDTIL—TRIE. T4
TADICTN—TERERINTUWEWNEE L, FEISh BN EIDFERLA
JVIZRIRSNDT IA DAV ARG ILAVNEITEYET RSN TLDIGE .
TATAPDT W—TENRRSINET,

MBS BES

HEBEDHEGEEE (FO—IC—FEHLULDERAETENDBATIEAL) EROHK
NELGLHHEERLTOBICOARTT DEIIEETEERT . chlFNUIvkDLO
— T4 Ty ar D=OIEBREN S/ \— M ETHEAINSIRERA T, CDE)
EEBEMZTBIZIX. TLLFTIbF T3y (Layout Options) DI &4 B
(Staves and Systems)IR—IDMHABDHEIFEEE (System Dividers) 023
> T HBOSEIREERT (Show system dividers) 1% TR DB ERL D5
A& (When number of staves differs)JIZERELET , [TLAVY—DR/NMNENE
ETAHE (When minimum number of players present)1Z:&iR35&. HiEE
DT IHIVFDEMELGYET,
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s
REGATFRE: BEESETESRSLIURBESROIIIL—TIZ 1 DOAFESTER
RIBATavhREIN, EEERLZLEFZOMDOHODLT773—ICET D
FTRTDAVRRYIANET IL—TIELT. 1 DORELIRFREERTTEDE
SICHYELz, COERICKY . A TLavDRENTEERBHLVZERORBD
AV ARYILAUE (Instruments between brass and strings)J. SEREEA E3
IZ#%5 (Treat separately)]ETBE—DXKIFIMEL TS (Treat as single bracket)
[CEEEINhEL,

ZAEOA: [Shift]+[M] DRy TAH—/\—[ZlopenléANTBE, EEBERRLEN
EHDHEEERTEEY,

BEROBFOIA+NER: THHEA T3> (Engraving Options) DI EFF
(Tuplet) yR—C DIEFOEFEDR AL (Tuplet digit style)lAFavIz [T
L—22#2k (Plain font) IOEREAF = ITEMSNELz, COFTLav&&
RIBEFEHDTDEZETA b (TIAILLTIX Bravura) [CXBIEHHLBARFESE
ITMFEDOHFOMADLYIZ, [HE (Engrave)] » T4+ FRBA)L (Font
Styles)IDIEFDFL—2I42k (Tuplet plain font) ITHEESINDTF AT+
VRAERSNET,

EFOAFEIMO TV IDAE: [HBAT 3> (Engraving Options) |DTEFF
(Tuplets)IR—C DI KELRE (Horizontal Position) o3, TEIEIDE
WREIBEER THREBDA 7t Yk (Offsets for Start and End of Bracket)1&EWVS R
HLOLE 2 DOHF-LGA T avhBmEhELz, CCTEH. EFROARFINOA
BIEEBIDRAR—ZADTIAIVMEZRETEET . [FEDS TRZOEFIZH<H
R DBAREIE DBINA TV (Additional offset for start of bracket on
stem- down tuplets)IDEIX. EFFICAFENARREIN, FENTRAETHLIE
BOHERSN. [FEN LAZOEFICH<ATEMOKRTEZEDEMNA TV
(Additional offset for end of brackets on stem-up tuplets)JDfE(L. EFIZH
FIARTIN, FENLAZTHAGEDAERAIIET . BMEOTODIID
BEIE.NEHEDLOTLESICLEHSCIzO EIE 0 ISRESNTWET . FHHT
ACIVRDBEE 14 ISRESATUVET,
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A—PF—A2A—Tz—R

F—R—KFia—rhvbh: TIRIEERTE (Preferences) DI F—HR—Fa—rhyk

(Key Commands)IR—I DIERE (Edit)JATIV—IZ 3 DOATURAFHT=IC

BmMEh, LA7IOMIEET 52— MRAGIRIEIC DN T, AZa—0F 170 %MK

&L F—AR—Ra— Oy CEEERTTESLIITHYEL-.

» [/NFDHEEZEE (Change Bar Consolidation)lld., /NN E—FD
KRICETS 3 DOKE WELL. RKFOH. RNFF&L/NEHVE—RES)
ZTNENICODVTHEDF—HR—FIa—rhvbEBRETEET,

» [IDHDHAEEYIVEZ (Toggle Bar Consolidation)JIZlE 1 2DF—HKR—F
a—MOVRERETE RYBLEITTSE 3 DOKRENEFRICUIYEDYE
ER

n [LA7IMDBREVIYE X (Toggle Layout Transposition)JIZl& 1 DD+
—ih—RSa—rAyrERETE BRYRLETTHE, THRE (Edit)] » TBIRE
wF (Transposing Pitch)1&T#R&E (Edit)] » TarH—krEYF (Concert
Pitch) IO TIYEHYET,

FSRR—FD R Y—IN—DIZ,FURAR—MADEA LTARTLAED )Y
D9 BENELIE. T VY BB, 24 LO—FDJEIZ, HEAHLBEORTHATY
BHOARIITHYELI=, A UNSVRR—b IR TR, GRIDZALTARTL
AZ0)v 09 5E, FEBREESM La—FANIRICTIVEDYET,

TAVEDBAXEMEDERT: URIRELLTODIIMEBERKEE . REL:
VAVEDDHAXEMBEEIYENVEBRMETERLTESLIICHRYEL,

e

ROMDHBWETHIZFAILDMBERE: ETANRMSINETOC IR ERKEE.
TOCIIMIBBESINDLLEDEUEICET AN ROMNSALVGE. Dorico (&
Dorico FAVIIMIHESTHILE—TETAI7ANERZELT, RRLISEEB
BMICERETEVET,

Apple ProRes E774: Apple ® ProRes a—Tv/%#RAY5HE 743, ProRes
I—T U Dorico MIFICEMSNIzCEIEY ERICBESNDLIITHYFEL
f= (SOa—T Y71 Windows TOHILE, Mac TIHAEDI—Tvoh < TH,
ProRes 774 ILEBAETEET),
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Issues resolved

@ steinberg

ID # Component Issue

STEAM-5341 Accidentals Changlng the enharmonic spelling of a note with a microtonal accidental now works
reliably.
A number of problems relating to the choice of specific accidental in note input when

STEAM-7506 Accidentals multiple accidentals in the tonality system have the same pitch delta have been
resolved.

STEAM-8133 Accidentals It is once again possible to select the symbols in the Edit Accidental dialog with the
mouse.

STEAM-7673 Articulations Staccato articulations are now positioned correctly under slurs on beamed grace notes.

. . witching away from Dorico while it i rtin with th n io engine in

STEAM-8174  Audio engine Switching away fro orico e it is start gup th t eSu.spe d audio engine
background preference enabled no longer sometimes causes it to hang (Mac only).

STEAM-8162  Audio export Attempting to switch to another open project while exporting audio from the first no
longer causes a crash.

STEAM-8227 Barlines Stgrt repeat barlines pow appear correctly at the start of the system if they coincide with
a time signature that is set to appear above the staff.

STEAM-8143 Bars When deleting bgrs at the end of the prOJe.ct, Dorico now ensures that tempos, rehearsal
marks, note spacing changes and breaks in the deleted range are correctly removed.

STEAM-5767 Beaming Furtherulmprovemen.ts have been made tg Dorico’s algorithms for avoiding “beam
corners” when beaming between notes on different staves.

STEAM-8148 B®ming Under somg circumstances, stems on notes. crossed_bt_atween.staves. cpuld appear on
the wrong side of the notehead when reopening an existing project; this is now fixed.

STEAM-5767 Beams A problem that caused beam corners (where a partial beam is positioned on the' wrong
side of a between-staves beam) to appear for some rhythmic patterns has been fixed.

STEAM-8204 Beams A problem whereby_notehea_ds could .dr_aw on Fhe wrong S|de. of notes when crossed to
other staves when first opening an existing project has been fixed.

. . ) N .

STEAM-8156 Breaks Movmg a system or frame break signpost with Alt+left/right no longer causes the
signpost to be removed altogether.

STEAM-8098 Chord symbols Chord symbols no longer incorrectly appear on extra staves added to instruments.

STEAM-8213 Chord symbols Chord symbols .nOV\-/ correctly caus.e. multi-bar rests to split on grand staff instruments
where one staff is hidden because it is empty.

STEAM-8022 Clefs A problem.whereby redundant clefs appear in extra staves belonging to an instrument
has been fixed.
Dorico no longer shows restorative clefs and key signatures at the end of a tutti passage

STEAM-8069 Clefs at the end of a system belonging to the divisi staves that were present earlier in the
system.

STEAM-8023 Divisi S.ta.lvgs in galley view will no .I().nger be spaced sufficiently far apart to make room for all
divisi staves, when the last divisi change has been deleted from a section player.

STEAM-8071 Divisi Time signatures at the end of a system that coincides with the end of a tutti range

(following the end of a divisi section on that system) now appear reliably in all staves.

Dorico 2 /N\—2av R
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ID # Component Issue
STEAM-8085 Divisi Changes of kgy S|gnature in unison ranges before or after a dl\./ISI change on a system
no longer collide with the double barline after reopening the project.
STEAM-8223 Divisi Key signatures on divided transposing |nstrur'n.ents in the preamble at the start of the
system now always show the correct transposition.
STEAM-8284 Divisi l)_lgapllng instrument changes for a given layout no longer causes the staff labels for
divisi staves to stop appearing correctly.
STEAM-8288 Divisi Pasting a divisi event that references a custom paragraph style into another project no
longer causes a crash.
STEAM-8322 Divisi Under some circumstances, pasting a divisi signpost could cause Dorico to crash; this is
now fixed.
STEAM-7942 Dynamics Dynamics will no.longer. sometimes be positioned incorrectly in galley view after editing
them, e.g. changing their placement.
. The cresc./dim. gradual dynamics in the Dynamics panel are no longer incorrectl
STEAM-8254 Dynamics . g. ”y . y P . 9 y
shown as hairpins in additional windows opened for a project.
STEAM-8325 Dynamics Und(_er some circumstances, ed.lt.s to.notes on ong system could cagse dynamics on the
previous system to change position incorrectly; this has now been fixed.
STEAM-8068 Flows Playback is now always initialised correctly when importing flows into an empty project.
STEAM-8095 Flows Spllnlng an existing floyv no longer cauges notes on the left-hand staff of a piano
instrument to be moved incorrectly to the right-hand staff in the new flow.
STEAM-8103 Flows Layouts that co_ntaln only a subset of flows now play back correctly, and can be
exported as audio correctly.
STEAM-8282 Flows _ImprO\_/ements to the handling of players with multiple identical instruments when
importing flows.
STEAM-7482 Graphics Graphics files imported from OneDrive using the “on-demand files” feature now appear
import correctly (Windows only).
STEAM-8183 Holds and Caesuras that are not positioned immediately before a note, rest or barline no longer
pauses cause an unexpected spacing distortion at the following barline.
STEAM-8183 Holds and A caesura positioned at an arbitrary rhythmic position within a bar no longer causes the
pauses spacing of a time signature at the start of the following bar to be incorrect.
Key Key signatures no longer incorrectly collide with double barlines to their left when they
STEAM-8085 . . . . . L
signatures appear within a tutti range preceding or following a divisi change.
Key Under rare circumstances, defining a tonality system with specific combinations of
STEAM-8208 . L :
signatures divisions could cause a crash; this has now been resolved.
STEAM-8223 Kgy Key S|gqatures in divisi staves are now always correctly transposed if required in a
signatures transposing layout.
Reset to Factory in Layout Options now restores staff label options to the correct
STEAM-8279 Layouts values for parts in part layouts; previously it was incorrectly using the defaults for full

scores.
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ID # Component Issue
. A problem whereby shorter notes contained entirely within the duration of longer notes
STEAM-8267 MIDI import . . . . ) ;
'mp on the same instrument would be omitted when importing MIDI files has been fixed.
STEAM-8296 MIDI import The last note in a MIDI file is no longer sometimes incorrectly omitted if its duration is
shorter than a quarter note (crotchet).
STEAM-8178 Mixer For some projects, the initial dlsplgyed position qf the Video fader in the Mixer did not
match its actual output level when first opened; this problem has now been resolved.
STEAM-8083 Multi-bar Ed|t§ to grace ngtes c_lo_se to divisi change events no longer sometimes result in
rests multi-bar rests being split incorrectly.
STEAM-8121 Multi-bar Multi-bar rgsts r.10 longer disappear at transitions between instruments when the player
rests has local time signature changes.
STEAM-8144 Multi-bar Creating a sygtem break following a divisi change no longer incorrectly causes multi-bar
rests rests to be split.
Multi-bar Divisi changes belonging to players who are cued into the current layout no longer
STEAM-8164 . ; .
rests incorrectly cause multi-bar rests to be split.
STEAM-5809 MusicXML Transposing instruments created via MusicXML import are now correctly numbered,
import taking their transposition into account.
MusicXML Switching off the Beam groups option on the MusicXML Import page of Preferences
STEAM-7884. . . . .
import now correctly takes effect for all noteheads within a tie chain.
MusicXML Some specific combinations of coincident tuplets in MusicXML files exported from Finale
STEAM-8122 . - ) )
import could cause Dorico to crash; this has now been fixed.
MusicXML Importing a MusicXML file into an existing empty project no longer results in some of the
STEAM-8203 . . . S .
import required default notehead types being missing from the project.
MusicXML Under some circumstances, the import of nested tuplets in MusicXML files could fail.
STEAM-8256 . . )
import This problem has now been fixed.
STEAM-5625 Note input The default enharmonic spelling chosen for grace notes now matches the spelling
chosen for normal notes.
STEAM-7113 Note input It |s. no Ion-g(.ar. possible to input noteg on a staff no? currently visible (e.g. an extra staff,
ossia, or divisi staff, or a staff belonging to another instrument held by the same player.)
STEAM-7493 et It.|s now po§5|ble to lengthen or shorten the QUratlon of an implicit rest repeatedly
without needing to reselect the rest after each edit.
STEAM-7506 Note input The_lnput of achentals with equivalent pnltch .deltas in tonality systems that define
multiple such accidentals has been substantially improved.
STEAM-7585 Note input Multi-paste now works reliably when copying material crossed from one staff to another.
STEAM-7585 Note input Under some circumstances, cross-staff notes could be pasted onto the wrong staff; this
STEAM-8167 P problem has now been resolved.
STEAM-7852 Note input After using Edit » Paste Special » Move to Staff Above/Below, rests that were moved

as part of the selection now correctly remain selected.
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ID # Component Issue

Slurs that end at tuplet positions are no longer incorrectly unscaled when using Edit »

STEAM-8021  Note input Paste Special » Reduce.

Copying and pasting material between instruments with differing numbers of staves now

STEAM-8066 Note input
works correctly.

Attempting to change existing notes into a slash voice no longer sometimes causes

STEAM-8082 Note input Dorico to crash.

Copying and pasting between instruments with different numbers of staves, or between

STEAM-8086 Note input o
divisi staves and regular staves, now works as expected.

Copying and pasting an ossia or extra staff signpost from one instrument to another now

TEAM-81 Note input . .
S 810> npu correctly creates additional staves if necessary.

STEAM-8134 Note input Grace notes are now handled correctly by Edit » Paste Special » Explode.

Edit » Paste Special » Explode now works correctly if invoked on a staff that contains

STEAM-8147 Note input .
. both notes and dynamics.

The enharmonic spellings chosen for octave-transposing instruments no longer

STEAM-8249 Note input . o
P unexpectedly differ for non-octave-transposing instruments.

It is no longer possible to use N/M to cause notes to disappear because they have been

TEAM-8262 Note input . . . . "
S 826 'npu crossed to an ossia or extra staff that is not visible at the selected rhythmic position.

Inputting notes via MIDI keyboard into a new voice now always produces the expected

STEAM-8263 Note input . .
enharmonic spelling.

The notes input on one instrument no longer incorrectly affect the enharmonic spellings

STEAM-8270 Note input . . ) . .
P chosen for notes input on another instrument during the same input session.

STEAM-8289 Note input Divisi, ossia and extra staff signposts are now excluded from block selection.

Using Alt+N/M to move items to the staff above or below no longer incorrectly attempts

STEAM-8297 Note input to move pedal lines or divisi/ossia/extra staff signposts.

Setting articulations and accidentals before specifying the pitch of the grace note to be

STEAM-8298 Note input ’
input now works correctly.

Edit » Paste Special » Move to Staff Below (Alt+M) now correctly always moves to the

STEAM-8319 Note input . . . ) .
P next staff when the selection being moved is not on the first staff of an instrument.

Starting note input via the mouse by clicking the Lock Duration button in the note input

STEAM-8329 Note input
P toolbox now works correctly.

Under some circumstances, it was possible for a note’s rhythm dot to be shown twice

STEAM-6975 Notes when the note is consolidated with a voice column to its left; this is now fixed.

Under some circumstances, single-stem tremolo slashes could collide with noteheads
STEAM-7665 Ornaments because the stem was insufficiently lengthened; this has now been fixed (Windows

only).

When an ossia is active on a grand staff instrument, only one of the main staves can be

STEAM-8206  Ossias hidden if empty, rather than allowing all regular staves of the instrument to be hidden.
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ID # Component Issue
STEAM-8063 Page layout A problem whereby editing the position of a tempo mark could cause the vertical spacing
to change unexpectedly has been resolved.
STEAM-8092 Page layout Hldlng empr staves .now.onf:e again works correctly for players holding multiple
instruments in layouts in which instrument changes are disabled.
STEAM-8165 Page layout Spurious additional clefs and key S|gnatu.res no Ionggr sometimes appear in the middle
of the system when extra staves are set via layout options to start at system breaks.
STEAM-8200 Page layout Chaﬂges made to staff spaf:mg for extra ;taves bt_elonglng to an instrument are now
persisted correctly when saving and reopening a project.
STEAM-8243 Page layout Under some circumstances, moving a rehgarsal ma.rk in Engrave mode could cause a
tempo mark on another system to move; this is now fixed.
Under some circumstances, repitching music could incorrectly cause lyrics above the
STEAM-8277 Page layout o '
gelay staff to move further away from the staff; this is now fixed.
Under some circumstances, editing or inputting notes directly before a multi-bar rest
STEAM-8278 Page layout could cause the bar count number to move incorrectly away from the staff; this is now
fixed.
STEAM-8287 Page layout It is now pos§|ble to select the staff spacing handles for multiple instruments held by the
same player independently when instrument changes are not shown for a layout.
STEAM-8312 Page layout A series of fermatas positioned OI?I adjacent. barlines no longer sometimes move
incorrectly when one of the fermatas is nudged in Engrave mode.
5 Under rare circumstances it was possible for Dorico to crash when editing the names of
STE A percussion instruments in a percussion kit from the Edit Percussion Kit dialog. This is now fixed.
STEAM-8157 Performance Thg speed of inputting n_otes in projects that include changes in the number of staves for
an instrument has been improved.
STEAM-8246 Performance Th_e speed pf inputting _and editing mu5|c_|n larger projects with percussion kits shown
using the grid presentation type has been improved.
STEAM-8268 Performance  The speed of note input in larger projects with instrument changes has been improved.
STEAM-8103 Piay mode A p.roblem whereby layouts that do not have all flows attached could play back with long
periods of silence has been resolved.
A problem that could cause Dorico to hang during start-up if the Suspend audio device
STEAM-8174  Playmode P g dunng P P
in background preference was set has been fixed (Mac only).
The correct VST Expression Map is now chosen by default when creating a solo double
STEAM-8285 Play mode . i .
Y bass player when using the HALion Symphonic Orchestra playback template.
STEAM-7989 Playing Adding an ossia staff above the right-hand staff of a piano no longer incorrectly causes
techniques pedal lines to stop drawing.
STEAM-8224 Plaqug Under spme (?lrgumstan_ces, pedal lines would draw on the top staff in the system in
techniques galley view; this is now fixed.
STEAM-8327 Playing Editing the default placement of a playing technique in Engrave » Playing Techniques
techniques now correctly updates any existing playing techniques in the score right away.

Dorico 2 /N\—2av R

95 R—T

Steinberg Media Technologies GmbH



@ steinberg

ID # Component Issue
STEAM-8136 Print mode Lyrlcs colgred by .VIeV\.I » Notes and Rests » Voice Colors are no longer incorrectly
displayed in color in Print mode.
STEAM-8198 Print mode Cqmmands from the Edit menu that can edit the score are now correctly disabled in
Print mode.
STEAM-7482 Project files Importing a graphlp located in OneDrive when using the files on-demand setting now
works correctly (Windows only).
STEAM-8195 Project files Improvements haye been_ made to the way tha.t Dorico determines the filename to be
used when exporting multiple flows to a hew project.
STEAM:-2812 Setup mode Under certain circumstances, draggin.g gn instryment from one player to another in the
Players panel could cause a crash; this is now fixed.
STEAM-8269 Setup mode Changing the mstrumgnt h.eld by .a player fr9m ong kllnd to another. no longer incorrectly
changes any slash voices in that instrument’s music into regular voices.
STEAM-7501 Slurs Creating a slur yvnh a smgle npte selected npw always correctly advances thg §I1_Jr tp the
next note of a different pitch, instead of ending at the end of the current note if it is tied.
STEAM-7674 Slurs The positioning of slurs on grace notes in multiple voice contexts has been improved.
STEAM-8241 Slurs Attempting to crleate and extend a slur with the mouse when more than one window is
open on the project no longer causes an error message to appear.
STEAM-8155 System track  The appearance of the system track in music in open meter has been improved.
STEAM-8190 System track  The system track now draws correctly for bars that span more than one system break.
STEAM-8271 Text The valut_es for the default distance of text items from the staff were incorrect by half a
space; this has now been corrected.
STEAM-8320 Text Clicking Revert to Factory for one of defaglt paragrgph styles in Engrave » Paragraph
Styles, no longer causes problems displaying items in the score or even a crash.
Time Time signatures local to a single staff now draw correctly when global time signatures
STEAM-8033 . .
signatures are set to draw outside the staff.
Time Start repeat barlines now appear correctly at the start of the system when they coincide
STEAM-8227 . . . . . . . .
signatures with a time signature change, and the time signature is shown outside the staff.
STEAM-8110 User interface It is once again posglble to define s.hortc_uts for commangs nested two levels deep in the
Key Commands editor, e.g. for articulations, note durations, and so on.
STEAM-8129 User interface The state of the varlo_us buttons in the user interface concerning the Video window now
always correctly stay in sync.
. Navigating through the entries in the drum map with the arrow keys now correctly
- f S . .
STEAM-8185 User interface updates the selection in the panel at the bottom of the Percussion Maps dialog.
STEAM-8219 User interface Some list controls in Dorico incorrectly caused the Input Method Editor for CJK text input

to become activated; this has now been fixed (Windows only).
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ID # Component Issue

Under some circumstances, the instrument labels in expanded player cards in the

STEAM-8260 User interface Players panel in Setup mode would stop drawing; this is now fixed.

The Stereo output and Sample rate controls in Edit » Device Setup no longer flicker

STEAM-8332 User interface .
when changing values.

STEAM-8090 Video There is no longer a limit on the length of the path of an attached video file.

Changing the project frame rate via the Video Properties dialog now always correctly

STEAM-8093 Video ;
sets timecode offsets for the current flow.

Advancing the playhead position frame by frame now always displays the correct

STEAM-8132 Video . X .
timecode in a newly-created project.

The position of the video fader in the Mixer is now always correct when opening an

STEAM-8178 Video . .
existing project.

STEAM-8235 Video Dorico now always correctly detects the framerate of a video at 23.976fps.

The presence of a timecode staff no longer causes staves to become misaligned in

STEAM-8101 Views e . . L .
galley view in projects in which instruments have a variable number of staves.

Staff labels shown in the margin in galley view no longer disappear for a moment at

STEANEBL7L Views certain points when scrolling music left and right.

When multiple windows are open on the same project, only the window in focus will

STEAM-8176 Views .
follow changes of selection.
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https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in

-Cubase-and-Nuendo

ETF0OFKM: TOPzIMDETO—ICETAERATEET . RLETA (fz&2
[ET4ILLH 1 &5) THERTDHEE. TOETHZEHROTO—ITRMALT, 70
—CLITENENELDSEICEDE TERTEEY  ETADRMIZETUTD 2
DDFELHBYET

BEE—RT, 7A—/RRIDSETAERMNTEI70—5EGY)vILT, AVT
FRAZ2—MBTETH (Video) Tt (Attach)1ZZIRLET, IT7 ML=
REAT7RTBRREN, IO RTTIETAZEIRTEET, [BE< (Open)l
0o BE ETANTOCIIMIRMASNET,
BAE—FTC.ETADREMINTNDIHINT —DOETAHI7AILERSYIL
T A LAV EDETAZERATAMEICFOVTLET,

HEE—FCETAZHRMLIBE. TETADTO/F41 (Video Properties) |5 A
TRIDBEE. UTOA T avnNRESNET,

% Video Properties

Videofile: |/cue.mp4

Video framerate: |24

Project frame rate: [ 24 fps v ] | Use video frame rate J
Beat count: Beat unit:
Flow attachment position: 8 b"‘ f : J
2 o ® e
Video start offset: | 00:00:00:06 [
Timecodestart: | 00:00:00:00 [£]

(et ] N

s TEFHI774)L (Video file)lBKUTETADIL—LL—F (Video frame

rate) JIEEERAARA D TA— LR ELGSTEY . RFTETAI7MILDHEXT /AR
ELETAIVOUNBRELIZIL—LL—MRTRSINET,
rFaszHr@IL—LL—bk (Project frame rate)lld. I—h—HLUFSU R
R—bD4URDICRRT BFALOA—RERET H1-6IZ Dorico BMERAT LT
L—LL—rEEELET . TETADIL—LL—FEER (Use video frame
rate) 19w 5L ETAIUCUNRBLIEIL—LL— DR ESNET,
MATESIL—LL—FOFMICOVNTIE, UTESEBLTIEEL,
2a—n72yFA2MIEB (Flow attachment position)]Tl&X, ZE—RHOE
TAOBERBRAVINEEELEY . ChFIEEL-EAOIBOBHTIEEL
F9,

RERE 44 OTO—DHRAD 2 MAICKETAZBESELRNVGEE . THOD
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A2k (Beat count)]74—ILKRIZ 8 #AAL. HADESRL (Beat unit)1hd
4 PEFTERLES,

s [EFFREF 7t vk (Video start offset) I TIE,. ZO—DFRYFAVMIE T
RIRSNDETADIL—LERBELEFT 12EZAILETAD 6 JL—LHET
EENERINDIGE. ZDT4—ILRIZN00:00:00:06 1EANTZHET.ETA
DBEN 6 IL—LOMSRIRTHLIIHEELET,

n [R4LO0—FBASR (Timecode start)ITlE, ZA—DT7AVYFAUMIBIZH TS
BALA—FDEFEELET . EXE. TaLL 1 BTEOMBMEICE 1
FEIRLYDEA La—FAT EENBHBEELABHYET . 2FY. 1 BEHIEFESE
F01:00:00:00 M5B8 L (F10:00:00:001MSEIRT 5156815 D). 2 HHIF
r02:00:00:00) (F7=1&£l11:00:00:001) N SEAET S, ELV--BEETT,

FTRTOTOANTADFREERZT5. TOKIZVIVILET,

BEE—FTETAZERMLIGE . TETHDOTR/IT1 (Video Properties) |¥ 4

FRTNBEBHICRAKCEEHYFERE A REE—FTIA—DA—FEEYYYILT,

AUTEXRMAZ2—HBTETH (Video)I»TFO/8F 4 (Properties)1%:&IRT %

N RBEE—FTI—H—NRILDOLEBICHITETADTR/IT1 (Video

Properties)Iih a0 v 03 5L. FAT7AT BEEFET,

ETAZRAGTEHE BEE—FOI7O—NRILIZHPD70—
DH—=FEDETRRIZTAILL)—LTAaVE TETAOTR
/374 (Video Properties)|#47OJ THRELILETA D NS
1 ILb—LODAA La—KRHARTEINET,
ETADRRHFESNDERBICETA IR DEEAEET, V4R IIEIELHEHE
HIRREL L DIGEEHYFEIT N, BENBRFYREETAARTEINET,
BIETAI7ZAILDERE: RFLIZETAI74ILIE Dorico 7O HRMAIZIE
DRAENDZDFTIEHYERA, TOCIHNEESEIZEETIES . EIELTE
TANDT IO CANDEREZX . ETAI7ANLEERIZEETIDHENHYZE

ETAMNRAEINI-TOO RN TIETHERETE
BUWMERIE. 78— RILDO7A—DH—FIZ, T4ILLY)—
LWZ7AAVDIDYICZAROEET(IVHARRINE
ED

TACIIMIETAZERIEBICIK. EV)YILTIETA (Video) I>TH R
(Attach) 1Z:BIRL. RILETAI7MILERMALESLET . ETADBRFENTA/N
TAITHFEENFS,
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ETAERMIETITEET D vT—h—  FMLO—F TURKRHGE BIRIZED
HCEBEERT 518D Dorico DEEILT RT, ETAMRAFEIN TR
RETHFEATEET ETAERMLTVAECTH, ILb—LL—rEB( LO—FFtA
DEIE. TETADT0/37« (Video Properties)1# A 7AS & E AL TIEETE
F9. ¥ 177 EFKIZE, 7A—DAh—FEE )Y LTIETH (Video)>IT0
INT4 (Properties)1Z#2#IRLFET,

ET494 KRS T942 R (Window)I>TEF# (Video) 1% ZEiIRT 5h ., F—R
—kia—bAavk [F4] (TI4IE) ZERTEE ETHI4RDDRTIERTE
YYBZONET ., VVR DY A XEMEIL. TAD IR ETIEABL 7TV r—
TAVDBREREICEVTRESNET,

JL—LL—kEAALTO—R: Dorico I, 24fps M5 60fps ET. FAYTIL—L
DA LOA—FELEH T REOTLEDTOT7zy a3 L EFERE THEASIN S
IL—LL—FERIEKYR—FLET . KESLUVAFTTDHRETERESND
NTSC A (FTL—LL—H 29.97fps THD=H.KOYTIL—LDEA LD
—REFEATIVENHYET, /oFOYTIL—LDEAA LO—RDIHE . §TL—
LIFEMMICRIDIL—LHSIEFICESFITSNnETHN, FOYTIL—LDEA( L
O—kDZENE. 29.97fps & 30fps DMEIZHLHEERE 0.03fps ZEHEHEDD
(=, AHAISZA LO—FEBSDODRFYTHITHEONET . & 10 RERVV-ES.
AL LA—FFBEED 2 DIL—LAIUEMBEINET, 59.94fps & 60fps DfE
(235 0.06fps DEEICOWTH, AHOEENMEAINET,

Dorico Cl&, />oROyTIL—LDEA La—RIEEKEICfps1AMftE, KAyTIL
— LD La—RIEEKEIZdfpsIHBFTEET,

A4 La—FRIEThh:mm:ss:ff IO R TRRSNET . ThEh 2 Hr TR, 2. B,
IL—LERDOLET, FOVTIL—LD A LO—RIE, BETL—LDORMIZEYY
XFEL TR TIELKEIanVE#FALET . 2FY. /okAayTIL—LD 424
Lia—FI&T00:00:01:051 &R RSN FAYTIL—LDEAA La—FIF
[00:00:01;05 | ERTRENET

FSURR—RIAURY (F—R—Ra—khvk [F2)) [Z1E. BEOZBERICH
OO TRAALO—FERTTDIELTEES . CNEBRTBICIE. BEF T3>
DIB4L3—K (Timecode) JR—L T, 8L LT4RTFLA (Time display)1%l4
A4L3—F (Timecode)JIZERELET,

ETADEBERMNYY: RHETADEENYIIE. RA7OBELRELTHAES
NETETADERFISYIOEMMLGEELRAMTHICE. XY —ZHNT
(F—R—Ka—rhvbk [F3]). Y—ILNA—DIETH (Video)1 4L A—HREL%E
H)9ILTCETAIT—F—%FRRLET . [ETH (video)I7xz—F—I(F. I7x—4
—DHVDHEA. IReverb j7z—F —&lOutput I7z—F —DERIIZRRSNET,

ETA71—4—%32—r9 5L ETADERMNIVIEIA—TEET,
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RNITR>TETAZHERT D ETAVAURVICIE BIZTBEANYFOBREME
[ZH ST HTL—LDERNRTENET , Dorico NEEZFIELTNSEEICE
EANYRDEUEZRTREDTAUDNRREINGEEE L, [IRTEHEE (Preferences)]
DL (Genera) IR—CDIEAE (Play)ltoiavIiZh b EIEEICHBEAYFR
#3&K (Show playhead when stopped)IF Ty Ry IREFIZLET,

BEAYRIE FIURR—bI1R DD REY (fast-forward) / HERL (rewind)
REAVED) VI D F—HR—FICToXF—DHHEEIE. [+ & [] F—%FEH
LTEIDT CENTEET , F—HR—FICTUX—DRWEEIE, [F7] TEEZERL.
[FO] TRZEYEEITTEET, Windows DIFBE (X [Ctrl]] . Mac DIFE (T
[Command] ZRIFICIHTIET. 1 BTIEES 1 JL—LBERATEBETEET,
Mac Tl&, 7729230 F—DAETIHILT. R)a—L BEDOHESS, AT+
THREGEOHBEDI=OICO AT LMNMERT 516, [Fn] F—3L,6fE2 TRFIZHS
BIFNIELESEMGELNHYET .

Y—H— I—h—LF . ETFDOHEEDIALI—FIZRDITENTZINILT, B<
DEEREENICBIL-EIRESERZLGBRMEZRLEY . v—h—(&, TEEH#
(Write)I>T®—h—% e (Create Marker) Z:&RT Hh . F—R—Ka—rhy
k [Shift]+[Alt]+[M] (F74/Lk) ZERTEIET. BEAVROREMBEISEMT
EFT N—D—FRATDOHRIGTBEHEIZR TSN, N—H—DISR)L (TIAILE
TIEII—Hh— (Marker)J&ERTREINDB) (. TANRTARRIILDIT—H—
(Markers) 17 IL—F(2&H BT T—h—TF Rk (Marker text)]7O/\Tah, E£=1E
RHEE—FOT—H—NRIILOVWT I EFERALTRETEET,

I—A—/ %)L T—h—IL BB E—FDT—H—/RL
T REQTO—DI—N—EYRLRTTOROTHICH .

I+ IRV ED )y I HIET. NRILICERENT 5 B
EETEFET, INIE I2EAET TITV—H—DEHUE |
EREFHT. TRTAOY—H—EDSLI—FH [
OO TSGR EICEFRITY , &EY—H—DEA LO—
FETHERRNMIELLE, I—H—/RILDRADHEET S
T4—ILFELT LYY ILTEEAV I THRETEE
ER

I—A—IRIILDERD 3 FIHIZIENmp.jEWSIR)L
MV TWWET, ThiklNmportant] (EE) OEET
ER

BELGV—H—LE BENLGRBRITIEZMATESEIIENMBOTEETHAH L
ZRI¥—h—THY. Dorico DTUREHEEICEVWTEEREGRIZR-LET,
I—H—%EEGI—H—ELTERETDIZIE, EIZTmp 15 DF v IRy I REH
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R—N—DTHAV: I—A—DTHAUICETBAToavIE BEF T avIH
LLTEIT—H— (Markers)IR—YZHY, CCTIEAAMLOI—FESRILDESL
& LICERETAIMNERELELY., BOKSERBEZHRELIZYTEES, 740007
S)—, DA LFERIEFRAUNMIEB YA XEEETHICE, [EF (Engrave) >
A RRBA IV (Font Styles)IDIT—h—TFRARATAF (Marker text font)l
FIEIT—h—D A4 La—FRAI4+>k (Marker timecode font) IZ#RELET S

Y—A—DRRIEZRIR: TIAHIITE, I—A—[FTILRIFLATIRTIE 1
BLEDOERDLICRTREIN, IN—FL AT IFTERTINFEFEA I—H—DERT
MBEZLEETHICIE. TEERME (Vertical position)1Z#T#E®D E (Above
system)JE (XD T (Below system) | DWTHMIZHRELET, Tl &
A LO—FERADOERITI—H—ERTTHIELBIRTEET,

AAT 234 La—F%FR9 %: Dorico (&, RAT7IZAA LO—FRADFHGHEERE
ERLT, ZCITAM LO—FRERRTEET . ZMLI—RDEBRERRTHICIE. L
AT 9A T arDIv—h— (Markers)|IR—S%EEIRL T, [EEAE (Vertical
position)J&I 24 La—FDFER (Timecode staff)JIZREL-3AT. 241443
—FDERZXIENMD LIZEE (Position timecode staff above bracket)]l=.
ZEDELEREALO—FDERERTSE DIV AN AVNI7I)—ZEHRELET T,
BRI 34 LO—FERICEITE8/4LO—FDHE (Timecode frequency on
timecode staff)1ZXELT. A1 LA—FDRTE 1 /NG E HEETE, F=(%
ERT (AL FDERICY—H—TE1TERTTHIEE) MoOERTEET,
HHEE—RTY—H—2%2RS595 35 I—h—ICEEESNI=2/4 LI—FDELEM
BRESHh, RSN EETHOHEDIL—LIZHEMICE Do FET, it L
[SRIRSNDST—H—DREZEERTHICIL, BLBE—FTIY—h—FEF(FAIC
FSvILET CNICE->T. 70— DB ENSY—A—RHEEFTDITRTOT
URERIEERYESN, 7O—ORMBREICIE. T—h—DMEICEES T 5RO
TURNEEINET (R—H—ZFAHICFIVTTHETURN LY EITRSYT
FTEHETURNTOAYET ) COY—ILIEL T IVIEHEEL ST, &z 1E<—
h—% 1 DESYILIEE TNKVRINZH A —h—D R EILBEELI-FET. T
UIRADFEIE 1 DRIDY—H—LIEICBEDENSISLHEEE. SDEAER
TETLWER A CORIIEELGHREMEZRICOVTIE BEE—FTEALNSYY
DIREETHEVES,

BEE—FRTRALINSYVIEZHEET S BEE—FROI/LIYIBN—FHSh, 70O
—DTURERICR T DEBRGHIEET T4 HIVITITHEADLIITHEYFEL E
TADNBRMEINEE, I—h—LFAEINFETADIHDISVID . BEE—F
DARNNSTFARTVADRLEBICERIRIINET . A LIVI DD TURER
E£3DE. X—ND—DEBENYTILEALIZEHINES , EBLHRSUMITUR
TEEBATAHACLET. EV—N—DEEBEDERUEDRAENBRITITERF
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T.

TUR%ERH: Dorico DFEEETHAITUoRERE (Find Tempo)los> kD%
FALT. 70—2f 0B LETURERETEET . COVrURVIE, BEE—F
DI—H—INRIIZH BT TURZERE (Find Tempo) I/ REEF5) o 5LHE
7,

& Find Tempo

Flow: Flow1

Bealunit:l f I : - 4 l |
o L]
Tempo increments: m Allow Increment by 0.25

Tempos found: Markers:

Tempo range: 2 8
50 bpm 200 bpm

BPM IFO  NFO  AFO Timecode Text Imp. Fr.Off  TimeDiff.  Not.Diff.

Selected tempo:@=171 | APPY

—_—
[FoiRZ#E (Find Tempo)lV4 o ROZEFERTBHIZIEX. T—h—/ RILTHEL
&1 DOXY—H—HLEE (Imp.) [THEESNTLWIRELNHYET, COIF
VTCIE. IA—FDEELI—H—ITH L., 2ERIFAICTESLEFAWNMIEIZES
FINTTRHEELEIC, RBLTUREBRETEET,

ZRIOD - CEEOHEDBEMAEZRIRLTHS. REIOTTUREGE
(Tempo range) IRZAF —%ERALT. REXRETHTURD TRELEZEIR
LET OB ETUREFEREG 5L, ERIDIMBHEIN-TVR (Tempos
found) IO A EFHEINFET  RESM-TURE, EBELGI—H—DOFEHITL
—LA T DFYENETNRDI—A—DHAAISETNI-TL— LD TFHIZHL,
BIET)RARRTEINET,

IFO.NFO 8&U AFO OBREBIIZTNTNEELT—H— (IFO). EETIEAL
Y—h— (NFO), ZLTTFRTHOY—Hh— (AFO) DFEHIL—LHEEH®RLET,

BRIOIv—h— (Markers)IX+TIE. T&HEh =7/ (Tempos found)i')
ANTERL-TURD SYFHBGERIFONET  YUAMIEZE T —h—HRRS
N.BWTBRLETUREERLEZSEOEMLSETNIZIL—LDE (Fr.
Off). INK AL T DR TROENZT—H— B LBEDERZE (Time Diff.).
BIUEBEFEOLRICLDTaAL—23vTRDOINEIIT—H—UEBELHEDE
(Not. Diff.) MN&RRENFT,
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RBETURMNRESL, B ESh-TUR (Tempos found)IVREMSZDT
UREBIRLTURNTOIER (Apply)lRE2 %01y oLET, hizkYon—
DORBRMEICERLI-TURMNEMESN ., thDTURERIETATIO—MSHEE
SNFEY,

s

Dorico 2 Tl&. BFRBORRFICETIFHEELLC.EBEICETS 2 20O4T
2AVETHAVICET S 3 DDA T avNHFHEICEAShTOET, FERIC 1
DYORTIDIREDEEDEMN. ERDERD L. DEYTURPYN—HIL
I—IBEDHETATLERRDAEIZ 1 DOHFREEFEFR LY., KFFEIMS
LITEVA) VT ENTZREGRFES 1 DERRLEYTESRIICHYELE, C
oA ToaviEWhInd, BEICHAEEINSEEICEWTHFRESZHIL
=E5@EEHAHYET,

HAFEBNEEEEIRT S HFRENREICEHTIHFA I avonThhsesE
RIBITIE, LATIF T avcFBxSnizIAFEEE (Time Signatures)JR—
CEREET .

Time signature position and size:

A
)7 4

| =

o g

[a) E
)7 A £

ANV %

o) :

= ~ —

™ ~
Show on every staff Show once per bracket Show at system

object positions

ATV EHRET DRI LATINDOEEICH LB GEESIM TEERLET,
BE TKFITEIC 1 DFFR (Show once per bracket) JCT#EA TS o+D
fIiEIZFRR (Show at system object positions)J[ERIAFTLATI+DHIZER
LETHINELT. LI—TAV T RECATHERT 520D /A—rL AT IR TIE,
BELYRESLBHFESEERTHEHICTKFIMTEIC 1 DFRE (Show once
per bracket)1Z:&RI 5581 HYET,
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RIFMSEIC 1 DRRTDEFES: KFMSLICRRINDIRELHEFEST (.
BEOHEFREIYKIBICKEGEZIENDL, KEARIZHEDHDAR—REKIFIZ
REGYET, COH AFRBEOTHAVICETHA T avDERLHE T
BOICEEBTTOLET . CNIELATOMFToavIicHBIA-TRFRES
(Time Signatures) IR—U M oEIRTEFY,

Time signature design:
- § a “?g - A?? - §
A9 o)
i o )7 4
o —
SV 7
e &

~ L ~

Normal Narrow, serif Narrow, sans serif Plain font

rO—+U27 (Narrow, serif) 1A 73> Tk, EHRNGAFESOHFNDFO—
TAVMREERLET , 2D T+ &, Britten, Birtwistle & 20 tH#2hED/E
HEICRDERDBEMICFERINLDICUUENEBEELET, [TR—Y kY
7 (Narrow, sans serif) 147232 Tl&, Helvetica %#E DS OT AT+ 48
LI BNBRERIT B Y I ITANDBFERRALET . cOTAUME, BREL T
LEBEVY —LBFEOLI—T 17 AICERSN =2 EICHERINSLDIZHE
MEITLET , LEDOADLYIZ, [TFL—2T42k (Plain font) 472 ar3:&RT
EFET . chIMBFEBERTL—2742k (Time signature plain font)] (T§#
(Engrave) |>[ 74 FRBA)L (Font Styles) | THREEAIAE) TEELIZTA UM E(E
BALETH., SNIZIEFTA—F LAV TUoRARREM LD T+ RIRTEH2L%EH
TIHOLET,

T T ILFOKRENMICIEZENENBFESS 1 DFDORIRSN, TIHILLT
FRFEMOEEAMICHRFZA SN TOVET, BATKIEMEHGOERICE
HFREELRRINFTN, TIHILTEEBEORFLEELVILREHYET,
PIEMTOEANTZERORTHLEKIZ. TR TN DOERICERE LY KEVVEFE
ERRTEINFET, KIFICEIZ 1 DOAFREZRTIEIRIC, EFEITE
BOEERITESPLURBEROKIEINL 1 DOEFREEHEEFEITSL 1 20
TJIL—TELTRSKSIZTBEEE. BEF T avEMALTIAFRES (Time
Signatures) IR—YIZHBEIL. ITEBRBLUFXF—HR—FADXKIFEI (Brackets
for percussion and keyboards)1ZlBE—OXIFIMELTHS (Treat as single
bracket) JICERELET
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BE, TLES LU —LBEDOLI—TAVJ ADRAT7ERIZEWLTIL, #8FE
FEXRFBMDOPDLTIEGLLIHITHIAONAZELHYET . ChE BT BICIE,
HBEA T aUERAWNTIATFES (Time Signatures) IR—2 12 EIL., TKIEN
1T HEEARDEF] (Vertical alignment relative to bracket) 1zl EHiz
(Top)JISERELET

HBELF T3V DOMAFEES (Time Signatures) IR—2 Tl KIFIIZEFTh 5L
RO LIZ MFRBORTEREZIEETEET , ChIE. TIHILADA T3y
[T RTDOFERIZEKTFR (Show on every staff) IIFREDBEDRRIESIINTS
HXHELBYET RN 1 DDIHEE (1 14 F=lE 125%), RN 2 2H 3
DDIZE (4 £ 400%). EIUFERI 4 DLLEDIHZE (10 F£fzIE 1000%)
T, TN ZNERICEENRESNTOETS,

HEA T VDMEDHEFRS: 1 BELOER (BLUFTav il Tt
DFER) DLED. TUoRPIN—HIILI—VRBEDHBETATLDEEIZR TSN
DIFEE L. KFEAR., DEYVRXRLDAR—REHBELGEWFISBNHYETH.
FEEARDAR—ADBEENRELGYET . COBDIEFEESDEEL Carter
1 Henze BEDEHRICEHERDTHE R THEASNDSZLIZEKY, 20 HicEE
LT7—hEEOHHFTREICERLEL,

BFREDEICRRINDERIE. VN—HILT—I.  TUR VE—MEIILGEN
FIZRRSNZERLEBLTHY . CNIELATOAToaoDIEREHBR
(Staves and Systems)IX—C DIMEBAT Ik (System Objects) 1o 3>
25pBA T av &ERALTERETEET .

ERDLEDVFREE. TIAHIITEIRBEDHFREED 2 BOYAXTERIRS
NETH. CNEFEFTII>DTAFES (Time Signatures) IR—2IZHD
MBA T VDR EBIZR TSN SHFEEOIEE (Scale factor for time
signatures shown at system object positions)ICTEETEEY .

EROLEDHPFESIFIXLOAR—RESMWLEN =0, BOEVMAFREETDOT
PAUEFERTHILIETNIFELETEHYEE A LOLIBFESHUN—FIL
Y= 0T URERESDMBIGEE . T4 NTIERFEES MO TATLERIC
HLOYET . 20O BORENTHFAUEFERATNIETNODMET e /&<
TESH. —EBETHRMAHYET, TURDOUN—HILT—IZFHFEED LIC
KRSEDBEEIL. FEA T3V DMEFES (Time Signatures)IR—TIZH D
[FURBEUVYN—YILT—HIcHTRHFIEESDAE (Position of time
signatures relative to coincident tempo and rehearsal marks) |z FICEE
(Position below) JIZEELFET,
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RO LO\FEENNMNIBEESONDGEIE. LAT I T ar Dl
B (Bar Numbers) IR—J(CHAHTHBAT OV MIBICHHFRENH LB T
X/ EiEBZEIERTFR (Hide bar numbers at time signatures at system object
positions)1ZA VI L TNEIB B EIERTRICTEET,

RO LEDIBFESIE., DEIRDOLICHRRBALET DD ERALTENEERT
EFI MHEBRORTHETHOZEEZEMI HHEFELS(E. MEDODKR THETEH
MASNET ELZEIICEASDERELHY . END+RLEIEZEHEOHTVDIEEIL,
LROBRL-EENMEAINET . BEDOERIE. BEF T a0 DEFREE
(Time Signatures) IR—(2H A TINTHRICHK T HEF| (Alignment relative to
barlines)JA 7> a> TITHEWVET,

HFESDRIBNEMTRRENDGEE . 7B P FOTTIEGLAIZ, FEN
ERZOEFEZFERALTRIEINET . A BOERORREERE, BFELF T 3y
DOIHAFES (Time Signatures) IR—VIZHAIBEHFDTAL—aVELTRRS
N32BDEE (Scale factor for denominator when shown as note
duration)J&#ZHE I 5 LT, R FORRERLIZMER A TEET,
TNENDHRFESIL. FEE—FT [AN+KREF—F=IEYIRRSVITEFER
LT BRISHEARTEES . TRK Edi-TRI2avEUevh (Reset
Position)1ZfERA3 5L, A7V ORYELATEET,

VATLRKIYY

DATLESYYIE HERADT R TOERICENT, MIDEBMEHIBRESVERF
DEREBZICTD,. 1 —HF—AU3—T1—RADHERTT,

D

BNt

1)
BN
]

i of

1 ———

mf

DRTLRSYIIE, TIAINTRFRM IO I TRRSN, CORTRIFERTE
[Ea— (View)Ir TS RTFLRSYY (System Track)1Z:ERLTUIVEBZONET,
RTRDIGAE . VATLINSYYTHED 1 BELOERDO LIZR TSN, @FILES
BATY A, FSVIDEITRIDRRA U A—EBBSEHERERICHYET . VAT
LSV IDRRTREINDDIFELEE—FZTTY .
TIANWETOYRT LISV IDNRRSABVEIICT IG5 EF. TREHRE
(Preferences) DI £/ (General) IR—UDIEa— (View) o2 avIzH BT H
BIOSIHMIP AT LN YIERT (Show system track in new projects) %
YYBEZTAHIICLETS,
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DARATLRNSIYIED) VIS BE D RT LMY IHERKEIZZYET , [Shift] %
HLELSMD /N D LEIZHEILRT LNV IED) vy HE ERGEZEILITS
CEMTEET VRATLMYINBIREIND L, VAT LINYIORELV EIZE
MORIMNRRINET  EBREED L/ ZBEIBRAR 2 BRICIE S AT LS
VI DEREETIEEINDITARTDAVRMIIAVRD B FEEIRTHRIVHH
Y, F= DRAT LMY TERLZ/DEH DI RED/NEEZTDRD/NEID I/
HEBATEIRIUDAHYET,
DRTLNSYIDRTPIZ [AlY] FHRTE CRATLNSYIIZUXLT)YREDRE
BIZIEC=TUyRSAURRTREN, [AlY] ZHLERSDRTLRNSYIES)YIL
TrIYT 9 5L IMNIND—BEBIRTEET . ERETESE DEHRGDERE
FE#kIC, BIREGEOMIRICETNZNHIBREBEFERORIVHARIRIINET,
DRAT LMY DBRT—FHGELEDTY  NEHOFARL, Y RT L YIDER
HEDEAVARYILAVEDTRTOEFDRIREN S, 1 DDT7ILaVEET
FTHE BRIIBRINET . VAT LRSYIDERIL, hDBIRETHE>=ULA
TOrEUVEZ YT HLANEIZHEBRINET N R—CEa—¢&XvL—Ea1—0
PVBZISEVD TILERRENHIFINET,

F—hA—vay
Dorico 2 (&, 7R KXV MIDI aAvT4=a 7RV O—5—DREEFEFHIHEITH
St=ODHFHLLVY—ILEBEHLTOEDT, ChICEYBEE—FOKEENLESN., =
DEEBICE FA2HEDREBICEFHERTLDELYET,

L) 2 Con moto moderato in 2018-0% #lay mode

& I 51634116 K
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RALESYY: BEE—FDARUNTARTLA DR LEICRTREINDZA LSy
JTIE. TAP DT URERETEET . TURD T ST HIERTRIZENT
F.EETURERIBRROETILELT. RRITTURERZTEIGET 2 A
DFRDEEELTRRINFT  EEDNURILESIVILTRSYT T 5E, FDR
AMDTURERETEET , TOVRRAZ—DBEIZIFTNSKTURDFEAE LIE
DRREIN, ZEORAVEDTURDERNGE T —RN\v I ELNET,

BA LMY TRETURERDFRERLTEES . REY—IL TSV IEIYY
LT .HRDTUREREEETAAHET , YIORRIVERESZ -FFEICHBEISES
EEBBOTUREREZ—EICEZTAOFET . TUREEMNMEBSNSEEL VX
LOYYRDHREICEYRESNET  VALTYYRDENNSNEE, RIRERS
VOISR THEICE S B LTINS TURER DA LLLYET,
KULHON TERMGERBHIEILZERTDICE. S/ Y—ILEFERLET X
EZRmtE I 5 RAUNED)vILTh D, BRREMELDR TREETRIVILET,

BEE—FRICBVTREY—ILFLESIAVY—ILTEASN-TUORERIE, X0
T RN BN EHHILE#THI=D. TIHILLTREE—FTIEAAMRELT
KRTSNFET . oD TURENRIICRESEHI5E . REE—RFTRIRDS3%. 7
ANRTFAINRIILDIFUR (Tempo) 1 IL—TIZHBTFXRAL (Text) 17O/ T4%
HELTRRSEET,

BAEE—FCTURERZHIBRT AIZE, BIBRY—ILEFALET . FA1LNSYIA
DIRAVEZE 1 DT 29)v0 T 3T, FDTFUREENEIBRINET,

MIDI 3> krO—5—k5YT: TFRNEFNDAARYILAVMZ MIDI O bO—5—
T—RERETH-ODL—VEFRRTEDIIIHYFELI-. SDECARTRTES
L—2lF 1 2 TEA. ChTEHDO MIDI avbO—5—DTF—42% R TE
*9,

MIDI > hA—5—L—2%RRTDICIE A—bA—230 T—3%FERTHIUR
R ILAVRD RS IANYE —IFit=ITRBINRELE 9 ILET,
AVRRGIAVRDFTSTFIZ, TFDAV ARG ILAVKNIBT HL—UBRTEINET,
aAVRA—5—L—2DESYIANYT—D A= a—Mo, T—2%EKTS MIDI O
PO—5—%FRLET, YANIIE 127 D MIDI a2 T=aF7ARAVbA—F5—
FTRTHAEENTNET , T—ENTTIZAAShTWDavbO—5—(F, A=a—
RIZFRR)RY (*) THMNFIFoNET,

MIDI AV rA—5—0DF —bA—2a30 T —EDERRIZIE ZA L IVIDTURE
BEERTADERLCY—IILDMERSNET ShEY—ILIXE R DRA U MEERL
F. VI N —EDEHEEFSVITEHIET VALT)IRDREICEIZE
BADRANNEEZTIADHE T, A Y—ILIE 2 DDEDREIZEOHSHIN TEIRHMIZ
BT AREERLET . BIRY—ILIZBAFEDRAUMED v ILTEHELET,
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MIDI MEZFHL: MIDI 77AMIILEEEHTEE, M/ LMY IE LY MIDI av kA
—S—hoYIIZEZTIATENT=A = A= 3V ARVMNITRTIZAILIZEENF
ERS

TAT12

TAT4DEE TRENTBIEWSERDAZ)TENOETEY . A—T RS DIKE
BB TIE—RMLEEETT . NMAUTOFEAMIFICESLTT A, ERHEN
SHITTIEHBYER A ZER/EIIIVUNDER. ZEXEEBHETHEMASN
B52EELHYET L DOV IAVEBRBBD/INELGEEIIIVIZHTT. ENELD
ERICEEET HILICKY, KYEMNGEZOEFR., FIEHWELEICLSIRAMATEE
ERYET,

L -

|

(.
1y

3. |
iy “

hilll

——
=i

F .3 I
e —_

f

TATAODINv = DERIE, HEDEEBERY IV HIBOTFEFLES
BHYEETLI=AY, Dorico 2 MBEDTA 1P DI-HODFEREIZEY . ChiEBESH
gsL/T:o

RNEBRISHAT DL, DEETHEIAV AR AN T T4 % ERL.,
THERDHME. TNTNDERICITETEINILERELET, CSh LI,
Dorico MBI TINOLDERTZEEBLET . RO IL—LRUYICEWNTHEAT
B5T4 7142 a3 DEALIZTODVTIREZITEIBEEHYER A T4 T4OH
AR DR th TRIRE-IFR T 35154 . Dorico [IBEIZHLTETAI4P DL
[CA=V2DEREBBMICKRTIEET, T4I40o w023V BT LD, by
TANDETDIEREERLES , BU Dorico NEL B TEMERDHEIRET
BWNET,
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TATADEERT D TA4D40E. €230 TL—V—DEETHA XYL A
UMIBWTOAMERTEFT, VATL—Y—IF 1 ADBEEEEZEWKRTS1=0.
CDAVARRYIAVREREIT B EIETEEFRA — A I avTL—v—IlEe
BENELCERETEETIEBDABZEZERT S0, REITEHIENTEET, iR
DTAT1PEERT BICIE. T4 74P DRABRAUNERIRL T, TEBE (Edit) 1>
Mt (Staff)l» [T4I4P%ZER (Change Divisi)JZRIRLET, LTOEA7
AT MNERREINET,

> Change Divisi
Divisions
4 Solo2
& Solo3
A Solo4
81
LrL 2
L ||
Staff labels
Q[ sieffLabeis  + | A (Nove) v| #Flioop [7] A[lc‘_?"’ [2] a3 Q.000t l:‘ ) oif!% ™
I:.r,:m ccccc - HE—::guar v | [ 0.00pt :| i{cmml H E.&L Ll
Solo 1
showsaconumter: | Y v T i |

| —

FATAYT LEBDVRNIE. §HEDTAT42aVDBRRINET . FRICT1 T2
EERT HLEEICIE. TTuttilEWSIRNILD T4 J42avh 1 DEFTHEELET,
TAT42aVDI)ARDTIZH AT o avnN—mb, YVIRABLUEIIIVD 2
BATDTA T4V EFHRIMERTEE T, VIRNEEMTB(ZIFYAD T 1T 1
23> %iEM (Add Solo Division)l/h2y @ ) . U avxEmd5ICiE&
92avDT4T1423a0%EBM (Add Section Division)l7/R%> @8 ) #0UvoL
F9. BMLEVIRNERE I aviEER TR ROTITEMSIN Iz ERICHIEL
T AR TEDVIRNB LUV 3V DHIZHBIEHYER A WEeETESE
(T T IV DFERERICEDI2HIZ, Dorico (F7A—FhDTL—v—DRHBEHAF
HA FRENZNZIEELTWSIEERIRELTLET,
TAT4DAVITRARENTOSIRNLEERTHICIE. F4707 LEOY RS
T4 T42aVEERL, TOIERIARIL (Staff labels) €3> DTXF AR
ELFET, BV2a0INLIE BHBORMIBME. V2 avDEROICERICEK
REN, BETEICESH. BEICE>TETLIZFRUNEFERLT. EOTRIF
IETL—V D2 DEEEZERTTIONERLET,
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4707 LEBDTAT42a> DY A SBEET EBD TIP3V EERLT
[JIL—T%EBM (Add Group)l R4y @ ) #9Uvd 5L IavESHIC
GIW—TFI2FEDBIELTEET T IL—TIRNIIE T IL—TleSht=T14J1>3
VICBTAITANTOERICHTEIPRFAT, AVARYILAVNEDREICRRSE
NFETTIL—TIRNLVERETDEIE. TTA2—DICLIZRRSNZRIVE
FALT.TEXA# (Full Name) ] ETBEFR (Short Name) IZ BRI IHRETEF
ED

®EIZ.[T4940%%EE (Change Divisi)IZA47AST DT EIZH A TL—v—
LEIET IL—TL%ERTE (Show player or group name)lB LMY aVE
B%®KF (Show section numbers) DA T3 EFALT. COTATAPTE
FZINBEINVIZHL, LATIORFToa>nlER MR (Staves and Systems)]
R—JDHFEIZHKS (FFavIZHE5 (Follow Options)]) . EICRRIES
(TR (Show)l) FIEEIZFERTIZTS (TERF (Hide)l) DLVTIMTHT
JAVDEREELEZTTINEIRETEET,
FTRTDEENEOSEZIOKIZ V)V ITHE, TAT14PDEBRNMERSN .
ARBRRTSNFET, CNIFEBEE—FICHBLTIYIRRSYT F=(& [Alt]+[]/[—]
[CEY TATA O DEEEERTITAMNBELERCEEFT . TAJVDEETERS
NI RARB LU LI a0 TRESNTZEMDER (L. MIETEINILHHED
RISt 5. HBOMIBHENSRRINET . TP DERKLVFIICI=
VODINRE IS NEID— A HDIEE . L TELITRTDT1T4PDFERIC
F.TATAPDEELNHLIMBEFTL=V VOEFRNBBNICRRSAET . HE
[FFHLDVT AT ORERIC. BEDEREFAKRICEREANTSETTY,

BEDTA T CDEREHRET D BEOTAJ14PDEREHRET HICIE., T
TAEDHAAREZTTIVI)9ILET [T4T4P%ZEE (Change Divisi)1¥ (470
THRAVWTEREZTHERDIIICHYET, T4 T4V aVFHIRT 55, Hl
BRI DANCCOEBRICESN TV -BFIFHIBFRINT . BEBISERINSDTE
EL TR, 2O a %IRRT BR1ICIE, HIRARELEDTAI1PDHRMNDT
RTCODERZHIBRTHILESTTOLET . #HIT. UFIH>T=TA4J1P 12 ay
FEMOBERLIZEE . TRTOEFINETINET,
TAI4DAVEEET D TAI4P0DN\yE—CFSLIZHENTBIHEE. £2E T«
J42avD—MOHAERDHYET HIHE . LRERAKRDFIET, MG THHEICE
BIEATATAVDEREERTEFT  RICRREINDERIL. TOHEETRY
DTATLPDERETCERINI-LDEZINRRSINET, RICHETISHETA4
1CDEREERTHEBE. TONRIEROBEORBHLENSENAET,
TATAO DI E—CFRT TS TAT4PDN v E—DFRT I HEEF A
ERETRTHEDOEFEIARFEERL, [HEHE (Edit)>TE@ER (Staff)I>Tk
Yy T4EET (Restore Tutti)IZERLET . chITKY. FAT7RTERTTH
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L by TR Ay 1 DEFDGEET IAILCD T4 T4 DEBEIER
ENFET . COEENHBORTHEIVANCHIEE. TAT1PDERLMED
BRTHREOMICHL/NHFEIE/NEO—EIC. BBMNICI=V U DERNRRS
nEY,

A=VoDINvE—D: TAIAPDERTIAZVVDERERIRT HE A DFE
R, SHIZFMDITRTDTA T4V DERICHLIELEFNBFREICBYET,
COEREEMNIRET HLETEST . TAJDOBRICMAFLERIFDTA
TOERDOELEFICRBENET,

A=V DIy E—FHRILPT KT BIZIE TEa— (View) T EFERFDOHS
— (Note and Rest Colors)I»[Fqi4>a =Y &M@ (Divisi Unison Ranges)]
TREZUVEAONET . A=V 2D\ E—VICBT 5B PRFEENITL—T
RRL. EEOTAI4ODTTITIVERFILPILLET,
FELY—RADEFREZEBDERICRTTHDFEMTNETH ST, Dorico A
TATAPDERICA=Z VD EREBEBRRSELBHRR LT TITILOFELEIC
(FDLEMNYFIRNHYET . CNIETA T Dy E—TUhFIET SHTEESHHE
EBROBMRRLE. FETA T4 D\ vtE—U N T LR EGHMEEDRKR T AE.
WITRICBVWTELRRTY . £9 FIToNSFIRIFIRS—IZETEILDTY . T4
AT DN E—CBIRMBRIRICHIZORT—IE. T4 DERICIERTINE
FACNITHL T BIZIE. TAT4T DN\ E—C DRBMEZE RS — DR E
FTRISE. EOERETAV4PDERICFEMTIE—TFTURR—XIZET . FH
FRDBEES DA ICBFELET . £ AV TRIEIAMVDERIZLMERSL
FERAD. BFEMNRTERET (NTEVRE) FEEBIZREINET,
TATAPDERNSA=J VDI TUTILDERICRIRAVMNIENT, A2 D
EREFEGLIEMREMNERAINTILSIZE. Dorico [XBEULEBREELTD
AERICEBERLETD. TOR. ZOERDEFEDAR—V VT MNETESIL
DHYET, AIRETHNIEL, AU DEREFRLERBEBITRITTEASLIIC. Ta4J
ACDNYE—V DR TREKIYATIDECNCEYGEBOERZFEALTZS
LY,

TATADEERIRNIL: LATOMFToarplEREME (Staves and
Systems) |IR—UI2dH ATHZS AL (Staff Labels) |2 av(id. LFD 2 S
DFT=TaA T av PN BMENTVET,

n FIL—TR%ERE (Show group names) &, REDL AT ILTERSANILD
EXBHEBMOVNT AN FEIEAADNRREINSEEICHESTVDIGEEDH
BMELRVET . CNDF U DEEE AVRRSILAVREITHOOTTAT4PD
TI—TIRN)DBRFEINET

= BH3VR%EFRT (Show section names)JIE. TA T4 DT IL—T b1

ARYILAVRBEIMNRRENTNENEINMEADLLTRETEET . COERED
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HBRERGELTIE A= AT ITIE T4 742 DRI aVEDERT
FHETH BEOERINIVEIDBELGWVEENHYET TIICHIERITT
RT (fz&z(E) Violin | BEETIIENALNTHY., BRINILERRLTE
FRGEROSMAILEMINGVGEEREICCOREEFERALET,
AT avDEEIE (T4 T14P%EE (Change Divisi)IFA7AT DITL—
Y—REIXTI—TR%EFRTER (Show player or group name)IELUTEHL 3
L &EB%ERTR (Show section numbers) AT avIc&ky, T4 DERE
DERFEICEEEINFET,
TATAVDBE: R))—RATE TA4T4ZDITITIVET AT VIRRDIT
DT7ILEEDHT. 1 DOFYURILTBESNDS-H. BGb5EI a0 BICHERSN
BERIBESNTLET , Dorico DEEDV—RATIE, TAT4PD\vtE—2
ADFVIARE LV aVEBRDF o RIVICEIYETT, T47420/8vE
—COBREICBVTEN - REMEZRETELLIITTEIFETT,
R=ANERIZEFDT1T42: K= DEI2avTL—N—ZT1T4D% &
9 %154& . Dorico [ETA4T4ZD\yt—U M BASNAEAIOMEBEDR T E
(<. S—hRE D RENE B EIMISRRLET

A
A
s Bhe—eo¥t 2 [
o o
a DC-O. S. a DE_'-O,
A
2
ANI V) L7/ |
!) r
fac - tus

FITAT4ODIRE—U D EDOIMEDRTHETE, T+J4PDERETNT
NISREARTRSN, RYED 1 DOERICOVA—FFELEFT,
COHEEBEBTBICIE, BEF T DI T4I4P (Divisi)IR—DIZHBFEE
X OHBERIRIZHDI T T4 DHEFR (Indicate divisi at end of system on
vocal staves) |+ T avEEBELEY,
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FviT7

TVSTIERKEDNyE—DDIDOYITERLTHIWR B/ \vE—CFRLET,
hE, EHTEERICER T HEOHENHRE T OO RGLHHABOER.
HEINEKLYEENBGZLGN—VaVERTTHEIGHEEICERINET, Dorico
2 X AVIT DIy E—DFNES 5D BIELGHEEZEALTOET,

— 8 —

 EEE e——
ossia e jate 51—

H : A‘J'T’l"-—
e =——re
- o

TV TEEMTS: AV TEEBMTBIZIE. AV TDERERTSEHEHFEE
BIRLTHSTIRE (Edit)>TEER (Staff) I>TA YL PZEEIZHER (Create Ossia
Above) | FE =LA YL 7ETIZIERL (Create Ossia Below) & #ERLET . ET7/
PZDMDKERZFATIIVARYIIAVDEEFERLTLNT, EFWLWTH
DERERTT DTV THRETHAGE. AFEREEFEROBADTTY
FILEERLTH S, [y 7% EIZERK (Create Ossia Above)lEf=IElMAvd
F% TFIC{ERK (Create Ossia Below)Z:#IRLET .

TVITEERTEDD(E, VATL—Y—DERTEHIAVARYIILAVIDHTT 2
92avTL—N—hEETDAUARRIIIAUKNIE, TaI4S D FEERVTIEEE
KROEMEIITEZFER A RFRIC FTEBEXINDAV AL AVMIZ AV TE
EBMTEFLA AVARYIWAVMIEBEICIIGSCTETOWThOAIZEA Y T%
RRCEFITH, ERORLCAICIE—EIC 1 DDAV TLORRTEEE A,
AV T DINvtE—C DRBME. BLUF VI TOERIMNEASR THHEIZTHA
FARREINET, CHoDHARIE, REE—FTERLTFSVI LT F2F
[Alt]+[« ][] THYDTEFT . HAREEBITA VO T ORBEES LUV THE
LBELET,

AV T#BIRT D AV T DN E—CFEIRT BIZIE. AV T DI vE—DD
MiRIZBH DA A RERIRT 20, FEA VT DONRvE—CROBTFEITKRFE
BIRLT. TR (Edit)>T3lER (Staff)-TRZHIER (Remove Staff)1ZZ#IRL
F7,

T T EEIRT BIEE. ZPA Y TROBEREHIBRLTOELRY (X, B/FIE
BICRRSNGGEDETTHRERLEGITHILITSERELTZEW, RIFERLCEE
[CAVLTEBERT HE EFIFBURTEINET,
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ER: TILIITIE AV T ORREBEDERD 213 ORESTRRINE
T, CDBEIT. EFEL T a0DIMHR (Staves) IR—IZH ATV T DIERE
(Ossia scale factor) ICHEITEE T,

TV TINRRSNDEUEBEERET D TIHIITIH AV TOERIETRATD
LAT INIRRENET N TV TEREDRED/A—I AT INIDARTY
BHIER, AT DHZRERT HIEDIFINEY LS IHEELHYET . LAT I
TV TERTTDINEINEERTBICIE BEIZKHLT. LT IAETard
Mg & L4AER (Staves and Systems)IR—TDIA YO TPELVEBMDESR
(Ossias and Extra Staves)ltoav(ZhbIA v FPERER (Show ossias)l%
FUERRIEATIZLET,

INETIRZEHE R AV T DIMNAIRER ST DAV DERICEDKIITHEE T DM
DNTIE, HIREN TO A EETHERASN TOARERUAVKONEELEY . A
YOTFDFRBESTRT VT ME/NEROMEIZHDEREL T, —ABD H AR
TV T DFIRNELR THEDHAZ A DERICEASEFI N, D HR
HIFRTHEDHTHRASE ., SHICHOERIEEA YT EA U DEREE ST
EBSEFE A,

FTVITEAMUDERIHEESELHEE, — MO HRAISMDERICERTLIDE
EICIEZRD/NETIR (RE ILHER) ZEALE I A, D ERAEEMNHOYIZEERD /I
B CH YT ER/ESEET,

Dorico [&. SNoIT R TORERAIEE T E=HDA T avE, EBEF Ty
DOLINGER (Barlines) IR—2IZHBIA YT (Ossias) o3> TRELTLVE
9,

TILT AV ARYILAV DAV DERDEICRRENDIZE. EAEET /D
BEFEROTICRTEINDGT YO TREE, HEF T3> DTIMNG#R (Barlines)]
R—=2DFTavDBBIRABITHIDOLT | BITAMUDEREFAC/NHRTHS
SINET,

FVLTDINI: VT DERDEBMEIC ossial EWVSEFEDINILERNE
FRIZE LAT AT a> DIEREMB (Staves and Systems)IR—T 0D
Ay 7HELUBMOGME (Ossias and Extra Staves)1t€oiaviciHh b4y
FDRIZSARILERTR (Show label before ossia)lZAICLET , hRARZLSA
IWEFERTRIEEX. TFYSPDSR)L (Ossia label)jZTHRAL (Custom) ]l
BEL. [HRBLDA YL PSRRI (Custom ossia labe)JITEEDTFFALEA
HALFET,

FISTDIRNIVEERINILDNSGTFTRELIVIR->THEE S, FEF T3
CDIEFER (Staves) IR—TIZHBIA Y7 (Ossias)ltzriavIZERINDER
BEICHOTEESNE T . 1 DDA VI TERITHIINILE, FFRIITRT LG0Tz
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AV TRERRITAHCGRIVICIE. ZNENERICHERZERETEET,
INTDRPTRBERIIE T T34 907 Ay 7HING D& CRIIAE LK
T9 51538, Dorico [FREESN-TTIT7ILDOERISERREZFITELT, BF.
BREFRES . (TRTDMDTATLAF YO TREROBRTHEICEIZHEELGLEKD
CLET. EBICHITRTERBORSIEHAHTTIICIE. BFEFTaoDHER
(Staves) IR—T DAY 7 (Ossias)l o avIiH b4V TRBAMED#HR
BOEER (Extend staff lines at start of ossia) IB LU AV PR TREBDHE
BOEER (Extend staff lines at start of ossia)I#ZELFET .

HEEFCAYIT: AV T7HHLMETHIBLZDROMER TR T TH1545.
BEOEREERIC. AV TOEREESLASEHBEOMBLETHEES LIZF
INEWNGEERHYET . —AT. EDA YL THNEMD AU ZARSIL AV RTIHAEL
CEEHRABICT SO HBEORBHNEDERRESJVRABSNSHIEEINT:
AERBEMDENA VI THBERTIONFELMEELHYET,

Dorico [FWWFNDAELAREELFE T LAT A ToavDIEREEE
(Staves and Systems) IR—CDIFyL7HEIVEBMDEESE (Ossias and Extra
Staves) 17> avItHAHTHEBEEE-CA YL 7 (Ossias crossing a system
break)1ZlEZEREEINDEEEEHS (Include in preamble) - IFERETE
HDEBZEKRIN TS (Exclude from preamble) JIZRELET,
ERDAR— VY AT ERIETIADERED T IAHILEDBEREIL. LA
ToRETLaL DIERDAR—I DY (Staff spacing) IN—IIZ#FHEFRSNI=TFY
LTFRERNDERET (Ossia staff to staff) IDIEIZL>TRESNES , COIEEE
(X, BEEAROMEIFRHADEZEELZITEE A,

BRIDA v THRETNNBT DA DEREOERIL. BEESY, FEE—
FCHERDAR—IUTY—)LEFERATHILTRETTEES AR TIEEAIZ/N\Y
FILBRREINETH. AV T TIEEBR LDV TRROREBAEIZ/N\VRILH
RINSNFET,

oL TEBE: AV TERRODBEFEBESNEEA,

AR AV DHEBDOBEEET D

Dorico 2 Tl&, 7A—DEEDRA VI TIU AL AV DEREEEITBME
FIFHIBRTEET  EXAE ET/OEET 3 DFLEFENULOEREET S
FOLEMIGERDEELAREICAYET,

BMOEREERT D AVARYILAVNIEBMOEREERT DHICIE. BIMDE
ROFRMET, O LN TICEBMOERERTSELVEROEFE KA
2T THRE (Edit)>Til%& (Staff)1-T EIZHEEEB (Add Staff Above)]
FETFICHEREBM (Add Staff Below)IZEIRLET . TOMEBITBINDGE
ROVERSN, BN (FF=IFHIR) ShIEROBERT HIRARREINET,
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AVRRYILANEYATL—N—DEDTHITNIEHYERT A, I3 TL—F
—hHEETBDA VAN AVIDERDRIIEETEEF A T FTERTILD
AVRARYILAVNZIHEERITEMTEEFE AL

EMOERZHIRT S BINOERZTHIBRT AICIE, BINOERNRTEINA TS
MEDHAFEBIRTH0. HIBRTHEET. HIRLE-WEROEFFIEIKFE
BIRLT.THEE (Edit)I>T5ER (Staff)I>TFEZZHIER (Remove Staff)1ZZ;IRL
FT o SNEAVRARYILAVRDIZLO NS HDER, EXIEET/OEFERE
EFDERDEIBRICEFERTEET (FzFZL. AVARYILAVMNIBT 5T R TDE
REHIPRTAHEETET, BIZ 1 DULEDERARTINTUVETNIEEYEE
A)o

BINDERDOBEBMELEIRT H: ERAVAEEDEP TRIBE TR T THLE.
CORERELIIETDMETRRFITERTICSELNGEEL, HEL2KDORS
TRESEEVWEEIHYET . ChIX. LAT7OTToavnlEREMAR
(Staves and Systems) DAy T7ELVEMDHEEE (Ossias and Extra
Staves) o av(lEBMEh =T FE-(XELRICIARSFCEMDHEE
R (Show extra staves across full system when starting or stopping)lF =
ORI RACHRELET .

THDEREIERTRICTS: AVRRYIIAVNERSN-BNDERIE. LT
AT DIEBROAR—L Y (Staff spacing) IN—U2H AT EHOER
ERFODAVARRSILAVDE AR DFEREFERRICT S (Allow individual staves
of multi-staff instruments to be hidden) 14+ 73> DELEE*Z(+EE A,

P S DER 1T

ATV AFEIE FICEBICIEEESNGMINEBRTHLEERTEITIERT
BEHICHERASNET . FEDMAINEVRS Y A E—RIC AEEETEMNILESR
BIT—ESNDEBREINET  FEMSFWZ RSy aE— RIS BRTIHIE
ALIFIBTREINED ., FREICOVWTITFITHREL LN EBIREINET  AIE LIRSy
Dot #FBIVXIYIRELEEINLIHEELHYET, Dorico 2 [F.2D 2 D
DAZYLAFHEIZDOVWT, GELGYR—MERHELTVET,

ASUDatBig: ASYVARETEMNY 52— FHEGHEE. RSV Bz ERA
FTHIETT RSV A fBEEFERT 5L IMNTDEHBEERS Y 1 TEHH LI EN
TEFET . AMBPFREICHR LT RSV aDV X LA BEMICRESINET,
f=&Z1X. 44 DIMNFTIX 4 PEFDRASY 2 4 DHARTEIN, 6/8 DIHFEX
TR 4 REBERFDORATyah 2 DRIRINFT IBFILBEERTHL. fElEA
DAY aDTalb—a i BEMNICEFHINET,

Aoy afEiEiE. 1 DU EDNEZEEIRLTHS, [R5 (Write) I"TRTY 248
B#{ERL (Create Slash Region) ##EiR T %H . [Shift]+[R] THHEREDRYTA
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—/N\—%FE. Tslash]&EA AL, [Return] ZMLTRYTA—N—2HELET,
BRUET2L—2aVO&EBEICRATYD 1 BEAMERESN S ELEDIT, TITAHILLT
FRIYL1DERNMFRBTEBRREIN, AZVDaNEBEHO—HTHLILE TR
LET (CAEEMICTBITE. TE2— (View)] » RSV 1EEZEREA
(Highlight Slash Regions)1Z&A ZI1ZLEY ). xS5wS 14818 ORI E L& T 1L
BIZHIN\URILEFERTLE. BEOMmmENSEEELFYROHI-YTEET,
1=, [Alt]+[)[—] TRSvS 148D REEE DB, [Shift]+[Alt]+[—)[—]
TRIYVABEOTaAL—2ar OEENMTHRAET,

AoV ABEERET S EAFEEOETTHMLEBEREETALLE XS
v atBiEE 2 DICHETEIENRELGZEELHYET . ChIZE, FrLvkER
RSETRIYABEEREITHMEICBEIE. BERY—ILRYIRADEESHY
—IEI)9 T BN U] EAALET RSV aBENFYLYMIET 2 DIC
NEIIN . LR FBRFOBEEHOBBMLBEDNVRILERICRSYT 5L AR—
REHERTEEEOANRETETEET,

AL ABEICH TR BERFREBICBVTIE. AV alitmERRT
BEMEIMITDODNT, SEIFLREHRBMNFELET , Dorico 1§, TIAILNTHE
EHFOTaAL—av DRIV AlCEfFRERTLET . =L, CORE. #
EA T OIERF (Notes)IR—UDIRSYL a8 (Rhythmic Slashes)lt
2 avIcHBAIEEAFIZEITSHRS5yia (Slash regions in compound time
signatures)J#A 73 CEETEET,

A9 a®NE: Dorico 1ZIF. RSVYARBEONRTHAUNKEBERAEINT
WET, Ll BEAF T3V DIERF (Notes)IR—CDIRFYL 1/
(Rhythmic Slashes) ]tV avICHATHFEBHBYDRAFyS a (Slashes with
stems) 1 ETFRELDAS Yy a (Slashes without stems)1ZE/RETHIEIZKY.
BEDTHALDHhNSEEDNEEERTEET,

Aoy aFEREE: RV aBE&SYLFERLG) X LDIEREETALE K. X
YT AERREFERALET ATV AFEERICLIA NI ZEDERICELSD
AHEFSTKRILTY  FfZL FEELI-BREEIRTLEEESN, TIAILLT. A
ALEBRFOHNEOHNDYIZ 1 ADRSGYLaAMNERDE 3 RICKRFIINET,
BFEOERERTY AMEEICER., BLUZTOHBLTLERIAFET . TOE RO
FOEYFRIRESN . REOEFRICRLERICIEETENETS,
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AoV AREEROERDOANZFRICEHABT HICIE, N5 (Write) TR
A{tEEERLE/ER (Create Slash Voice) Z:&R3 5. [Shift]+[Alt]+[V] (T 7+
JLR) AT UREAALET . COATURE. FHRICELZDENZEMT S
[Shift]+[V] < REBLUZESTLVETD,

[Shift]+[Alt]+[V] O FERYRLANTHE BMENDEZXTV 1 FZFEHDA
AT FEHBYDRASY 1 (HRELAE). FEHYDRASY 2 (HEEFTH
E). HELGLORZY ADIETYIVEDLYET . ZEDF LRk, FvovbDE
BlOAoDr—a—IZ[EThhDBMEINSFESOBEENRTINET,

AU aE—EANTEE. CORTGYDAFEBREIEZFDA UV ARYILAVIDE S
IZCHEERTE. V] TESHOUYBZZITESIEEICIE. RSV TEFEEER
RICEFENDELSIZHYFET,

RSV aAEEFHDIAMTEEETT D AoV aEFEICYXLERESREEA
ALERIS, FEAEHRBLDOASYY AITYYEZ LB EIX. A5y ad55
1 DZE#RLCT.IWE (Edi)I>TFE (Voices)I*TRSYLaFEE (Rhythmic
Slashes) INoFH LT EF A TERINLET , YT A2 — Mo IZEDER
(Normal Notes)|Z:ERT 5L, FEMIFELEDFEICERSN ., EROMBTA N
DERKRDEYFHIETINET,

AU BEIZENTIH BEFOVT DDAy aF - (IRMBMENET
BT NADNUFILEERLTHS, TANRTADIRFYy 2Bl (Slash
Region)17 V—T12HBTHREEL (Stemless)ITANTA4EFUIZTBHIET. R
Y ADHEHYERELLEVYEZONET,

REOAREZEETD: FEHYDRSY AITENTIE RSV atEFHOT
TJHILEDFRDAME LRAZIZTEHNTRESICTEN . ZBEDOFIERMEAET
IEETEET . [#RE (Edit)>[FEE (Voices) P[HEBETIHILNTCLAZIZTS
(Default Stems Up)I1FEIEZIFEBETI74IFTTRAEIZT S (Default Stems
Down as desired) |Z:&RLET,

RSy aBEICE VT SEEFOVWT IO DRIV aF (SRR ENMET
HMEVTNAHLDNURILEERLTHS, TANRTADIRSy 1488 (Slash
Region) 17 IL—TI1ZH B EEDRE (Voice direction)] 7O/ \T4%&F4 (2T 5
LT REDARAEIEETEET,
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ERNODUBEEFET D TIHIITIEH RSV aBEHERTY A FEFERIE
WINhBERDE 3 RLEICRATYD2ERRLTVWET  ERLEORERFWT D
FLFIBTERTEET . TNENTRF YL a4l (Slash Region) £ XM EFH
ERFF (Notes and Rests) 17 IL—T1ZH B RA5vLaDEIE (Slash pos.)170O
INTAEFVICLT. HETHEERELET . 0OIDEILERSE 3 BRISHEL. T
FJRADYEFELEIC, AT RDBFEITICRIV 2B HIEET,

ATy ABEATE DR ATy AN DFRP TRIBFELIEERTLTLS
S5E. ZTDINDEYDHAERBTTIEDHEIRENESH I, LD FTHMNERDE
CREBIZHIMEIMZE>TEDYET, TIHILETIE RFvP 18- T RTE D
MIHICENW TR LN EARFTEOLSELET . L. TANRTDIRTY
a8l (Slash Region)1¥ L—FIZH 5 TR E LVATOKRFZIERT (Hide
rests before start)IEFUTRTHRBELIVEDAKFEIERT (Hide rests after
end)]7ONTA4EFUIZTBHE RFORTENFITEET,

AL AFERRERNILSE S ATV aFEFMAMDRTvL 1 FEFEET
(FEEDFEBER I T ZI5E . Dorico [, RSy aftEFEDTIHILEDEE
LOEREZLEEZLT. 2 DOFMINEEIRKERLENKIITLET . Ry aft
EEBOAT YD AR—RIL, BBHEA T a>DIFEE (Voices) IR—UDIRS
A FBEDBEE (Rhythmic Slash Voices)|J IW—T2&H 57 T avIZkYRE
SNEY,

RSy EBERITRSR: HERTINCRIVD 2 E2FERATHICIE. TITERBXYE
#MmE (Edit Percussion Kit) #4705 #MEFT (REE—FDTL—r—X
RILTHERIL—V—OA—RFEERRAL T AV RARYIILAVEDIAVTFRAIAZ D
— WA AT7OTEREET)5 MELTAI—TDTILIVN—DRTYT RS
Y2 BOSHEWITNAEFERTAILT I TERFUNIRESOYFEEIFELZLD
AU AHFBMTEET, ITESFZTYNI 1 DULEDRIYL2DEYREEMLT,
BERHERLEOMEBICRETEEY,

BEROANCBEVTIE REIF—2FRALTEFYNFDELE DAV RbYILAV MEE
BENT 5. FYMIBMLIZRSY A THNIET R THEEICEEFN. ITESRF
JEDMDEFDA N EFSTKBRICRTY 2EANTEET,
TEFZXINDRTY AL 5 REORRIMITEAFOHARRIINES, UK
FEEEHNDADRRYILAVCDRTRAATITOYEZ DL RSV aldRRTEINE
‘A,
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N E—RES

INYE—REES X, BID 1 /&R, 2 NEEIE 4 NEIICEFENSEREE 1K
FCICIRYR T CEEEREBITRLET . COEBADKREITEREICESTEEREIC
BERGELEDTY  ERNHICHO O TERAEDFEFFESHEIN TV DL DIEHH
Dl RYITEENMBRYBREINEERNLGEONEIIDHERSBEITAYET A,
INFE—FEEBZERATAHEHRALTLY, BYBRLTWAIEAHABIZHMYE

9,
T T 0
-

INEY E— Bl BRYRLAREGDEFEANLIZER, ROPDEHASIEFEY ., /IMNET
JE—FEBERFSEDHEADBRHOYETERIRLT (CIIFRIFEEETEET).
(FEEE (Write)>T/NMETUE—REEIBIZ/ERL (Create Bar Repeat Region) Z:&RL
F9. COFIEICKY NV E—MMEEAERSINE T 1 /NEIUE—FESHEIR
SEESEICRTINET, LEROMDYIZ, [Shift]+[R] THEEEDIE—IEED
Ry T —N—%FE T%IZ AALTHID 1 /DEIT%21THIO 2 /MEi. T%4]T
HID 4 INDE—FEBEERLET,

INETE—R B EER LI ICRYR UM BEEE T HI2(E, METYE—RES
OLFhh, F-FEFEORNEEREICHIALNURIILEERLT, TO/AT
AN\RILDTINETE—M B (Bar Repeat Region)17 IL—I2&H AT /IMNE#E (No.
bars)IZ7R/NTA DEEZEFELFET

INETUE—MEIE., TIAHI P TERNKBTERARTINET . RARTOA I/
AI7EUYEBZBICIZ . TEa— (View)»T/MFYE—REBIZESEE (Highlight Bar
Repeat Regions) |1Z:&RLET,

INTE—REEBE AT S Dorico [SEEIRIIC, /M E—MEID LI, #82Y
RLUEZE#MDOAI U NE—FERRBCTRRLET . TIAILTIE 4 INEIZEITHDY
EARTREN, BERO/NFMNTLIENIUESNET  F2EXE 1 DDEFO/NED
#I1Z 3 MEIREO/NETE—REEANTEWVBE. 3 DHDNETE—REE M4
EATURENFET, TIFIEDAIUINEREZEET BICIE BFEF T av ol
#iJE—FEEE (Bar Repeats)IR—TIZH BNV E—FEEORIBD AV
n INFIZEIZERR (Show bar repeat count every n bars) 12X ELET . h o
FE—PIRRSELZWNMGEIX. [IMIVE—FEB DAYV rDSE (Appearance
of bar repeat count)1ZlJERR (Do not show)IIZERELFET .

. ;
N
N

COTIHIEDHREIX, BrD/NFIE—MMEEZLIZEEETEET, TO/T1
DTN E—MES (Bar Repeat Region) 17 IL—F 2% 5ThoUMEE (Count

frequency)1E =LAV D4R (Count appearance)|ZAICLET, [h
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RBARELE (Count from)1TA/T %A 2T BE, Dorico BNhI U ERIET
HEMELIEETEET,

INTJE—FRBBDAIDITAU AR REAINEERTHICIE. S
(Engrave) I’ 242 FRBAJL (Font Styles)]T. [IMAYE—MEEDHIUE (Bar
repeat count) IN AU REAILERELET,
INRVE—FREBDLIZRREINDIBFOFMAMLEL. FEE—FTIVRFEE
[Alt]+ RENF—TFHYPTHIETHRHETEET,
INFVE—RREEETIL—T1ET 5 RAMKOEWIL—EEEF OEEITH L
TIE MFVE—REBET T TBEICE - TEDREEETRT EMNEFELLY
HBENHYFET FEAE 4 NETEHOBEZF DEZICELTIE, Fo1=<RAL
200 4 IMITIL—RERDEIICRRTEET,

J ) @

[V 4 s J ¥ 4
A0 F A y A
|
_I r
(&)
- J o g [ 4 L 4
B i e A FA

FIF RDESIZ 4 NEHERIZEST IL—TETEEY,

S ) ) 2

s J o g7
Vi F/ i)
I r
4
H 1

HEYV—RTEHYFELAN. 1 2HD 4 PEITIL—XIE RD&KIIT 3 /1
BHDVE—FESEEALTRTTHIELTEET,

VNIV 3

.7 S 4
|
I— r

F /740
B 7
F/7 7

SOIN—TEFHDTBIZIE U E—REEBEOWT D, T/ E—HE
BOmmZHINTNAODNUEIILERRL. TZONMFEHRZEIZTL—TFE
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(Group

every) I 7ONRTAEEEDQ/NEHITHELET . 4 NEITIL—XETHIELE
2 3 INEIDUE—FEBEERTITDIZIE. BEF T avnlMGFUE—FES
(Bar Repeats)IR—UIZHBTTIL—TDERY 3 MOS8 (Appearance for
three-bar remainder of group)l#l3 IMNFYE—FEEEZHEH (Use 3-bar
repeat)JIZERELET .

[Shift]+[R] TRYTA—N—ZFAWNTNMHE—FEEZERTHHEETH. T
—TIEERETEFET  2EAE TWLAIEANTEHE 1L IMNTDVE—REEZE 4
INEISEIZT I —TL. T%2,41EANTBHE 2 INTDYE—REEE 4 INEIT
EIZTW—FLET VI —T1EiE 1 /M. 2 INEIFERIE 4 MEIZBLTOH
EETCEET . ANSNEBFOHAEHLENEMTHSE Dorico A ¥IETLI-5
BlE. TIAHILMKEE (FIL—T L) (TBYFET,
HLENSEIBUBAELH D=0, INFTUE—FEED T IIL—TRIFEEIZITEILS
[TEEL TS,

1 DISFEEDONT/NETE—REEICRBE SN/ NGBS O&EE K, LA 7 UM
Tav@UNHES (Bar Numbers) IR—UIZH AT RAFE SFUHE I/
DE—FrREEOTFIC/IMHEBSOHEZZET (Show ranges of bar numbers

under
multi-bar rests and consolidated bar repeats) |47 avE 4§ 5HIET 1

DIEEHLNT-/INEE—REB D TFIZRIRTEEY,

wmeEhAOEFHY—IL

Dorico 2 [, TILFR—Rk ITHRTA—KRE)T1—R L FEHERADEEDR
FEIVOE—LE ., PO —RNLTEEET AT EHOEFHEEY—IL
EHFZICEALTVET,

VILFR—Rb: AE—LIERER—RNTHLEGERSBETIEELZKERRAS
FUEEFRAOFEHEEZIEDLTILFR—AMEFATEDLSITHRYELE, BIRLE-
TATLMN 1 DETOGHE . R—AMERIMRKLFST(EDYFERADN. BT
AT LMNBIRSNTNSIHS. Dorico (&, 7ATLABIREN TS S Ry JLA
CrDOBEET LEBETHEIMIMOBE LDOER. 1 BELDAURRYIILAVE ED R
[CEIRENF=TATLOME. BLUVBRGERND I R TDAIURMYILAVEDSE
RIEIGERSNIZTATLOMEZHIEL . BIREGEEICWNFESISSERDIE—%FF
LR TRYRLR—ZARN T, COEBEFEDHIIELFET,

ARG ILAV RO EY EHIEVLE TEIRSNTULVSIHES . Dorico [FBEYESIMVR
RyLAVRDER 1 D 1 DEEMOR—XMEEERLGLET, ChlzKkY., =&
ZIE 1 DDAVARYIILAVINDIETFEBTEZIE—L. CNEEBD A XYL A
VMIRILFR—XT 5. SEEDERDICHDHINDODD AU XY LA R ERRS
TEET,
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BRGENIE—LEERIYEN-TIZBE T, Dorico [FBEFRDIE—ZTEX
B CEREEDE AV RARYLAVMIR—=ZLET A BREEHNIE—LILER
FYRLMES. Dorico [FEHRDIAE—ETLLHTTESHETE<HRYERLT, ER
EENDIFAHSENESITR—RILET,

REZENTOERICBETS: WEF Edi)I-THRHELGKYRIT (Paste
Special) 1T A=a—(Z 2 DOFLLATURAEBMESNELT, BinShi-av>
RIZT ED#KRICFEE (Move to Staff Above) &l FTDIRICIHEE (Move to
Staff Below) ] T. SNLDTIAILEDF—R—KIa—brhAvkIlE [Alt]+[N] &
[Alt]+[M] &V ET (THRE (Edit)I>TFERFTHIET (Cross Staff)1>T LD

KFETHIZT (Cross to Staff Above) &I TFTDEERFETHIET (Cross to Staff
Below)I1DT 74 ILEDF—HR—Ka—rhyk [N] & [M] [ZEERESETULED),

SNEDIATURIE GERLEZBEFLREDTATLERADERINSUIVERY ., ThE
ENTOERIZR—RITBEE£% 1 DOBRETRTIEET, ChIFSEEER
WRTCETHEFILGHEETT , LA X MIDI T7AIUDSF—R—RD/\—+%5
HRAAVTER. BROEREEFOERIOEFORERA. FEEFOERMNS
EFORRABHIELIVLENHIGEC. FIREDOIIRTO—RELEF )T
—REFERALIER. BRORAD VT ZRAESTIVENHIEELREIERNTT,
ERICBRIAERELNTORERICEETHESE. EFOYFOAEN (F-
FHAR) TDLOFEFTERICEEN TV E EFIFETOERICEESET. &
FITERDIETNIREBLGYFET OTERLTIZEL,

REEFZENTOHERICERTS: T LOERICHESE (Duplicate to Staff Above)]
LITDEERIZHER (Duplicate to Staff Below)1hS, I#REE (Edit)1>T45kLEEY
f1+ (Paste Special)JVTA=a—(ZFHLGEMEINFELIz, COATURIE. TED
ERICFEE) (Move to Staff Above) &l TODFERICFEE) (Move to Staff Below)]
ERTVETH AVRTURR—=R TR GEOE—T U RR—XMEATHES128 EIR
LI-ERETOERICELGLNS ENTOREKRICERTEET,
)Fa—R: YFHY23y (JT21—2R) TlE.1 DUEDAURRYIL AV D HEE
EHLT, KUDBWNAVREYILAVE (F—R—KUEHL a0 DIGEIE 1 DDA
DARRYILAUR) [TEIYETET . COFROMNBRRIEEAICEELT 51
HI=. TR (Edit) >R EREYMIT (Paste Special)l»l)7a1—2R (Reduce)]
NFLGEmMENELT,
FI.IT1—RTEHEREZMERE (Edit))>Ma— (Copy)IToJvFTR—KI(ZaE
—LFET RIC.AE—LEBRD)T1—REkEHED 1 DULEDAURRYJLAVE
ZRIRLT.THEE (Edit) >-THHKRGERBY T+ (Paste Special) I»TJTFa—X
(Reduce)]#ERLET,

Dorico [FAE—L=BRER—XNFBRIC. ROLSLEBRETLHEVET VXL
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N—HILEREIE-—DFEHITT—ULET, A=V O EFITHIBRL. FTE DAL
EDRLCERIZE 1 BOHANR—RPEINDRIIILET, BREEESDERE, +94
— 7. F1—(FMYBREET,

AE—LEERZBIRLEAV AR AVMMIR—I T BZEOE|YIRY (B BRI
RESN R—XMEDAVRRYILAVMETARTHLELES 1L DDAV AR ILAY
FDEFEZITRY. BEIZHELTEDAVARIILAV D EFEEELET . =2
(.4 DDAVALYILAVIHLEFRZIAE—LT 2 DDAVARIILAVKNIY T
—RATBHEE. BRIEFLEDAVRARILAVEIMGIEIZ, 2 DDA ALY ILAVMIHY
FIZREISNFET 5 DDAVARYIILAVIOLEZREIE—LT 3 DDAV ALY
IWAVKZ)TF1a—RTREEE. VT1—RED 1 DODAUARYILAURZ(FT
E—x® 1 286H& 2 DODAURARYILAVIMS, RHRIZ 2 2HIZIE 3 D8HE
4 DHM5.3 DHIZIE 5 DONLDERMNE|YLTONET,

IHRTO—K: THRTO—KEIE, LKDH BE 1 DO 2 D) DAV RRYILA
UrDEEEEBRLT, KYBLDAVRARYILAVMIR—=R T BHIEETTHIRTO
—FIEEVRDLIEZIDTY . CAMNTERE (Edit) 1>T455&GREY (T (Paste
Special) > TTHRXFO—F (Explode)lMbERITTEDKLSITHYZELT=,

FITHRE (Edit)>TaE— (Copy)l2EALT. THVRTA—FSERERE Y
JAR—FIZOE—LF 9, RIZ. AE—L=BEREITIVRTO—FIEEZHDI Ry
ILAVRE 1 DLLEZBIRLT, TiRE (Edit) I>TH55408Y fF1F (Paste Special)l>
rTH)RFA—F (Explode)1%&:&RLET .

Dorico &, HAFDAVRRYILAV I ENEN ., TELEHFB DO LEMSIRIZ, Wb
¥ 1 BREZITIMALIILET . MIBEZERTIEROBDSHEAEDAU XYL
AVRHE—BTBIGE . AVRAMYIILAVKEEFNEN 1 BT OZTWYET . 1T
ZRATAEROBAHNEDAVARYILAVMREY DTGNS 2 DUEDA
DAY AUKNIEILEFANEIY B TONETS,
RS—VORBEELEDFTHTIIBEVWTATLEL. HAXDEFREFADIY

AR ILAVMBEEINFE T,
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BEREITA45—

HRSNT=I#%FE (Engrave)I>BEHE (Playing Techniques)l1# 4705 &Y.
BIFEDEEREFRELTAHIDFTILEERTESLSIZHYELT-,

= Edit Playing Techniques
Playing Technique Category: Name: Snap Pizzicato

Single / Above Appearance Below Appearance

Overpressure (Down Bow)

Overpressure (No Bow Direction) (.IA) G)

Overpressure (Up Bow) - f
Overpressure Possibile (Down Bow)
Overpressure Possibile (Up Bow)
Pizzicato
Pluck With Fingernails
st
Punta d'arco
Snap Plzzicato
Sul Ponticello {Bow on Bridge)
Sul Tusto Default placement: -ﬂl
Thumb Position
UpBow Popover text: ‘.%I
Playing technique: [ Bartok/snap pizzicato v I | Edit.. l
‘ Now | New from Selection
Duration: W
‘ Save as Default | | Revert to Factory —
Shown In Cues: —JS not shown in Cues |

[ ] IED

BMEFDERRZZHET S BFEOEEREEHRETACE. #4707 DELE
2 BIEEBEDOAHATI)— (Playing Technique Cateory) | A=a—h @Y%
HTIY—ZBIRLET , ChFEREE—FDOIEEHE (Playing Techniques) ]/
FINCRFENDATIT)—ITRIGLET . BIRL-ATIT—DERREN A=
—DFSTDOYRMIRTEINET . BIRLTWSEREEN. ¥ 4705 DG %
EHOBAN VI TAI—IZRTINET,

IT459— & BRULZBREEDFIC(TITIELTHENEDYES . [TFRF
(Text) IQERFEEIFRATICRIRINSTHFRALERTRLET . [J1)7T (Glyph)l
DERBEFT T4 VICEB5EBTERTLEY (BEFITEIF D LOXF
%

1 DULEFERLETH. BERIEFEIA UM TERARIFU SHICIEER T 7ML
FTEHICHAELETHERTEEY),

[FXRb (Text)IDEREGEIE. COFA(T7OJ CTEERETEET [TFRL
(Text) I 74— LR ZEREL TRRINDTHFRAMNBEZEREL. ZDIT<CHADA=L—
MoERTETHREAIVEERLTHEELE S . TIAIATIR ERT ST+
FREAILIE, TEEREB 420 (Playing technique font)lIZIEESNTLNVE
ED

128 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

(797 (Glyph)IDERBATIE MEDT-OIZE 2 OFA(TAJTEREET &
ROLET T BRBEOHBELRLAERGEINE>T. F47RT LHFEOKRT
LEA—DT7 7230 nN—IZHhET (VM 1 D FEF 2 DONERICHET /12
UM 1 DFORTRENET . METAAVEVIVITHEFE 2 DITA8—HE

TFL
@ Edit Playing Technique
Name: | comp.stringsSnapPizzicatc
m Text Graphic Composite
o G |
Rang) ‘ ring te | v'
( )
mlul v | A
00 0
m [S8) -
~= ol = ¥
- S gs b >
<
Zoom:—{_} Select: | Previous ‘Nm ) ™)
Component f A
xoffset: [000 [ Xscale: [10000 [  Attachment from:
vofset: [000  [3 vscate: [10000 [5 Attachment to:
Zorder
Stem )
Stemattachment: X [ Addsiyen |
Cancel m

EERREICHROERZEMTBIZIE. A7 EGRDIARILHSERLET
U2 (Glyph) 127 old FED I+ EDEBEDXFEERTEET . [TFX
b (Text) 12T 0 5(E FEDITAVNREAAILOBEEE 1 DUEAATEET S
57479 (Graphic)127h i, SVG., PNG, F¥fzl& JPG 74— vrDI 574
VP& A R—LTEFET, A EDHE (Composite) 12T h5IE, TAD IR

CTHRASNIBFDERESTEMTEEY,

BMLE-EHRF, ROARSYSEEE [A+XEF—TBETEET, BEXRFTEFN
TR .nVELonegnm 1 259Uy ILTRSY T 350 X X5—IL (X
scale)1&lY Ro—JL (Y scale)IDAE AV PA—LEFERAL TR RIEEREER
TEFETUITaIBERIFKEAMEEEAMDEREMIILTERTEETH.
SV THXAM HABRDOEDERIZBV T, BRIEARICHWETEERET 0

ENHYES,

BEHOEZNELYASIBEIX. THIROIEF (Z orden)I/R2ZFALTEIRL
FERZARICBHSELILT. RERORTORIRBERERETEET,

BEREODTHAUNTRLIZ0. TOKIZV)YILTE 2 DI T452—%FLC., #

AFAT7ATIZRYET .
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AMUDTLEL—IRILDFIZHEZZDMDA T avE ULTFDEEYTT,

AT3Y)— (Category): h73)—%FRL T, COERFEZIREEE
(Playing Techniques) I/ ARILDE DI IVITRTTINERELET,

FI+ILEDEIE (Default placement): EEHEZEDTIAILIDRRUEE.
RDIE (Above) AT (Below) IMEELET

581 (Appearance): JYUIRATDBEEBEDOHITERASNE T [LTELE
C (Same above and below)ll&, SBRIEZERD LF-[ETICRRT D,
WThRICEEBEEATHEEZERLET . [ ETFICE->TRLS (Different
above and below)ITlE, ERD L TFICK>TERLGLEEEIBETEET,

RyFA—/R—FF X+ (Popover text): COEEREZRETH-OIC
[Shift]+[P] DRYTA—N—ICAANTETFRANEEELET I TICHDES
BEICEVATONTOASTHRRNEIEET HE. TTA3—NEEFEETHLET,
iBEBE (Playing technique): BARFIZERICRBTHESRETY . RE
ZSHRL TS,

Talb—33> (Duration): FESNTWSEEBENDERBRTOA T3y
A Dorico [2TFRTREINTIILEL=O FREDTI7DHEYRLERIZM
AT 2R BR. BLUSESELBHEOXRNMNEMEINDIFETY). BFR
TOMRIEEONFTH . SEORRICKY. BRRENT IAILNTERRE
£7:95 (TaL—avdHY (Has duration)]) A, 1 HFFOELED 5@ F
ahd (FaL—avil (Has no duration)]) MEIEETESELSIHYE
ER

Fa1—TDFRER (Shown in cues): Fa—MNSBITDAUALYILAVIIDE
EREEZEDDIREITHOTVDGE . COEREEEF1—(CRRIHMLE
WAEEELET .
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BARAOESREL: IEE (Engrave) I"IBEHR%L (Playing Techniques) %A
TOU CHEERELIERRZEEITRT. BEAOESREECEEM T AT
FIEBRREADONBRERETHEEIC. TEEHZE (Playing Techniques) A=
A—hoBIRTEFET, £, EEEE (Playing Techniques) | A*=1—HAID
MR (EdiNIREVED)vITRE UTOFA(7RIBNRTSN, BEOELR
DERBEAERELTAHICTILDOEERETHAET .

® Edit Playing Techniques

Playing Technique Group: Name: | Pizzicato

Pick scrape Group: | Techniques
Pinch harmonic

Alias for: (Unset)

II

Pincé Fallback: (Unset)

Ping

Pizzicato Articulation type: Attribute [SIIEERET

Pizzicato alla chitarra

Pizzicato secco

i New I I New from Selection I

I Save as Default | | Revert to Factory |

(et | 2N
T ==

ELBONEES XD IL—F (Playing Technique Group)lA*=a—I&. DY

W—TICB T 2BEADERREERETINEBIRTEES . ChoD I IL—T

(& VST THVRTLviaveyIBATERIN, EROBEICSEZAMRDEA

TEEELET .

m JEEHE (Techniques): 2L HOUFDMEICEEF* SR 5EEHAT
ER

» 5§EES (Dynamics): Y OURDEBEEFRIITAVIICEEES5Z 5EREE
TY,

» RBX (Lengths): BREERTEHTAL—3v0 LA—MPTE IO LK
YOURDUEICHEETEZHERRETY,

» EHFE (Ornaments): EZRAFENEVFISHLEMD S CELEZZEMAT-
Y, BOEYFOET I EELSERYTHERIETT .
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EROTAA (Name) J (X, THEZE (Engrave) I>T®ZEH & (Playing

Techniques)l. B4 (Play)IPTTORTFLvarIvF (Expression Maps)l.

BLUTEBAE (Play)1rT/8—hyiarvF (Percussion Maps)IDFA7HAS K

DIVAMZIBENT, COBRFENEDKIICRRENAINTRELET . BERAD

BEEREICFXENTNLUTOEERETEET,

n TAYF7RF (Alias for): ShRZEMMTSBERDERTEEFIBELET,

» JIL—7 (Group): COBEADEREENKRRINDGT IL—TEEELET,

» % (Fallback): COEZREENERATELGNMGS . MDOYICERTSIBEER
DERBEEEELEY,

» P—T4¥al—arDR4F (Articulation type): BAERADBEREENE R
EDMBDT2AL—2aVERELET, THE (Attribute) IIEZDREDEFD
AITEREIN (RIVA—LDT—T14F2L—23275 ), [E#E (Direction) &
LIBEO TR TOEFIC MOBEBEREICI>TRYESNIETHREZEZ KT
F9 (EFH—LDIETRREE),

ERERALIOKIZY Y ILES . T EFEHFRIEBRSN-BERAD
BEREZEIOCIIMCRATEDSSITAYET,

WELLERBZZMOTAD VN THEATESLIICT S [#HE (Engrave)l>
[FRERGE (Playing Techniques) I TITHE21=#R&EIX TR T, TIAIIITIERE
OTAVTIMMEFICERINE T FRERFE - EREL-BERDERRZEEZS
BUERTEIARTOTAODIIMTHRATEDLSICTBICIE. A7 E/DYR
PBEZET HERBGEFRIRL T [T I4ILMEL TR (Save as Default) 129
Y OLET , COERREF. SERERSNSITRTOFHR IO /MM RSN
FY,

TIAIEDBEEREICMA-HREZTICRT K. F47O5 EQIDY Ah DX
LT HERHEEERLT. THABOREICET (Revert to Factory)1&49')vy
Lij-o
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FESERIA M Petalumal

Dorico 2 IZI&. FEEZDFE I+ I73)—THSPetalumal B FfzIZinhHY E
Lz D773 —I[&, IPetaluma]. Petaluma Text]. Petaluma Scriptj® 3 D
DIA P THERINTWNET, [Petaluma i, RA7HD TR TOEFTRELESICE
BENB A DT+ LTY, [Petaluma Text)lE, AA/—LT—5, O—FEES.
BMERELE. TXRANDIIGTATLIZEZTFRAFEN AT ERSITERAEINET,
Petaluma Scriptll&. RA7HFDZDMT R TOTFANTOERICELX1T
FI+2hTT,

INTRO
Bsmaj7 Esqen

7P 77

.y

Petaluma 773!)—I&. Jazz Standards &5 —RMLGEEETHERAINSGFE
EFRAMIITEELZEINTVET A, 1350 LU LEDEFEFESE 500 U LEDFR
DLN—F)—ZFL. INEFEFEVFTHITENTOWSHRYM DO TH., (FE5HIC
NITTA—ISECIDELYFET,

APz IR T Petaluma #FEATHICIE, BHE (Engrave) IPTHEE I+ b
(Music Fonts) 1% Z#iRL. FRATESEE I+ VLD RAh bl PetalumalZEA T
FTOKJIZZVYILET, chlzkY. TPetaluma Script1£ 7Oz IDTIHILED
TXARARIAVNIBYET MOTFRAN T+ ERTEHET. THE
(Engrave) I>[ 24> b RAB AL (Font Styles)IDTFI+ILEDTHRAREI+ >k
(Default text font)], HXUTEE (Engrave) I>TERFE XA A JL (Paragraph
Styles) IOTTFI74ILEDTHF XL (Default text) IZ#wRELET

Petaluma & SMuFL BE#iOEE T+ bTHY. SIL Open Font License (OFL)
DAV REZITTVET, LIz >T.OFL OTFTTEEREFI)—XT5RYIL. B
HICEHER. 8. BAETEAET . [Petalumall DI+ b I73)—DF T+
VRBTHY . IRETAVMICD TV NBEFERATEF A RRIC, 9400072
|)—TPetalumal BELVZDIRET A+ ME, ERICERFTETEEH AN, TIREN S/
Vr—oD—EELTERMTEET,
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NotePerformer 3 MHHR—
Dorico 2 [&. Wallander Instruments [Z&% NotePerformer 3 MY HR—rEEA
LTLEY . NotePerformer (&, ZEERY I+ I T7ICKEBEDT=HITHFRIIZE
SNtz —F Y ILAV RS ILAVRTT,

NotePerformer 3

Bass Comtr- Orchestral
Flute Obou Clarkwel  Bassoon  F.Hon  F Mam Trumpet  Trombone b T'npﬁ P Violing

L) L ] [ ] [ ] » L] L] L]

RE ur L17 R R11 R21 R32 R3 c Las

100

REVERE REVERB REVERR REVERS REVERS REVERD REVERE REVERS REVERS REVERE AEVERE REVERB REVE RS AEVERS A
L L L L

" 15

NotePerformer 3 (& Dorico 2 IZ A B ch TWFEFHE AU NN .
www.noteperformer.com &YRIERBEATEET, £-. M5 30 BERLSA
TILRES Do O—KTEET,

NotePerformer 3 ZB ALA > XAb—)LLT-% Dorico THERT BHIZ(E.
NotePerformer AL TBEZTHITACIIERE. TBE (Play) " [B&E
T2 FL—F (Playback Templates)|Z:&RLFET . BETVTL—FDURIG
[NotePerformer |Z#IRLTIOKIZEI)vILET,

NotePerformer # 4 R TOFR IO/ NCHERATHIHEE (L. RERE
(Preferences) DI £ (General)IR—C DIH\E (Play)ltoiavichablT7
FIEDBETUTIL—bF (Default playback template) 1% NotePerformer J(Z5%
ELFET,
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FRIFRC S

HALion Sonic SE ®ZFDfhd VST /—rIHRTL vy arxthits VST 3 412X+
HILAVKZBWT,. BERBLUEE FOSHFEIREBEORLEZDOREIC. MoSD
RSt E A EREICBAEIhDLSIZHYELT =,

F—ForWEHL

Mac &Y Windows T A—TA44ZZHLIDEB T/ T7OTHARTIND K
SICHY . ETHPOEEOEBZIYEHICIRIEBETESLLSICHYELE,

INTTER

BETRAAILD RE/NE#E: The New English Hymnal %ED—ERDEETEIC
(F. RIE/NEHIROBFLEREENRONE T, TR TORR—RDMEIZAMNRRS
N AVNRERAVVROHEAEHLEDHIDLYIZ 2 KOMLV/MNIRNEINET, -
2L, fHER D BB I E (L5} T, NEIRA S 4 DD BRETARTSIWET, B2
AT a>OUNg$R (Barlines) IR—VIZHAITRILMEBICHIRERLS (HBER)
D4 (Coincident repeat barline appearance) &= #ILVE#EER (Double thin
barlines)JIS,. VJE—FD mD# (Repeat dot frequency) IZT#HEBADTRTD
AR—2R (All spaces in the staff)J[CERE T H_ET, CORERAVITHETED
KOIHBYELL:,

INTE S

RAFONEESOHE: RAFICEENL/NEHESOEHEEZR T TELLIING
YDELIze CNIERARFOETICRREINET . CNEBRTTBITIE. LAT M
Ta nlINGES (Bar Numbers) IR—UI2HhATRAFTIH/NHES DEH
#%7~ (Show ranges of bar numbers under multi-bar rests)1Z#4IZLET,

HEF TV DOHRFF (Rests)IR—DIZHLWA T avhBnEh, sEREZD
TONEBESDEHEARTEDT IAICDEROERLE, HERTD 1 D& 2
DHDNEHESDRYYXFDIEEEITEASLIIHYELT,
ERBHLATIMIBTHNEEBSDONE: LAT I T aonlNGES (Bar
Numbers)IR—JI(2IRSTSTRALIDBFHLWA T v L TEMSh, 7aY T
IRDBELATIMIEDINGT ZTRIMINEFERTEINERIRTESLIITHYFEL
o HBRTODIHTIE. IV RIATBLUVARZLRATNINGE S (Ra7)
(Bar numbers (score))ID/NSTSTREZAIWNEFERTE—H. I\—kLATIRE
NS (/3—F) (Bar numbers (parts)) ID/NST STREAAIVEFERLET , BX
FEOTODIHRTIE, RAFLATIRENR—bLATIROWVWTRETINGES (R
a7) (Bar numbers (score))I1N/NST STREZAILEFERLET A, ZHld Dorico
1x TEASNDZPHESDIFVFREMILDNBIZ BT DEIICEHFENTE
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Y. Dorico 2 TTAVIIMERVWTEH/NEHB S DN ELEHLSLELKSICLTLVE
ER

TI7AILLTIE, IMNFES (R3a7) (Bar numbers (score)) IETMNES (78—F)
(Bar numbers (parts)) 1D /NI STRAAILIEWTNERILNEEFLETTH. B
FIZRBANERFDIEITEY TIVRATICHEEEZFTIZ /NA—bL AT D
BB SDIAUE HA X RE WV EHBIZEETEFT,

J—FEES

HZ5—: a—FREEH. TanT«DI—§ (Common)F IL—TDIHS5— (Color)]
TONRTADEREICRSILSITHEYFEL =,

Ko

B

BEHLUBAE CEASNSEREESEIEET % Dorico IZT)ybEh TS
AVRRY IV ANEATIZIE, RELBATOEEERTI DRITENENEL LT
HEEEFEATILDOLAHYET . BEIZELT, 7JB—DOEFHEETAENIZCH
FEBEEETELLIICHRYFEL, [HRE (Edit) > TFEEEE (Clef) Y TA=a—
(2. TR&TE (Concert Pitch)l]&TBEATE (Transposed Pitch)1® 2 DDHT A=
a—MFLEMENE Lz, OOl BEEBETE—FDOIMEEEES (Clefs)l/iR/LH
LFATEST N THOERMREINERTEET,

MSSEL S

BBRENERETEYDSY: BERESBRSICEETFANELEXRETFAL
KGR, THFRAM —ADKRFEMEBRESNNIRET-CIHE. FEXI<EFE
NERREL T RBESHERORNAIICEESNTLESIIGE ., RIBFELS T/ME
ROERRD—IEZRY DA EDLIITTHIET, BBESHMRYERA LI
VET.

TO/IRT4NRNRILDIBRBEE (Dynamics) P IL—TIZ . TEREZEYDAL
(Erase background)Z7O/STaAFfzICBMENEL Iz, X, FEE—FTD
HARREINET . COTANTAEFVICT L EBLESRALOBEHEADLEYD
AEINFT . RBEBTEALOREDTIAHILEDRES(E, BFEF T aDIETH
8% (Dynamics)IR—UICH=ICERESN-RBEFTALOEREZEYOAL
=& B (Padding around dynamic with erased background)DfEIZ&KYRE
SNFET, TANTANRIILDOIEFEEE (Dynamics)17 IL—TIZHFHzICRESN
=T B%H%E (Erasure padding)l7ANTAZEMICLTHREE LEZTEHILE
1TEFY,

RADBIRERET D, Dorico [FXBEBTFRAMBSLIUERETFANE, FM4F3y
GURNNLETRTHR—ILRAR2) RN XFEEFRBILTRAT =8, f risoluto D&
SHBBILEICRAZHRITAEE.f D=HDRAIL risoluto DF=HDRAKLYE

R<AGYFET, RBIKX. TIAHINTXFOLETADEREHLB AT RBREN ST
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O, BRIELEEDEDEHD TINEIRREECHITK>TIE, BYD RS D58
BEULEICKECRADBENHYET LA BRBELBTOKRETF XL
espressivo M p | TIXELIsIDE D TINEIHREF-CHES . BBELEENDTORA
DREFTELIIICRZAFET . COMREKELT, BBLESHALORAD 4 AAE*E
NENDRESEERICLEEEZTEFET . TFRAMOREHLE A LY TETREE
LIFEVWESICTRBAZELLT, BYDALEEENXFO LT THIFZRZS&
SICFRELET.

BYDSSN-RBMEEIL. RBELESOERERHADERREEBH TS —MMELT
RigsnzFzd,

BRIFGDIEDNSIZATEY: BIGDIEDNIATEUIE. T4 FTIVILAIILDOR2BE
BARFELEBELERTOIT—HOERBICSI>THERASN, [RBLGATEY 1&
FENDBEELHYET . ATELDRIFGICIENYEFITBICIE ATEUEZEIRL
T.HLGEMEN-TRIFEDEMY (Flared end)]TA/NTF4ZAUIZLET, D
TANTAEANTELEL TN S EEFERIGATEE 5 T, RIRTHEMI NI LD TOH
FERATEEY,

BIGDELYD T IAILED YA XE, BEA T3> DI85 E (Dynamics)]
R—IDIEEMERSREBEES (Gradual Dynamics) o avIcEHxsn-T&iEh
EM21=THAL> (Flared end design)1¥ IL—TADA T avzERBLTHEREL
FTMEARDATELDRIGDENY DY A XL, FEE—F T, HLGEMS I
[EMYDHAX (Flare size)]7A/ST+DIE (W)I1EMBE (H)IZEEL TR
LET.

I4IV3—

[$REE (Edit)I>T70ILE8— (Filter)JA=a—[2v—h— MY E—MEEBE LU R
Sy afBiEABMENELT -, F-T4IWE—A=a—(F. BYYvIIZ&Ba0TH
ARAZ2—DHRIZEFNZLS(THo=1=8 ., BEICFUHTIENTEET,

245V

HRALEE: TO/RTARRIDII40HYLS (Fingering)1F IL—TIZT R —
JU (Scale)IZ7ANT4HFHLGBMENFELZ, ChIFHEEE—FTOARREN,
TaVAIT DRRMEEE . TNDB T IERORTEREIANEETEEY,

B4 HIT ONER: TRITARRIDIT42H Y25 (Fingering) 15 )L—
FIZHFHLGEMSN =T B YEEIREES (Cautionary) I1h D, BYI T4 H LS D4R
EERICLEEETESLISITHYELz, SNILFEE—RT (F4HIUT TIHEK)
BERNERSN TN EEETRREINET . COTANTAE RN T10 AV T
MW B RDIGEETOAATUICTEET . TNLUNDERTIXEEMICAIICRE
ENFET, TANRTFADAUICHEDE UTOEISBIRTEDLSICHYET,
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" T4 (Default): FEFTLav THRESNIZRII10H) T DNVEZERE
FALET,

= }E304L (No parentheses): 4> H) I EFIMELTRRLET,

» $FIDF (With parentheses): FEME FTIAAH) T ERRLET

= #Pfl (Suppress): BUITH) T EFELITERTFICLETS,

HAFEFLIETREAZDTAHILYT: T40AHI VT IZAVERRETTHE
B EMTERXSITRYELz, COKSBEMEITI—TaA DTV HYY
JTHEAINDGENHY B TALTTERSIATERTHILERLET . T
BEANET BRI, TAoHI T BESEERLT, TONTARRILDI I FIVT

(Fingering) 17 L—7IZ#FLGEMEN F-IFaL—3> (Decoration)] 7R/ 74
EAUICLET . CNIFREE—FTOARTINET  FELF T a>DII40HY
>4 (Fingering) IR—CDIFH ALY (Design) 1ty a> TCIEMEKTE
(Advanced Options)]|H 70 ar BT AL AVEHRDOY A X #EOKS
BREDF T a EHETEET,

Fyl—Ea—
REBAOERSALBEVBRLBOBRO LONFES DY A X LLBIRE
hELI=,

HALion Sonic SE

Dorico 2 [& HALion Sonic SE 3 &8 LEL-. HFILLWN—Ca  BICEFH SN
ARL—2307 a7 ILIZDNVTIE, LTS A RESEBLTESLY,

https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/

SXY—
Ra—LT7z—F—FIE/ >3 A—JLIZEWNT, [Ctrl]+21)v%9 (Windows)
Ffzl& [Command]+71)yy (Mac) §5&. TIHILMEIC) YR TEDLSIZRY
il./f:o

R

BRELGLOER: TO/TANRILOIEHEARH (Notes and Rests) 17 )IL—FIC
[FREZEIERT (Hide stem)ITONTAHAFHITEBMSNEL =, CHIXEFEE—F
TOHRTRINFET . AUITTEHE ERLEZEBROFENRRINGAY, B
FHLERTRICHBVET ERLEZBFDNENOTIL—TIZA-TWSIEE. FE
[FIERRIGRYET . EHLBEEBYICRRTEINET, =L, EHDTIL—T
BRI 2BHIRTCTIFREZIERT (Hide stem) TO/STFANAUIZRESNT=
HE . EMLIERTITEYET,

138 R—T Steinberg Media Technologies GmbH


https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/

Dorico 2 /N\—2av R

@ steinberg

BHDAS

BEOEFZEMFICHAAT: BRLEBFOERZE 1 DULEDOERFICHEARA
HBHEIHRYFEL =, EFRFICEMI HEFEZRRLCT. I (£23AY) Z2WLET.
BHORYTA—N—HRAE ERLEFFORETAL—avrbiREENSL
ENRTEINFT . RESNEHEROFEFR, FLEEBEDLEEZAALTHSL,
[Return] L TRYTA—/N—ZHEELET . BIRLI-FFI/EELI-LLEDE
FF 1 DICIRFEDGEIE ERD 1 DEFERESNET . IEELLLERAREIRLT-
BRI ARTERARLDICET+ATHIGE X BRLEIRTOETFNERFIC
IREDETEMDERFNERSNET

BEHFDT1L—avIC/BTEXFE (2h=2 28/ w= 2EH. h=2 5.
q=4 NEMF.e=8 NEFLE) FEBERANDTIHILEDF—HR—FIa—
bAYNIEFETaAL—2aVICHIETEHF (9 =2 £FF.8 = 2B/R.7=2
NEM.6 =4 NEMN.5=8 NEMLRE) ZMAMTEILICKY . EFOEDEL
ZEFDRYTA—/N—ICEEEE TEDLIITHYELI, Fz. 1 DULED#LE
FF(EUAER) XFEMASILET FRAEOROEMEIEETEES . TaL—
IVDBEICHFEERATLIEHE . AREHDBEMERR—ZDNNA(TU TR Y5
BENHYET LR IL. T5:4q.01E TR 4 78R 4 DORIITKS 5 ERFIE
AONR

3:2-2wllEl2 28/ 2 DORSITED 3 EFIELYET,

EBODRAR—VY

MNILTEFE: BT HEROMILTHFEAEMLENESIZ. FEDKIHICH
IOEREDNEZONFEL , EMLESTISE (&, FERMEICIRHAIZEEREAERDS
nFEY,

HES S

ITEBOLOIVR: ITEBOLD VRN UN—TII—0ELVTURERTT
ALORABIZEBRESNDKSIZHYELT=,

BETVIL—b

BETUTL—MZIE. VST 41V RRYILAVREZIE MIDI T/IRA RSN S DR
270z IDAV ARG LAV MIERE T S8 Dorico HERAT H/IL—ILHVEE
BINTWET, CNETIH. TIALCDOBETUTL—ME 1 D213 T, FAYT
JRDOBEAIZ HALion Sonic SE DAV RAVAELUVAB SN TLYS HALion
Symphonic Orchestra & HALion Sonic SE DSA4 73— T Y%EFERLT
WELIZo AVDFILD Y IURERIE VST AV RRYIILAVREEIYHTT, T4
IWRDOBETUTL—rDOERE EEETHILFITEELLN TNETESE T
THIEDBETUTL—rOBERZIERLEVRY. Dorico IFBATHIURDOE
Y TEITHEDEIE>TLVELT,
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TIANLCDBETUTL—b: FHEZEOAME THS Dorico Elements [,
HALion Symphonic Orchestra HiREEBEHLTLVEL S, TIHILEOBETIE
HALion Sonic SE 5473 —0Qa TUVICELEITEKFLET . 2018, Dorico
Pro T 74 ILEDEBETYTL—rELT, THSSE+HSO (Pro) ) &THSSE
(Elements)1® 2 DERHLTULET, GiIFE (L Dorico 1.x DT IAILDEET
VIL—hERILTY, %%&FI(E HALion Symphonic Orchestra DY RE—Y){E
&9, Dorico Elements DT 74 ILEDBETUTL—ERLBDERYET,

FRIOC M EDBETUTIL— & FERTEHINEIEE T H1-OIC. [REBEHRTE
(Preferences) IO £#& (General) IR—CDIBA (Play) 193 avIZIFI4)Lk
DBEETUTL—bk (Default playback template) 177 avhEmEhELT -,

WEDTADIINMIELIBETUIL—EBIRT S, £IETIAILNDBET
DIL—FOWIT A ZERTRICE.TEE Pay)lrTBEFYTL—F
(Playback Template)]ZERL. YA SFERTE2BAETUIL—FEEIRLE
ER

BETUIL—ESHI2EMT S: Dorico [, BAETYTL—rEESITEMT 51

OIS, PRTLERFFA—F—BEEDT7 TV r—2avT 3T+ F—IHE

9 5. IPluginPresetLibraries 13 & U TPlayback TemplateGenerators ] £V T

AINF—HNDY T IAINEF =T —REHRAAAET  TAILF—MEFLUTODE

HBYTY,

= Windows:%PROGRAMDATA%¥Steinberg¥Dorico 2 (AT LEK) Fi=(%
%APPDATA%¥Steinberg¥Dorico 2 (A—H—EH)

» macOS:/Library/Application Support/Steinberg/Dorico 2 (¥ XTLEK)
FE1=1X ~/Library/Application Support/Steinberg/Dorico 2 (1—H—[EH)

BN ITAHILE—RADETTIAILE —DLRIA. Dorico IZHITHBETVTL
—rDERTEHELGYET,

[PluginPresetLibraries INDIEESNI=H T IHILE—HS LUTD 2 DDIT7

AL —REnET,

m Presets.xml: N—F¥ILAVRARYILAVRDZATZ)—RADTATOT vk
FENNVFOVRTY  REBICHIGT HTIRT Ly aveyTEId/ 13—
HvarTvIDEMEERLET .

= Presets_for_instruments.xml: Dorico RIZHERTESRT IAHILEDAV ALY
WADRBATIRTE ZDAVRRYIAVNIT IA I TERARENDT)
YEDY AT,

[PlaybackTemplateGenerators INDIEE SNI=H T I+ LT —IZIE,

playbacktemplategen.xml EWST7AILMNFEELEFNIXBYEE A lE,

FHAEND VST A RARYILAVE @ UID, EHT SIPluginPresetLibraries |
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DT—2. BEUZDHUNLKDOMDINTGA—E— (FEZIE AVARRSILAV I DIR
HEND MIDI FYoRILEB. A—TAFHADOE. TTIMF Yo RILADT 74
ILED Send RLARIVIEE) #HRELET . YT 7+ EF—I2IEF T av el
T .pluginstate Z7AILWEENDIZENHY . VST AV ARYILAV D VERE
[SAV RS ILAV D RIZHEAFAENET

IVRA—H—DNINoDT—2I77MINEFRALTHRBEDBETVITL—FEER
FTHRELEFEREINTOWER A, COERIE, —F/X—F4—&! VST 412 XbYJL
AVEBEUHIURSATI)—DRARBEDIBED-HICRESNTLET,

EMOERE: BEA T avDlF4305 (Timing) IR—DIZHEIEEATEN-T
al—av® % THEE: (Play as % of written duration) 1A 7L 3> Al ,
ROEFOENTURTHESNAEEDOERAEBINTELOLIITHEYEL,
BRD 4 P ERUTOTAL—230THAGEIL BESN-RSEITEBISN
FI. BN 4 DEREHASRSTHAGEE. EFOEDY 4 2ERORS
DMBATEZTFDNEBHRELGYET . D 4 RERORSOBAICIEZORRICE
(F5TUREREEIN, BEFIERAT 1 42fH 4 78/ 120 BOTURDEED
4 NEFICKHT HIEEDEIETERBSINET,

BAEANYREERUEICEET S BREN-FHORINDTATLOMEIZHLE
~NYREBEISE S, HiLLWF—HR—Ka—thybk [AI)+[P] (T74/Lk) ALEMS
NELIz SR ETATHERTHLE ET LOBEDHENETFDEDT
L—AITH T 2D ERERTES0. FEBIZERTT,

WERE

BRBEZERTICT S TEGRYRLEE(T5-OLE . BRBUETIERRIC
FTEDHEFXLWGEILHYFET . BRREZIFERTICTDICE BREEEZRRL
TFaNRTF4DIEERZE (Playing Techniques) 1Y IL—TI1Z2H BT ERTE
(Hidden)17ANTAEAUICLET . AMFDARIRINFET . HEITGL T TEa—
(View) > THAE (Signposts) -TiEZEH % (Playing Techniques)1%:&RT5&.
INBREERTRICTEET,

TXRAM—ZADBERREDEREEY DT BEBENNIREECES.
BREEBRILOEREZZYDIAT L. GAPILGYET . ChEEIRT H1=0HIC.
TanTa\RILDOIEERE (Playing Techniques)1V IL—FICTER/E%EYD
AL (Erase background)1Z7AN\Ta4NFfzIZBMENELz, CNITEHEE—F
TOHRTINET EERZEFDLORBDTIHIEDOKRES(E, FEA T3
DIRERGEK (Playing Techniques) IR—DIZH=ICRE SN =IESEGEREDID
E2Z#2ZYDARLIE=HR B (Padding around playing technique with erased
background) |1 7 avIckYRESNET . £-. [RB%EEE (Erasure
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padding)I7A/TA4EBHICLT. ALADEBEREALICEKEEZ LEETEET,

TXAM—RADBERBEDKEFT7Evh: BEA T avnNEEEE (Playing
Techniques) IR—U (2 [TFHXF A& BDREBEEDKEATEYEF (Horizontal
offset for text playing techniques) 147 avi#f=IZBMENEL =, Th(ET
THIVFTRAR=ZANEAIZREENTVET D, EAETHFRANM—IDESR
BiEZ . TN BT A ERFLIEMEIYVPLEICRTESESESIEX. COFHLLA
T2avITRAF ADINSEERELET .

RERS

REBEEDHEAE: Dorico (. RIEBFESDBELZREMICHAR—LL. VE—HMME
P REDEFRPBEINDLIITHYET  FIURAR—FED/PNEIARE S VEA L
TARTLAE RIEEEHOBREMEERBRLET . A—T1FEELU MIDI OE
SHLEELLLRERBEZEAHET

[Shift]+[R] DRy TA—/—: VE—MMEl. E—FEBLIUVEHFTEDILEO,
Ay atilE. BLWNEHE—MMEREERT 520D, TIAHLIDF—HR—F
L3—kAYk [Shif|+[R] (Z&kBRyTA—/R—h#FHi-IZEBMEhELE=, Ry T4H—
N—IZAATELIXFFEIEREIE. UTDEBYTT,

H—HEDLERD

/ \ 1 1 RkO—%

Il N\ 2 2 AkO—4

1 N\ 3 3 RkE—%

I \\\\ 4 4 AkO—4

z zonstem FELD Z =—4

0 clear FLEDEBIR

BHEEOLLEO

/ N\ 1 1 AkO—%

Il AN 2 2 AkOo—4

1 N\ 3 3 XkO—4

1 ANNNN 4 4 AkO—2

0 clear FLEOZHIFR

JE—RE

end ending FROVE—MEN

add BHREOUE—MERIZEI 3 FEM

ATy 2t

slash FRDODRS v 258

INEY) E— B

% %1 xEBEONERE

%2 =ED 2 MMERE

%4 %D 4 MERE

%1,2 REBEONEERE. 2 2ETIL—T1E

%1,4 EO/NMHERE. 4 2T IL—Tk
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TUR

BEOTURDEDEMEFRET SD: TONTANRRILDITFUR (Tempo)lF L
—JIZ. THEDELL (Beat unit) 1 7O/N\TaHFHzIZBMSN ., ERLI-TURTA
TLOEDEMERETEDSLIITRYEL -, 12EZIE AA/—LIT—VCRRSE
NEHEME 4 NEFHILMNR 4 REFICERTIEEIE. TORTATLEEIR
LTRED DI RDREEAUIZT BT TERTEEY,
FURBEAORYYXTF: TI4LETIE, FURBED LREFRERTHFOR
PIYXFELT,En FyiapfEREINET RGHARVIYXFEFERATIEEIL.
BEXTavDITUR (Tempo)IR—YIZFeksn -l TUREEDRE LY
(Separator for tempo range) 1A 7L avETARALOREYY (Custom
separator) lICEREL ., AT AXFEEELET,

AO/— L= AO/—LR—IDEFIZHTHFRDAR—V T HRES
nFEL,

TXAk

BfR: TOINTARRIILDITFHRR (Text) 17 IL—F(2, TR (Border)17O/8F
ADFTISEMENEL-, A UIZTDE THFRANT AT LOEBRICRENRRSN
FTRBDT IAILCDKSE BEF T avDITHRRE (Text) IR—DITHER
SN=THERBOXKE (Border thickness)|ATLar TREINET , T-HED
ASIE FLGEMSN-TEFRERDOAKE (Border thickness)lFA/NTa%&A4IZL
T EAROTHFRNTATLIEICEEE LEZTTHIELTEEY . CNIETHEEE—
FCOARTINET , TFRNERBOBDOTIHILEORBIE, BEF T3>0
[FHFRE (Text) IR—VIZHATHFAMNABEDOERZZEYDALIRA (Padding
around text with erased background) ID{EICKYRESNET , =, TO/ T
ANRILDITHRE (Text) 17 V=T I2HBTRAZHZE (Erasure padding)l”
ANTAZERELTLEETEFET,

BEEE: TO/RTFANRRILDITFERRE (Text) 17 L —F 1 TEREERE (Avoid
collisions)IZ7A/NTaHEBMEIN, FEXF T a0 DI THRE (Text)IN— TiE
ESNAERE WD T IAHIIEEE LEETESLIITHRYEL -, TANTAHER
ESNTOWEWEE. TXAMIERD LA TOTIAICDEERMBICR RSN,
tMDT7ATLEDERER BN ITEONER A, FEE—FTIE. BEDHETHE
ZIREBETEFET,

ST BEATLIVDITHRE (Text)IR—DICE, TEAME=TAT LMD
/INgEEE (Minimum distance from protruding items) A7 3> EFf=ISEBME
N TXRANTTATLEBRNOEAH-ZOMDTATL (BRORT—LE) &
DEICBHELGRBZEZRECEFET . CNETE. TXFRANTATLERAHAB LT AT
LEDEMFERESNTOEREATL,
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R—UBEZSDL—Y2: Dorico 2 TlE, LTIV #FHf=ITEMEN, THRRND
L—LIZAATEFY,

= {@pageCount@} - LAT7OrDBR—T%

» {@flowPage@ - BENTIO—HNNDR—SNES, JO—DRTDR—
S 1 ELTHYURLET (DFY. RESEA—SEBTIEBYFEA),

= {@flowPageCount@} - REDTIOA—DHRR—IH

= {@flownFirstPage@} - 70— n ARABRINEIR—D D, RIRINDHIR—D
BFE BREE—FDIDO— (Flows)I/ARJLIZRFTENDTO—FESZ n 12
ALET (#l: {@flow5FirstPage@}).

{@flowPage@} & {@flowPageCount@} Dh—oUI&, b= bMERSN B
BETCHAIR—CDELERBICRLEVEHRIL—LO ., RYOHBEOMBEENE
iEShTW370-DHERMLET,

INGTZTRALIWDEAT7AY: [iHE (Engrave)>TEE%ERA24MJL (Paragraph
Styles)1D /T T ZTRZA I DA ATAYT TEIRLI=TI+ILLDFREIE. R
BIRSNETFRANTATLTHEIESNET (RET5H5EE),

A—H—ALF—Tx—R
R1zB%—#: Dorico 7OV OO RODRI-BEVLEFHLEL-, AIEELER
BETARIIDIEEEESZ VLT DELL ., BEFEHEL TRRATEIRAR—RERK
BRICIGIFELIz. Hub D4 R ODTH A EERLEL - RAFEALI-TO )
FDYRRDAR—ZAMNGLLGEYEL, TOT EETADERE) AR, LT —EIZ
Wnh 1 DLHRBIENTEFHATLEZN., EELERTEINDEIITHEY .,
LOvar T YA R A REICE oz EEICR DT I Y EL-,

TL—V—NRILELBLATIMIRIVIZE THEHER: BHOTL—Vv—%7
A—(CEYETHRE  BROTL—V—FIEL AT I ERIRLTREE TS5
B.IL—N—POLAT7IOrEBIRELIEBRNTHEEIC. BB TEHFIVIRYIR
999l RIZ [Shift] ZHLENSHMDFyIRYIRED)vITHIET. 1
E&E 2 @BOHDYV)VIDEERRNICHITRATOTL—V—F LA T IOrEE
REFLIEBRNTEFET S

MFTEBIINEREIOFAT7OTICHEITHEHER: TITRBXVIEHFESE (Edit
Percussion Kit) 1% 47 RJ D—EDEEE . EHRRLIZAVARYILAMIHL
TEITTEDISIHRYEL - BT FHOMEEAVTIIRDER, BET
BT VIRZAV EDAVRRSILAVEDERDEEE . FYDODAU ALY ILAUE
DHIBR. FYRADA VARSI AV DIBEBEDEBLRELHYET
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MFEICRY 1ETBRTL: TH% (Edi) > TRITKRY (Undo)l&MERIT (Redo)lld.
BHEICWLTERMEICKRTIABH I SHALIICAYFELE, TIRIEETE

(Preferences) IO £ (General) IN—L DIREE (Editing) 1o avICITITE

TEFETIHRIREELBH TS (Follow selection on undo and redo)1DIE

REBREMNFH-ITEBMEINEL-, ThEATIZTTSHE Dorico 1.2.10 LIFTOEEIC

RYFEJ,

Dorico 1.x DD F7YvFTTF—k

Dorico Pro 2 ¥ TETT5HEE, Dorico 1.x MDD 1—HF—FT—4B LUVIBE
BREFEEMICHAERIIBITEINET, CHITE, F—FR—Fa—tavk RIE
HE.RIAFEALEZTADSIIDOURN BRESNFZLATOL . FE.BES
LUBRANDATLav DT I+ILME. BFLUVRFESNAMS X T L NI
TREAI . XFRZAIDTIHILMENEFENE T, E5IT, Dorico 1.x @D
vst2whitelist.txt Z7AJLIZEBMLI=FXTH VST 2.x T35 /4%, Dorico 2
DHRTARYANIEFMIEMEINET,
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ID # Component Issue
STEAM-4241 : Changing the pitch of a grace note before a barline no longer incorrectly considers the
Accidentals : :
STEAM-4294 accidental state of the following bar.
STEAM-5539 Accidentals Whep using the Second Vlennegg School accidental system, grace notes are now
considered correctly when determining whether or not to repeat an accidental.
STEAM-7472 Accidentals Under some rare cqcumstances, |t- was not possible to change the pitch of a note that
had been respelled in a part layout; this problem has now been resolved.
STEAM-7910 Accidentals The enharmonic spelling of rising chromatic passages in minor keys has been improved.
STEAM-7905 Audio export A progress dialog now appears during audio export on.both Windows and Mac, and
accurately reflects the actual progress through the operation.
STEAM-7047 Barlines pashed b_arlme_s to show subdivisions in additive time signatures no longer fail to appear
if the bar is split across a break.
STEAM-7077 Barlines Creating a tlr.n.e.3|gnature chaqge at a dashed subdivision no longer causes previous
dashed subdivisions to appear in the wrong place.
STEAM-7132 Barlines Repeat barlines no Ionger draw !ncorrectly at the end of a system if they coincide with a
key change to a key with no accidentals.
STEAM-7301 Barlines Inserting a t_)arlln_e at the same rhythmic position as an existing dashed subdivision in an
aggregate time signature now works correctly.
STEAM-4846 Beaming pragglng the end of a stemlet now works correctly when the stemlet belongs to an
implicit rest.
Chord Toggling the Show as mode property on and back off again for a diminished half/whole
STEAM-7562 . . .
symbols scale chord symbol no longer results in the chord symbol showing as a different chord.
Collision Mysterious problems where deleting an item can cause an item in another bar to move
STEAM-7504 . g - .
avoidance vertically in galley view have been resolved.
STEAM-7716 Collision The extent of items is now always correctly considered for collision avoidance when
avoidance editing an item that is graphically wider than its rhythmic position and duration.
STEAM-7018 Cues If a cue abuts the end of a flow, a redundant restorative clef change is no longer created.
STEAM-7029 Cues Cues are now automatically removed if they are invalid under more circumstances.
Edits that affect where instrument changes occur no longer sometimes cause system
STEAM-7505 Cues objects to disappear if a cue is located within the range affected by the edit.
STEAM-5064 Dynamics Edit » Reset Appearance and Reset Position now work correctly on dynamics.
STEAM-6385 Dynamics If a dynamic has a color set via Properties, it now shows cor.re.ctly in the blqe linked color
rather than the orange selection color when another dynamic in the group is selected.
STEAM-6651 Dynamics A series of gradual dynamics interspersed with immediate dynamics and shown as a

single hairpin no longer draws incorrectly in galley view.
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ID # Component Issue
STEAM-7328 Dynamics Under rare circumstances, edits thgt affect the .\/el’.tIC§| placement of gradual dynamics
would not be propagated to all music frame chains; this has now been resolved.
STEAM-7742 Dynamics Adding an immediate dynamlc.to the.end of an existing group of dynamics now correctly
extends the length of the flow if required.
STEAM-7782 Dynamics Hairpins that extend precisely to the end of the flow now draw correctly in galley view.
STEAM-7257 Fingering Thg In_dlcate shift to next note and Shift dl_rectlon properties for_stnrlg fingering shift
indications are now correctly reset when pasting notes onto non-string instruments.
STEAM-7384 Fingering Deferred f{ngerlng sybstltutlon now works correctly on notes and chords that are tied
between different voices.
STEAM-7409 Fingering Under some C|rcumst.ances., fingering substitutions could fail to draw as slurs, despite
the options or properties; this problem has been resolved.
STEAM-7217 Flows Duplicate Flow and Split Flow now correctly copy the flow info for the original flow into
the new one.
STEAM-7697 Graphics I_mported graphics are now exported at a much higher resolution when exporting PDF
export files.
Graphics It is no longer possible to change focus to another project in the middle of a graphics
STEAM-7767 . : . :
export export operation, which could cause graphics from the wrong project to be exported.
STEAM-7848 Holds and In some circumstances, a fermata on a bar rest could be incorrectly positioned at the
pauses start of the bar, rather than over the bar rest; this has now been resolved.
Key Adding a clef change at the same location as a key change now always correctly
STEAM-4826 . ) :
signatures updates the cancellation naturals, if shown.
Key Changing the current tonality system in the Tonality System section of the Key
STEAM-7618 . .
signatures Signatures panel now always takes effect correctly.
STEAM-7628 Key Creating a key signature from the Used in this flow section now always uses the
signatures tonality system selected in the Tonality System section of the Key Signatures panel.
STEAM-7796 K_ey The _tonahty sy§tem shown in the panel in Write mode is now always used when
signatures creating a key signature.
Changing the keyboard language on the Key Commands page of Preferences now
STEAM-7374 Localization works correctly when there are unsaved changes to the key commands in the current
language.
STEAM-7563 Localization The default key command for Write » Res.pell >_ Respell Using Note Above now
works correctly in the German-language version (Windows only).
STEAM-7361 Lyrics Using the Ief? or right arrow key to navigate off the first or last lyric no longer incorrectly
loses any edit made to that lyric.
Multi-bar . .
STEAM-6243 rests Multi-bar rests are now broken by both the starts and ends of repeat ending segments.
Multi-bar The presence of a system break no longer sometimes causes the width of a multi-bar
STEAM-7065 .
rests rest at the end of the previous system to change.
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ID # Component Issue
MusicXML Exporting with Export layouts as separate files switched off now correctly finds and
STEAM-7423 .
export uses the most appropriate full score layout for the selected flow.
MusicXML . i .
STEAM-6118 import Imported MusicXML and MIDI files now respect the Default text font family preference.
MusicXML A problem that could cause Dorico to crash when importing MusicXML files from
STEAM-7391 . .
import PDFtoMusic Pro has been resolved.
Moving the selection between non-note items with the arrow keys no longer sometimes
STEAM-7957 Navigation causes the selection to jump unexpectedly to the start of the previous system in page
view or backwards several bars in galley view.
Notation The Overlapping notes in the same voice in a kit or grid presentation option on the
STEAM-7487 - . . . . .
options Percussion page of Notation Options now works correctly for chords split by a barline.
STEAM-5499 Note input Inputting the first note in a new voice between rhythmic grid positions now works
correctly.
Under some circumstances, extending the duration of a note that ends within a tuplet in
STEAM-5555 Note input Insert mode could cause other later notes in the same voice to be deleted; this problem
has now been resolved.
STEAM-6546 Note input Changing the_ voice of a sel_ectlon_ c_;f npt_es no longer son_]et_lmes causes the not_es to be
moved to a different rhythmic position if items already exist in the destination voice.
STEAM-7411. Note input Pasting a selection beglnnlng. with implicit rest§ immediately followed by a tuplet no
longer causes some non-note items to be offset incorrectly.
STEAM-7411 Note input Pasting a.selectlor_l that begln_s Wlt_h implicit rests fgllowe_d_ by a tuplet no longer results in
non-note items being pasted into incorrect rhythmic positions.
STEAM-7425 Note input Pasting a selec_tlon including tuplet_s into an eX|s_t|ng passage with |d_ent|cz_:1l tuplets with
chord mode active no longer sometimes results in some of the material being offset.
STEAM-7449 Note input _Pastlng materl_al of the same d_uratlon as an existing tuplet will now remove the tuplet,
instead of pasting the material into the tuplet.
STEAM-7561 Note input Updplng the creation of a tuplet no longer sometimes fails if a non-note item is located
within the range of the added tuplet.
STEAM-7609 Note input Making a selection on a percussion _klt using the five-line staff presentation type now
correctly uses the extent of the selection from all components, rather than only the first.
STEAM-7657 Note input Copy and_ paste for instruments W|th|n_ a percussion kit using the single-line instruments
presentation type now works more reliably.
. Dorico no longer hangs when attempting to shorten with Shift+Alt+left arrow a note or
STEAM-7748 Note input rest of the minimum valid duration (1024th note).
STEAM-7880 Note input I\{Iovm_g the caret after priming a new voice no longer causes a voice with the wrong
direction to be created.
STEAM-7939 Note input When multlple |_tems gre selected_, hitting Return now starts note input, rather than
attempting to edit the first selected item.
STEAM-7490 Notes Stems in opposing directions on adjacent staves are padded by a small amount to

prevent them from becoming so close they may appear to touch.
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ID # Component Issue

Rhythm dots on stemless notes— i.e. a whole note (semibreve) or longer — in down-stem

STEAM-7508 Notes . . . S
voices are no longer incorrectly snapped to spaces in the wrong direction.

Glissandos between invalid note positions (for example, two notes of the same pitch tied

STEAM-7436 Ornaments .
together) are now correctly automatically removed.

Making a selection on the lower or left-hand staff of a piano instrument and then pasting

STEAM-7568 Pedal lines .
the pedal line now works correctly.

Pedal lines that span multiple systems no longer sometimes disappear when making

STEAM-7684 Pedal lines unrelated edits.

The notation option to remove overlaps for percussion kits did not always work correctly

STEAM:748/ Percussion for a chord split across a barline; this problem has now been resolved.

Piano Pasting piano pedal lines now works correctly when selecting something in the left-hand

STEAM-7568 pedaling staff of the piano.

It is no longer incorrectly possible to use the Shift+l key command to add an additional

STEAM-7516 Players . )
instrument to a section player.

The chosen page range for printing is correctly preserved when leaving and re-entering

STEAM-7290 Print mode .
Print mode.

Choosing a page range that does not include the first page of the layout, then switching

STEQE2S Print mode back to All pages now updates the print preview correctly.

STEAM-7764 Print mode Cancelling a print or graphics export operation no longer sometimes causes a crash

Repeat

STEAM-7199 :
endings

It is now possible to create a repeat ending when an explicit bar rest is selected.

Setting a property on an implicit rest no longer causes all other selected items to be

STEAM-6760 Rests removed from the selection.

The Bar rest design in long time signatures option on the Rests page of Notation

STEAM-7012 Rests Options now works correctly when adding bars to the end of the flow.

The presence of local time signatures on one staff no longer prevents multi-bar rests

STEAM-7545 Rests from appearing in the other staff if they line up with the bars of the global time signature.

Expanding a group in the Players panel will no longer cause the cards for the players
STEAM-5501 Setup mode within the group to be truncated incorrectly when the group is partially scrolled out of
view.

Tempo items with dx/dy offsets are no longer sometimes positioned inconsistently in

STEAM-5817  Tempo relation to other items.

The spacing of rhythm dots in metronome marks has been improved, particularly for

STEAM-7473 Tempo durations shorter than a quarter note (crotchet).

When the font style for gradual tempo items is set to absolute rather than staff-relative

TEAM-77 Tempo . . h S .
S 06 P size, the dashed or dotted continuation line is now correctly drawn at absolute size too.

Gradual tempo items with no drawn continuation line now draw a handle and attachment

STEAM-7723 Tempo line at the right-hand end in Write mode.
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ID # Component Issue
STEAM-6777 Text System-gttgched text can now be edited correctly if the top staff of the system is hidden
because it is empty.
STEAM-7536 Text Right-aligned text is no longer sometimes slightly truncated within a text frame.
When considering ties for the purposes of collision avoidance, the inside of the tie was
STEAM-7578 Ties incorrectly being considered instead of the outside. This problem has now been
resolved.
Time Under rare circumstances, notes and rests could be grouped incorrectly in irregular time
STEAM-7075 . . s . . .
signatures signatures within an aggregate time signature; this problem has been resolved.
Time Undoing the addition of a local time signature to an individual instrument now always
STEAM-7587 . . . - .
signatures correctly reinstates the previous global time signature.
STEAM-7561 Tuplets Undomg the creation of a tuplet where a non-note item’s position overlaps with the new
tuplet will no longer go wrong.
STEAM-3656 User interface D_rop-down menus in dla_logs _and pa_nels no longer _sometlmes appear on the wrong
display when running Dorico with multiple displays (Windows only).
STEAM-7510 User interface Focus no longer gets Iogt after _cllcklng_the_ buttons in the _note input toolbox, resulting in
key commands not working until you click in the score (Windows only).
STEAM-7637 User interface It is now possible to assign key commands to both File » Import » Flows and File
» Export » Flows.
STEAM-7647 User interface The various annotations that appear at the top and bottom of the caret are now correctly
scaled relative to the current staff size.
STEAM-7663 User interface Maximizing the document window while a modeless dialog was open could in rare

circumstances lead to Dorico hanging; this has now been resolved (Mac only).
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Known issues and solutions

Frequently asked questions

Answers to frequently asked questions about Dorico can be found online in the
Dorico forum.

Knowledge base

For the latest information about issues and solutions you may encounter when
running Dorico, please consult the Knowledge Base.

Entering the eLicenser Activation Code (Mac only)
When you first run Dorico and are prompted to enter your Activation Code, you
may find that after you have successfully activated your Soft-eLicenser, you must
quit and restart Darico for the application to detect that it is fully licensed.

Key commands to transpose notes by an octave (Windows only)

The Intel Graphics Adaptor drivers used by many Windows computers define a
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut
Ctrl+Alt+up/down/left/right arrows.

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for
transposing notes by an octave.

For information about how to disable the default Intel Graphics Adaptor key
command, consult the Knowledge Base.
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